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WELCOME TO lST WORD PLUS
You can think of a word processor like 1st Word Plus as a friendly, but very
powerful, typewriter. With a conventional typewriter, your text is printed on
sheets of paper as you type it. It is possible to do a certain amount of editing or
amending, though of a very limited kind. Correcting fluid can be used to delete
text, and you can type over the corrections, but you will not be able to insert text.
Moving and copying blocks of typewritten text is also very difficult unless you
happen to have a photocopier, scissors and a pot of glue handy.
With a word processor like 1st Word Plus, however, your text is displayed on the
screen as you type it in. Since it is not printed immediately, you have a "breathing
space" in which you can make as many corrections as you want. Moving, copying,
and deleting whole sections or "blocks" of text is also extremely easy with 1st
Word Plus. You need only print your text out when you are sure that it is just
right, and since 1st Word Plus shows you the text exactly as it will be printed out,
you can be sure of perfect results every time.
All in all, you will find that 1st Word Plus is a truly professional word
processor which will answer all your writing needs. You can "cut and paste"
blocks of text both within and between documents, and combine this with your
own graphics. Not only that, but we've added a 40,000 word spelling checker and
a mail merge facility, so that whether you use 1st Word Plus at home or in the
office, it rivals systems costing three or more times the price.

-

1st Word Plus has been designed specially for the Acom Archimedes, so it is
very easy to learn and use, whilst still providing the power and versatility which
experienced users expect. Full advantage is taken of the user-oriented desktop
features such as windows, icons, and menu displays. In fact, the only time you
will need to use the keyboard is when you are typing in text. Complex editing
tasks such as cut and paste, changes in layout, and reformatting are all done just
by using the mouse.
The mail merge program accompanying 1st Word Plus is 1st Mail. A mail
merge program allows you to produce a series of documents which differ from

each other only in certain details. The classic use of this kind of program is

to

send the same letter to a number of different people. This is done by creating a

-

master document with 1st Word Plus. The differing information or variable data,
such as customer names and addresses, is saved separately. By merging the
variable data for each customer into the master document, hence the name "mail
merge", a series of personalised letters is created, although you have only
needed to type in one. 1st Mail enables you to make multiple copies of letters or
any document using a set of easy to understand commands.
Although the best screen performances are obtained when a colour monitor is
used, it is possible to operate the 1st Word Plus program with a monochrome
monitor. However, some of the finer details, such as the difference between light
and normal text, may then be less easy to see on the screen. They will,
nevertheless, appear correctly on the page.
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-

The following outline summarises the contents of the 1st Word Plus user guide:

INTRODUCTION explains what 1st Word Plus does.
ABOUT THIS MANUAL summarises the contents of the 1st Word Plus user
guide and explains the conventions used throughout.
GETTING STARTED explains how to run the program on your Archimedes.
!ST WORD PLUS TUTORIAL takes you step by step through a tutorial session
using the basic 1st Word Plus features. Beginners to word processing should
follow this tutorial carefully before attempting the more advanced features
discussed in later chapters. If you already have experience of other wordprocessings, you can go straight to the next chapter.
BASIC TECHNIQUES familiarises you with the keyboard and the screen.
DOCUMENT LAYOUT tells you how to create and type in text, then use the
formatting and style options to control layout and appearance.
EDITING DOCUMENTS tells you how to edit your documents, check them for
spelling, and paste pictures into them.
SAVING AND PRINTING explains how to save your documents to disc and
how to print them out.
IST WORD PLUS COMMANDS is a reference section providing brief
summaries of all the menu commands used in 1st Word Plus.

-

INTRODUCTION TO lST MAIL tells you how to run 1st Mail on your
Archimedes.
lST MAIL TUTORIAL takes you step by step through an introductory 1st Mail
session.

USING lST MAIL provides detailed information on the production of
formatted documents using command files and datafiles.
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!ST MAIL COMMANDS is a reference section providing brief summaries of
all the commands used in 1st Mail.
APPENDIX A contains instructions for printing address labels using 1st Mail.
APPENDIX B provides information on creating your own printer driver. 1st
Word Plus is supplied with a range of drivers for the most popular printers.
However, in case you have a printer which is ri.ot yet fully supported by 1st Word
Plus, tum to this appendix.

CONVENTIONS
Keys which you press are represented by boxed text:

Sometimes you will need to hold down one key, eg [2[J ,while pressing another
one,eg[±:J.
This method of combining key presses is symbolised [2[J [±:] .
The three buttons on the mouse are referred to by their conventional Archimedes
names, these being, from left to right, select, menu and adjust. In this manual, to
'select' means to position the mouse pointer over the item referred to and then
press select.
Note, however, that in 1st Word Plus there is no difference in function between
the select and adjust buttons.
The centre or menu button is used to call up the menus.
The title of a specific screen, menu or box appears in bold as follows:
File

4
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BOUT THIS MANUAL

A menu entry followed by ' ••• ' indicates that a dialogue box will appear, for
example:

-

Open file ...
Text that you enter and text that appears on the screen is shown as follows :
This text appears on screen

ESSENTIAL READING
Before attempting to use 1st Word Plus, it is essential that you are familiar with
the workings of the Archimedes, its desktop and its directory-based filing system.
These are described in detail in your Archimedes Welcome guide and User
guide .

-
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B ETTING STARTED
LOADING lST WORD PLUS
Before you do anything else with 1st Word Plus, you should make copies and
keep the originals in a safe place. To make backup copies, follow the instructions
in the Release note or see your Archimedes Welcome guide and User guide for
details. Use the copies as your working discs.
If your Archimedes has a hard disc, you should install the software on your hard
disc. 1st Word Plus includes a utility to enable you to do this - details are given
in the Release note accompanying the program discs.
There are three ways to load the 1st Word Plus program onto your computer,
either:
•
•
•

from the desktop, or
directly from the operating system, or
using I Shilt 11 Break I.

The actual method used will depend on the configuration of your system, ie how
the computer was set up, and your personal preferences.
The 1st Mail, dictionary merge and printer install programs (lstMail,
lstDMerge and 1st Install) also on the discs supplied, are loaded from the
desktop or from the operating system in the same way as the 1st Word Plus
program .
When you first receive the program disc, 1st Word Plus will be stored on it in the
directory called library and will have the name lstWord+. If you have not
changed this structure and the program is to be loaded from floppy disc, load 1st
Word Plus as stated below.
Loading from the desktop
To load from the desktop:
Put the program disc into the disc drive.

7

2

Move the mouse pointer.to the floppy disc icon and press select.

3

Move the mouse pointer to the folder called library and double-click
select to open it.

4

Move the mouse pointer over the program icon labelled 1st Word+ and
again double-click select.

The desktop will clear itself, and after a short while, the 1st Word Plus startup
screen will appear (shown below).
Loading from the operating system
To run the program from a floppy disc, using the operating system, first ensure
that the program disc is in the disc drive, then when the'*' prompt is visible, type
the following command:
v

I T

1st Word+
When the program is run directly from the operating system, you can also select
the document you wish to work on, so that it is loaded automatically after the
word processing program. To do this, add the document name to the word
processing program instruction line above separated from it by a space, so that
you type for example:
lstWord+ doc.joyce
Loading with IShilt

11 Break

I

First ensure that the program disc is in the disc drive and then press:

8
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After a short while the 1st Word Plus startup screen will appear:

File:
lunt i tleij
!"!!$%&'()
@AB CDE F GHI
' abc de f g hi

-

F1 Bold
F7 Insert

F3 Italic
F2 Under
FB Del Lin F9 Indent

OK

Cancel

F5 Super
F19 Fixed sp Fll Centre

1st Word Plus usually runs in Mode 12, and this mode will be selected
automatically when the program is loaded. However, when using a multiple
scan-rate monitor, it is possible to increase the amount of text on the screen by
running in Mode 20. To do this, you must select Mode 20 before loading the
program. (See your Archimedes User guide for instructions on how to change
mode.)

9
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If you are an absolute beginner to word processing, this chapter is designed to
introduce you to using 1st Word Plus on the Archimedes computer. It will take
you step by step through the fundamentals of using a mouse-driven word
processor, from loading in the program to saving documents on disc. By typing in
a sample document, you will be able to see for yourself how powerful 1st Word
Plus is, while still being easy to use.
You must first load 1st Word Plus, as described in the last chapter, Getting
started. This is the startup screen:

! " M$ %&I ( )
@R B C DE F GHI
' abcdef g hi

Fl Bold
F7 Insert

F3 Italic
F2 Under
FB Del Lin F9 Indent

N

Cancel

F4 Light
F5 Super
F18 Fixed sp Fl! Centre

-'
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GIVING YOUR DOCUMENT A NAME
You will first have to open a document file with its own filename to store the text
in. Do this by entering the name of the file you want to open in the OPEN FILE
dialogue box in the centre of the screen, (if you removed it by selecting the
Cancel box you can call it up again by pressing menu, moving the mouse pointer
across the arrowhead to the right of the File option, then selecting the Open file •••
entry on the second level menu.)
When you first load 1st Word Plus, the dialogue box will have the directory
name & • lwp. doc.* in the Directory: box and the filename untitled in the
File: box (see your Archimedes Welcome guide and User guide for details
about files and directories). The insertion cursor will be in the File: box.
First dear the File: box by pressing IEse I,then type in the filename Oakwoods
which is the name of the sample document you are going to type. Use the left and
right cursor keys [±] ~ to move the cursor around and the I peiete I or I Copy I keys to
erase any mistakes you make in entering the name. I Copy I will delete the
character to the right of the cursor and I Delete I will delete the character to the left.
Check that you have typed in the filename correctly, then move the mouse pointer
to the OK box and press select. The startup screen will disappear, and will be
replaced by a text window with a dialogue box in it asking ydu if you want to
create a new file. Move the mouse pointer to the OK box anB press select. The
dialogue box will disappear and be replaced by the text wibdow.

12
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ST WORD PLUS TUTORIAL

The text window

-

I
I
..

-

II
Every document that you work on with 1st Word Plus will appear in a text
window like this. Since you have just created a new document, the text window is
empty. At the top of the window, the title line displays the name of the document.
Directly below this is the ruler line showing the current tab stops and the
positions of the left and right margins.
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TYPING IN TEXT
The following extract is the text you are going to type in. As you can see, it has
several different styles of typeface, centered headings and numbered and
indented paragraphs. These are all things which are easy to do in 1st Word Plus.

BRITISH
1.0

WOODLANDS

Oakwoods
There are two types of oakwood in Britain, damp
oakwoods and dry oakwoods.
The typical damp
oakwood tree is the Pedunculate Oak with its
stalked acorns and peculiar shaped leaves.
The
typical tree of the dry oakwoods is the Durmast or
Sessile Oak in which the flowers and consequently
the acorns have no stalks and the leaves have starlike hairs on their undersurfaces.

Bold type, capitals, centred text
The first piece of text to be typed is the title of the extract. This is to appear in
capital letters in emphasised or bold type and is centred on the page. You change
from normal to bold (or italic, or underlined) type by pressing a function key.
The function keys are [IT] to[§] on your keyboard. They are also represented at
the bottom of the screen identified by their function (Fl Bold etc). You make
them work either by using the mouse to point to the key you want and clicking
select, or by pressing the key directly. The key is "on" when it is shown on the
screen in black with white text. You tum it "off' again (ie revert to ordinary text)
by clicking on it (or pressing the key) again. So, to type the title in bold text,
centered, follow these steps:
To tum bold type on, press QI] on the keyboard, or use the mouse to select
the Bold function key. The Fl icon at the bottom of the screen should now be
in reverse video (white text on a black key).

14

. . . ~T WUKV

F4 Light
F5 Super
F19 Fixed sp Fl! Centre

2

To tum on capital letters, press I Caps Lock I on the keyboard.

3

Type the following text:

BRITISH

l'LU~

TUTU.KlAL

F6 Sub
F12 Refm1at

WOODLANDS

4

To centre the heading, press IBD or use the mouse to select Centre.

5

To move two lines down the page, press ~ twice.

6

To tum off the capitals, press I caps Lock I again.

7

To tum off bold, press [EJ or use the mouse to select Bold again.

Underlined text and tabs
Now for the numbered sub-heading, which introduces the use of tabs and
underlining. To produce this follow these steps:
Type:
1. 0

then press:

When you press ITab I the cursor will move along the line until it is level with
the next tab stop (marked by a diamond) on the ruler at the top of the

window.

-

'
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(Typists should also note that the numeric keys '1' and 'O' should not be used
interchangeably with the alphabetic keys 'l' and Shift '0' as they sometimes
are on a typewriter.)
2

To tum underlining on, press@] or use the mouse to select Under(line).

3

Using I Shilt I when a capital letter is required, type the following text:
Oakwoods

4

To move two lines down the page, press G!::l twice.

5

To tum off underlining, press@] or select Under again.
Note: Press I Shilt I and a character key together to type capital letters (P,
C etc.), or one of the upper or 'shifted' characters(! , "etc.). If you have
used a typewriter, you will notice that the Archimedes' keyboard has a
I caps Lock I instead of the typewriter shift lock. The I caps Lock I only shifts
the letter or alphabetic characters.

Typing ordinary text
Now for the easy bit. Type in the following text from the passage as you would
on a typewriter, but without pressing G!:J at the end of the lines. You will notice
that the cursor automatically goes to the next line for you. This feature, called
word wrap, saves you having to press G!::l at the end of each line. Only use G!::l at
the end of a line which is to stand on its own (such as a title), or to insert blank
lines (eg between paragraphs).
There are two types of oakwood in Britain, damp oakwoods
and dry oakwoods. The typical damp oakwood tree is the
Notice the difference in colour between the bold type in the main heading and
the normal type of theJest of the text.

16
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Italic underlined type
The next words will be underlined and in italics, so follow these steps:

-

1

To leave a space before the next wura, press the Space Bar.

2

To tum underlining on, press or select [£IJ .

3

To tum italic on as well, press or select [}I].

4

Type:

Pedunculate Oak
5

To tum underlining off, press or select [IT] again.

6

To tum italic off, press or select [}I] again.

7

To leave a space before the next word, press the Space Bar.

Continue by typing in the rest of the passage as shown below, putting in the italics
in the same way.
with its stalked acorns and peculiar shaped leaves.
The
typical tree of the dry oakwoods is the Durmast or
Sessile Oak in which the flowers and consequently the
acorns have no stalks and the leaves have star-like hairs
on their undersurfaces.
To end the paragraph you have just typed in, press

l£::I once.
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When you have finished typing in this paragraph, your screenful of text should
look like this:

There are two types of oakwood in Britain 1 daMp oakwoods and dry
oakwoods. The typical daMp oakwood tree 1s the Pedunculate Oak
with its stalked acorns and peculiar shaped leaves. Ifie typical
tree of the dr11 oakwoods is the Durnast 01· Sessile Oak in which
the flowers and consequently the acorns have no stalks and the
leaves have star-like hairs on their undersurfaces.

CORRECTING MISTAKES
Once you have typed in this piece of text, you may want to edit it to correct any
typing mistakes you may have made. In order to do this, you will need to move the
cursor, the flashing block which indicates the point at which some text is added or
altered, to the right place.

18

Moving the cursor
Move the cursor by using the mouse to point to where you want it, then press
select. This is the quickest way, but you can also use the keyboard:

.-

•

To move the cursor up or down one line, press [f] or [TI.

•

To move the cursor left or right one character, press 0

•

To move the cursor left or right one word, press I Shift: I 0

•

To move the cursor to the beginning or end of a line, press @ill 0

orw.
or w.
or[:±:].

Try moving the cursor from the top of the text to the bottom firstly by using the
mouse, then by using the cursor keys. Once you have mastered the technique of
using the mouse, you will probably find it much faster and easier than using the
\ keyboard.
Altering text
When you have moved the cursor to the correct position, you will be able to alter
your text by deleting mistakes and inserting new text. You can delete single
characters as follows:
•

To delete a character to the left of the cursor, press Back Space or I 0e1ete I.

•

To delete a character under the cursor, press I Copy I.

Once you have deleted a mistake, type in any new text that is required. Notice
how new text is inserted before the cursor, and any existing text shuffles
rightwards to make room for it.
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Tidying up paragraphs
After you delete or insert text, the lines in a paragraph may be of uneven lengths
and look rather untidy. In order to tidy up an edited paragraph, you will need to
reformat it:
Position the cursor on the first letter of the main paragraph (the 'T' of
There).
2

To reformat the whole paragraph, press [£ill or select its icon with the mouse.
(If this causes the Hyphenation dialogue box to appear, select Disable on it
to turn hyphenation off for the present document.)

Indenting paragraphs
It will look even more professional to indent the main text of the paragraph you
have just typed in so that it appears in the same column as the text of the subtitle.
To indent a whole paragraph, follow these steps:

20

1

Position the cursor on the first letter of the main paragraph (the 'T' of
There) .

2

To indent the first line of the paragraph as far as the first tab stop, press[}[]
or select its icon with the mouse.

J

Reformat the paragraph as described above.

1.8 Oakwoods

-

There are two types of oakwood in Britain, danp oakwoods and
dry oakwoods . The typical daMp oakwood tree is the
Pedunculate Oak with its stalked acorns and peculiar shaped
leaves . The typical tree of the dry oakwoods is the DurMast
· or Sessile Oak in which the flowers and consequently ~
acorns have no stalks and the leaves have star-like hairs on
their undersurfaces.

EDITING BLOCKS OF TEXT
1st Word Plus also allows you to do various things to whole blocks or portions of
text, such as moving them, copying them, deleting them, and changing their style
into bold, underlined, etc. Try these techniques out on the sample document that
you have just created.

21

How

to

mark a block

Let's mark the paragraph as a block of text. First, position the mouse pointer over
the first character of the block, ie the 'T' of There, press select and hold it down,
then, when the pointer hand appears, drag across all the text to the end of the
block. Release the select button.
You will notice that the block is no~ highlighted with a different coloured
background.

(To remove highlighting, press and hold down select.)
22

Moving your block
You can move your block to another area, such as beneath its present position. To
do this:

-

1

Position the cursor where you want to move the block to - in this case the line
below the end of the paragraph.

2

Press menu and then select Move block in the Block menu. (Note that
holding down select removes highlighting from a block, so make sure you
press and release select only briefly when you move the cursor.)

The block of text you highlighted will be moved from where it was to the new
cursor position.
You can also move the block to the new position by pressing @ill [IT[] after
marking the block and positioning the cursor.
Now try moving the marked block back to the beginning of the passage.
Copying your block
You can also copy or duplicate your block of text, which is a two-stage operation:
Marking the block and copying it to the "clipboard", or storage area in the
machine.
2

Pasting a copy back into the text.

First, highlight the block (see above) and then select Copy block in the Block
menu. A dialogue box will appear, confirming that you have now stored the
block on the clipboard. If something else was already stored on the clipboard,
you will be asked if you wish to overwrite it. Move the mouse pointer to the

appropriate box on the dialogue box and press select. You will notice that the

23

original text on screen does not move but remains exactly as it was within your
document.
The second stage is to paste the copy of the passage back in from the clipboard.
Position the cu;sor where you wish the text to be placed, for example to the end of
the passage, then select Paste block in the Block menu. You can paste as many
copies of the block as you like into the text - the clipboard will retain a copy until
it is replaced by something else you copy.
Now try making some style changes to the copy, leaving the original block as it is.
Changing the style of a block of text
Mark the paragraph as a block in the way described above (How to mark a

block).
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2

Select a character style or combination of styles using the function keys, the
key icons, or the Style menu. In the illustration below, Light (CE]) text has
been chosen.

3

Call up the Style menu with the mouse, and confirm that the option(s) you
have chosen have a tick beside them denoting that they are currently selected.

4

Remove the block marking by calling up the Block menu and selecting Hide
block. A quicker way is to hold down select.

1.8 Oakwoods
There are two types of oakwood in Britain, danp oakwoods and
dry oakwoods. The tyeical danp oakwood tree is the
Pedunculate Oak with its stalked acorns and peculiar shaped
leaves . The tyeical tree of the dry oakwoods is the ~~rrnast
or Sessile Oak in which the flowers and consequently e
acorns have no stalks and the leaves have star-like hairs on
their undersurfaces .
There are hm t~pes of oakwood in Bt'i ta in, d;i1w oakwoorls and
dra oakwood:>. The typical d<mP oakwood tr~e is the
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Deleting your block
Mark your restyled block once again, then select Cut block in the Block menu to
make it disappear and to restore the example document to its original condition.

SKILLS LEARNT SO FAR
This chapter has taught you several different skills. You have learnt how to type
in text, change type styles, make corrections, position text and make alterations to
whole blocks of text at once. These are the basic features of 1st Word Plus. You
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are now ready to use it to produce your own documents. Further information on
the more advanced features of 1st Word Plus follows in the next few chapters.

HOW TO GET HELP
1st Word Plus will provide instant help information at any time if you press
menu to call up the menus, then move the mouse pointer down to the Help menu
and across the arrowhead to its right. The names of the various help topics will
appear on the screen. Move the mouse pointer to any one of them and press one of
the mouse buttons to display information relating to that topic.
If you have just loaded the program and a dialogue box is present on the screen,
you will need to remove it by positioning the mouse pointer over the Cancel box
and pressing select before you can gain access to the help menus as described
above.
Once you have read the message, get rid of it by moving the mouse pointer to the
OK box and pressing one of the mouse buttons, or by pressing c;:;J .
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Oakwoods
Ther·e are two t!jpes of oakwood in Britain, da1;1p oakwoods and
dry oakuoods. The tyeical dafllp oakwood tree is the

Pedunculate Oak with its stalked acorns and peculiar shaped

mves. The typical free of the dry oakwoods is the Durfllast
or Sessile Oak in which the flowers and consequently 'flieacorns have no stalks and the leaves have star-like hairs on

their under;

I

Define a block with START and
EHD BLOCK or by dragg_ing the
f!louse in the window. Then use
the BLOCK fllenu to fllove text

I\ \\ OK i <I

Note: Pressing G;!J always has the same effect as moving the mouse
pointer to a box with a yellow background and pressing select. Note
that in monochrome you may not be able to distinguish the different
background colours.

If you select Extra help, 1st Word Plus will automatically display a help
message every time you select a menu item. By using Extra help, you can be
confident that no menu item will be carried out until you have confirmed it by
clicking on OK. Tum Extra help off by selecting it a second time.
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SAVING YOUR DOCUMENT
To save your document to disc, so that you can look at it and practise editing it
wother time, select Save file in the File menu. 1st Word Plus will then save your
Oak woods file to disc, close the text window, and return you to the startup screen.
Select Open file ••• in the File menu to display the OPEN FILE dialogue box you
saw when you first entered 1st Word Plus.

QUITTING lST WORD PLUS
To exit from 1st Word Plus click on Quit••• in the File menu. You are taken back
to the operating system prompt. If your micro computer is set up to start with the
Desktop, press RESET to get back there.
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This chapter, and the four following chapters, are intended for two groups of
users of 1st Word Plus:
•

Beginners in word processing who have worked through the tutorial in the
previous chapter, and

•

Experienced users of other word processors who are new to 1st Word Plus.

As they aim to provide a thorough coverage of using 1st Word Plus, these
chapters follow the various stages of a word processing session, from creating a
document to printing it out. Consequently, some of the information contained in
the previous chapter may be repeated in greater detail here.
This chapter will familiarise you with the keyboard, the screen and the filing
system before you try creating a new document.

KEYBOARD

Typewriter keys

Action

Numeric keypad

The Archimedes keyboard is divided into four areas:
•

The typewriter style (or QWERTY) keyboard where the keys are arranged
in the same way as on a typewriter.
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•

The computer/keyboard control keys, which are the darker grey keys on the
keyboard. These include the cursor keys which are used to move the cursor
around the text window, and other keys such as I Copy I, I Delete I and I Insert I used
for the editing of text.

•

The function keys, which are the top row of keys above the typewriter style
keys, and are used to carry out special word processing activities in 1st Word
Plus such as centring text, applying type styles and deleting lines.

•

The numeric keypad, which has no particular function in word processing.

Function Key Icons
The function key icons are displayed at the bottom of the screen to show the word
processing tasks carried out by the Archimedes function keys. To use a function
key, either press the key itself or use the mouse to select its icon at the bottom of
the screen.
Keys [ill to c:£D are toggles (switches which can be either on or off) showing the
current settings of the following options:

IBJ
[}[]
[TI]
[E]
[TI]

[EJ
[£2]
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Bold text on/off
Underlined text on/off
Italic text on/off
Light text on/off
Superscript on/off
Subscript on/off
Insert text/overwrite text

The Fl to F? icons are shown in reverse video (white letters on black) if they are
switched on:

Keys CT[] tol:EII are used for editing text:
CT[]

@]
IIIQJ

lIITJ
l:EII

Delete line containing cursor
Insert paragraph indent
Insert fixed space
Centre line containing cursor
Reformat paragraph
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Key box
The key box allows you to use all the non-character keys with the mouse, so that
the only time you have to press any keys is to type in text.

You will have to reduce the size of the text window to display the key box (select
the window size icon at the bottom right hand corner of the window, and drag it
in).
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WORD PROCESSING MODE
Files can be created and edited with WP (Word Processing) mode in the Edit
menu switched either on (for document files) or off (for program, data, and other
non-document files) . See WP mode in the chapter on !st Word Plus commands
for more details.

THE STARTUP SCREEN
The startup screen is displayed when you load in 1st Word Plus:

cofllfllan
letter
pr i ntt est

! H 8 $ %&I ( )
@RBCDE F GHI
' abcdef ghi

F1 Bold
F7 Insert

F2 Under
F3 Italic
FO Del Lin F9 Indent

Cancel

F4 Light
F5 Super
F19 Fixed sp F11 Centre
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Font table
The Archimedes has available a 188 character set. However, not all of these
characters are easily available from the keyboard. To remedy this, 1st Word
Plus provides a font table which will allow easy entry of many other characters
including the accented ones used in several foreign languages:

Printer Installed: Epson FX (9-pin Matrix)
Parallel Port
! " 1 $ %&• c > * + , - • ' e 1 2 3 4 s 6 7 e 9 : ; < =·> ?

@n Bc DE F GHI J KL MH0 p n Rs T u u wx y z [ \ ]
' a b c d e f g h i j k 1 M n o p q r s t u u wx y z { I }
i £11~:§" !
o+
!
AAAAA2 R ~ ~ ~ ~ E x i x x D u b 6 6 Ho H 0 6 u u ~
~ ~ 8 ~ a3
P ~ ~ @e 1 2 1 1 a n o o o o o ~ u u u u ~

F2 Under
F3 Italic
~===: Del Lin F9 Indent
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ft

N

F4 Light
F5 Super
F19 Fixed sp Fl! Centre

Delete ¢
Tab
Fixed Space
aps Lock
F6 Sub

m!)ASIC TECHNIQUES

To reveal the font table, once a text window has been opened, position the mouse
pointer over the window size icon at the bottom right-hand corner of the text
window, press and hold down select, then drag upwards a couple of inches
before releasing the button (see also The window size icon in this chapter) .
To insert characters using the font table, position the mouse pointer on any
character in the table (the large box in the centre of the screen) and press select
to insert the character at the cursbr position in the current text window.
The range of characters that you will be able to print depends on your printer.
Once you have installed a suitable printer driver (see Installing a printer in the
chapter Saving and printing), the font table will display the range of characters
which you will be able to use with that printer. The printer display line at the top
of the font table indicates which printer driver is currently installed, and whether
your printer uses the serial (Modem) or parallel (Printer) port on the back of
your Archimedes, or the network printer.
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THE TEXT WINDOW
The text window occupies most of the 1st Word Plus screen, apart from the
window borders, the icons contained within them, and the function key icons at the
bottom of the screen. You can open files in up to four windows at any one time,
allowing you to cut and paste text between documents.

Workspace
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Title bar
The title bar displays the document name, preceded, if there is room, by the
names of one or more of the directories in which the file is contained. The
maximum number of characters that can appear is 12. However, only complete
names will be shown. If the full name of a directory will not fit, then that
directory will not be shown at all, and neither will any of the other directory
names above the missing one, even if their names are shorter.
The title bar also allows you to drag the window to a new position. (See below
under Moving windows for details of how to do this)
On the left of the title bar are the foreground/background and the quit icons. The
foreground/background icon is used to change the stacking order of the windows.
Selecting this icon on a window which is currently in front of other open windows
will send it to the back of them.
Selecting any part of a window which is behind other windows will bring it to the
front of them and make it into the current window.
The quit icon is used to close the current text window and abandon any edits that
were made since the document was last saved.
To the right of the title bar is the full screen icon. Selecting this icon will make the
text window fill the entire screen. Selecting it again will return the window to its
previous size, shape, position and stacking order relative to other windows on the
screen.
The workspace
The workspace is the area displayed below the ruler line (the ruler line is
described below). This area contains the text cursor, which indicates where typing
or editing will take place.
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Scroll bars
To the right of and beneath the workspace are the scroll bars, used for scrolling
around the window either vertically (up and down) or horizontally (from right to
left) . For further details see Moving around documents in this chapter.

Ruler line
The ruler line (displayed directly below the title bar) shows you the margins
and tab stops for the ruler at the cursor position. 1st Word Plus allows you to add
new rulers to your document, with different settings for tabs, text pitch, ruler
length, etc, on each one. For further details, see Rulers in the chapter Document

layout
Page border
Page breaks (the places at which new pages will begin when the document is
printed out) are displayed in the page border to the left of the workspace. For
further details see Page breaks in the chapter Creating a new document.

38

MANIPULATING TEXT WINDOWS
foreground/background icon

Full screen icon
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The window Size Icon
The window size icon appears at the bottom right-hand comer of the screen and is
used to change the size or shape of the text window. Sizing window is useful if you
have more than one text window open (for example, if you are cutting and pasting
blocks of text from one document to another). To size the text window drag the
size box:
up

to

shorten it

down to lengthen it

o' 1.
;_ __ - - · - -·- ., -·· __ ,I

[]
right to make it wider

left to make it narrower

When the dotted outline of the window is the size you want, release the mouse
button.
The full screen icon can also be used to change the window size. (See above under
Titl.e bar for details).
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Moving windows
To move the text window, move the mouse pointer to the title bar, hold down
select, and drag the window to its new location. Be careful not to alter the ruler
line by misplacing the mouse pointer when dragging the text window by the title
bar.
Closing windows
To close the text window and abandon edits made since the document was last
saved, select the quit icon in the top left-hand comer of the title bar.
The window can also be closed by selecting Quit••• in the File menu. To do this,
follow these steps:
Press menu to call up the menus.
2

Move the mouse pointer across the arrowhead to the right of the File option
and select Quit... when the second level menus appear.

Before the file is closed a warning notice will be shown informing you that your
recent edits will be abandoned if you proceed.
You can close all your open text windows together with the 1st Word Plus
program by selecting Quit all ... in the File menu. To do this, follow the steps
given above, but select Quit all ... in place of Quit.... A warning notice will again
be displayed.
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MOVING AROUND DOCUMENTS
If you want to look at text that extends beyond the edges of the text window, you
can scroll, or move through, the contents of the window. To scroll, use the scroll
bars at the right and bottom of the text window or the scroll arrows situated at
either end of them.

~I;

Vertical scroll

Hqri:z:gnJ~L§c;r,ol.L!?~r

F2 Under
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F3

I
iI

bar ~~

The size of the scroll bars varies according to the proportion of your text which is
visible in the window:
•

The vertical scroll bar shows the position and approximate size of the text
area visible on screen relative to the whole document. If you have a small
document, the scroll bar will be larger than if you have a long document.

•

The horizontal scroll bar shows the position of the text area (up to 73
characters wide) relative to the maximum line length of 160 characters.

Vertical scrolling

You can scroll text up and down using the scrolling facilities to the right of the
window:
•

To scroll up or down one line, position the mouse pointer over the scroll up or
scroll down arrow and press select.

•

To scroll up or down one screenful of text, position the mouse pointer in the
black area above or below the scroll bar and press select.

•

To move towards the beginning of your document, drag the vertical scroll bar
upwards.

•

To move towards the end, drag the vertical scroll bar downwards.

Page Up I and Page Down I can also be used to scroll up or down one screenful at a time,
and it is also possible to scroll text vertically one line at a time by attempting to
move the cursor out of the visible workspace using the cursor up or cursor down
keys, until the end of the document is reached.
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Horizontal scrolling
In the same way, you can scroll text in the window left and right using the
horizontal scrolling facilities at the bottom of the window:
•

To scroll left or right one character, position the mouse pointer over the scroll
left or scroll right arrow and press select.

•

To scroll left or right a larger distance, position the mouse pointer over the
black area to the left or right of the scroll bar and press select.

•

To move left or right, drag the horizontal scroll bar leftwards or rightwards

Moving the cursor
Once you have moved the text window to the part of your document which you
want to work in, you will need to move the cursor to the correct position. You can
move the cursor either by positioning the mouse pointer and pressing select, or by
using the keyboard:
•
•
•
•
•
•
•
•
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To move the cursor up or down one line, press [TI or [I].
To move up one screenful, press IShit Im.
To move down one screenful, press IShit Irn.
To move the cursor left or right one character, press[±] or[±].
To move left one word, press ffihl [±].
To move right one word, press IShit I[±].
To the beginning of the line, press @ill [±] to move.
To move to the end of the line, press [fill[±].

Finding your position
Select Show position in the Layout menu to display the current position of the
cursor in your document, eg Page 17 Line 4 Column 58. This information is
displayed on the ruler line in place of the current ruler. Select Show position
again to tum the position display off or select Show ruler to redisplay the current
ruler. If the current cursor position is displayed, Show position will have a tick by
it.
When WP mode is not switched on, only the line and column position will be
given as non-word processed documents are not divided into pages. If neither
Show position nor Show ruler are switched on you will have one extra line of text
visible in your workspace.
Finding pages
To move to a given page in your document, select Goto page••• in the Edit menu.
When the Goto Page dialogue box appears, type in the page number you want
and select OK. 1st Word Plus will move to the page you have specified and
display it in the text window with the cursor on the first character.
With documents more than 99 pages long, you can move to any page number (eg
page 212), although the page border will only display the last two digits (eg 12).
If you specify a number greater than the size of the document, 1st Word Plus will
position the cursor at the top of the last page.

DIFFERENT TYPES OF SPACES
You may notice when moving the cursor that it will occasionally 'jump' over a
space onto the next character. This is because 1st Word Plus uses four different
types of space, and you can only position the cursor on three of them.
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Variable and stretch spaces
When you press the Space Bar a variable space is inserted into the text at the
cursor position. 1st Word Plus may widen a variable space by adding one or
more stretch spaces to it when it right justifies a line (see Justification in the
chapter Creating a new document). You will be able to place the cursor on the
variable space but not on the stretch spaces which 1st Word Plus may have added
to it.
1st Word Plus treats the variable space and any stretch spaces which may have
been added to it as a single unit. When a variable space is deleted, any stretch
spaces associated with it are deleted as well.
Fixed spaces
To insert a fixed space, either press [ITQ] or select its icon on the screen, or select
Fixed Space in the key box. You can always place the cursor on a fixed space.
A fixed space will never have stretch spaces added to it, nor is it ever used as a
potential word wrap point during right justification. Use it to link words or
numbers which you do not want the program to either move further apart or split
over different lines, such as:
•
•
•
•

Names
Telephone numbers
Addresses
Postcodes

'Arthur Daley'
'01-200 0200'
' 13 Grove Street'
'CB45JA'

Note that pressing ITab I inserts fixed spaces into the text up to the next tab stop
(see Tabs in the chapter Creating a new document) .
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Indent spaces

An indent is inserted into the text by using the CTI:] key or icon. This gives a similar
effect on the screen to using ITab I, but actually consists of a single indent space
followed by stretch spaces to the next tab stop. The cursor can only be positioned
on the indent space and deleting this will delete the associated stretch spaces as
well. For further details, see Indents in the chapter Document layout.

DOCUMENT SIZE RESTRICTIONS
Although 1st Word Plus occupies quite a lot of the computer's RAM (its working
memory), there is enough memory left in an Archimedes 310, for example, to
work on documents of at least 150 pages, or the size of an average novel! This
figure will be reduced:
•

if you have the 1st Word Plus spelling dictionary loaded into memory, and

•

if the 'typing density' of your text, (the number of words and/or pictures on
each page) is high. The figure above is based on a typing density of around
250 words per page, or a total of 37,000 words in memory in one 1st Word
Plus session.
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1st Word Plus will display an Alert Message when you are running short of
memory. You can check for yourself the number of pages, lines, and words i~ a
document, as well as the amount of memory remaining, by selecting Statistics ••• in
the Edit menu.

li!lllllH
Docuf!lent: Pages:
Lines:
Words:
Bytes:
Space refllaining:
RRM:
@][!]@] Disk:

1
1
8
lK

2951 K
699K

. +DKt

Use the left and right arrows to change the number showing you which disc drive
is currently being displayed, your floppy disc is normally 0 and the hard disc (if
you have one) is normally 4. When you have finished with the Statistics dialogue
box, select OK to remove it from the window.
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FILENAMES
Documents are saved as files which are identified by filenames . Filenames can
consist of up to ten characters. The name may be preceded by a directory path
(see the Archimedes documentation for an explanation of directory paths) which
consists of one or more elements separated from each other by a full stop. When
a text file is opened, the name of the file will appear in the title bar at the top of
the screen.

IMPORTANT NOTE
Documents can only be saved within directories which were already in existence
when you loaded 1st Word Plus. It is therefore important to ensure that all the
directories you intend to use do exist and are in the correct hierarchical position
before you load 1st Word Plus, otherwise you will have to give your document a
different directory path before saving it.

If you wish the program to make backup copies of your files, you will also need
to ensure that a directory called bak exists at the appropriate place in your
directory hierarchy, before loading 1st Word Plus. This will be needed for your
backup copies, when you save your files. (See your Archimedes User guide for
details of how to create a directory and Saving your document in the chapter
Saving and printing in this manual for further details about where to create bak
directories.)
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Doc files
Files which are created with the directory name doc as the last element of their
directory path are a special case. This directory is intended to be used for files
containing word-processed documents. For example:

When a file is created in the doc directory, WP mode will automatically be
turned on. Note, however, that the file must be created directly within the doc
directory for this to happen. It will not occur if the file is created within another
directory that is itself included within the doc directory.
Files in any other directory will have WP mode switched off when first created,
although this can easily be switched on using the Edit menu. If the document is
then saved with WP mode switched on, the mode will remain switched on the next
time the file is loaded.
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OPENING A FILE

! " M$ %&I ( )
@RB CDE F GHI
· abcdef g hi

F1 Bold
F7 Insert

F2 Under
F3 Italic
FB Del Lin F9 Indent

Cancel

F4 Light
F5 Super
F18 Fixed sp Fll Centre

The OPEN FILE dialogue box appears in the centre of the screen when 1st Word
Plus is first loaded in, and is used to select a file to be opened.
When the program is first loaded the directory name doc will appear in the
current directory box near the top of the dialogue box, followed by a dot and an
asterisk. Dots must be used to separate the directory names in the box if there are
more than one. The asterisk stands for the following filename .
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The filename untitled will appear in the File dialogue box. The names of any
other files to be found in the doc directory will be listed in the scroll box.

If there are more files than will fit in the scroll box, those outside it can be
revealed by using the vertical scroll tools to the right of the box in the same way
as the window scroll bars are used, ie moving the mouse pointer over the up arrow
and pressing select to show entries above the present listing and over the down
arrow to show entries below it.
If you wish to open or create a file called untitled (ie, a new file), in the doc
directory, select OK.
If you wish to open another file in the doc directory, select its name in the scroll
box. The name of the selected file will then be transferred to the File dialogue
box. Now select OK.
If the file you wish to open is not in the doc directory, select the quit icon in the
top left-hand comer of the scroll box to obtain a listing of the contents of the next
directory above the currently listed one.
If the directory is on another drive, specify the drive (:0, :4 etc) in the Directory:
box. See your Archimedes User guide for details about drive numbers.
Entries which are themselves directories will be marked by an arrowhead to their
right, while files will have no arrowhead. If you now select a file from the list, its
name will be transferred to the File dialogue box and if you then select OK,
providing the file contains information legible to the 1st Word Plus program,
that file will be opened by the program.

If you select a directory name, the contents of the window will then be changed to
list the contents of the directory you have chosen, and you can then select either a
file or another directory within that directory.
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You can browse through all the directories available to you by selecting the
quit icon or the names in the scroll area to change level up or down within the

hierarchy.
The entries in the directory and File dialogue boxes can also be changed by
moving the mouse pointer over the entries themselves and then pressing select.
The insertion cursor will be placed within the box.
There are then two ways to edit the box contents, either:
•

clear the box completely by pressing I Esc I before typing in new contents, or

•

edit the existing text using the cursor keys, together with I ~~te I and I copy I to
remove unwanted items character by character, before typing in amendments.

Note however that the correct directory path (including the drive number) must
be displayed in the directory box if the file of your choice is to be found. The
program will only look in the selected directory for the file, and if it is in a
different directory it will not be found.
Select OK to open the file once you have the correct names in the directory and
file boxes.
Double-clicking select with the mouse pointer over the correct filename in the
scroll box will also open the file directly.

LOADING FILES
To load a document file, when the File dialogue box is not on the screen, press
menu to display the menus, select the File option by moving the mouse pointer
across the arrow head to the right of the option. Finally select Open file ••• by
positioning the mouse pointer over it and pressing select. The OPEN FILE
dialogue box will then appear.

If the dialogue box has previously been used to select a file, the next time it

appears, the entries in the directory and File dialogue boxes will be those
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previously selected. They can, nevertheless, be changed in the same way as
described above.
After you have selected which file you wish to open, 1st Word Plus will open a
text window, read any existing text from disc into memory, and display the start
of the document.
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This Chapter is a reference guide to formatting your document with 1st Word
Plus. It explains how to use the many layout facilities offered by 1st Word Plus,
including such things as:
•

How to set the left and right margins, and then line up your text in between
them.

•

How to make use of the rich variety of text style options available with 1st
Word Plus.

•

How to use rulers to vary line spacing, tabs and text pitch at different points
in your documents.

•

How to organize page layout (paper size, header and footer text, chapter and
page numbers) to suit your particular printer.

•

How to store the document layouts and rulers you use most frequently.
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SETTING UP THE MARGINS
To set the margins to be left at the top and bottom of your document when it is
printed, select Page Layout... in the Layout menu to display the Page Layout
dialogue box. Use the left arrows to reduce t.~e value displayed, and the right
arrows to increase the value.

!Head L: ..___ _ _ _ _ _ __,
IHead C:
IHead R: ....___ _ _ _ _ _ __,
1

::::==============:

!Foot L: ....___ _ _ _ _ _ __,
!Foot C:llll
IFoot R:!....__ _ _ _ _ ____,

::::==============:

@]~@]
~[!]@]
~[!]@]

@][!]@]
@]IT]@]
~

56

Paper Length
TOF Margin ICancel I
Head Margin
Foot Margin
BOF Margin
Linestpage

I
I
I
Ii

I

Paper size
Paper Length shows the total number of lines your printer paper is physically
capable of holding. Alter the Paper Length value only when you change the size
of the paper in your printer. The default value (ie, the standard, unless you
change it) for this option is 66 lines.
TOF (top of form) margin

This shows the number of lines between the top of each sheet of paper or form
and the header line, excluding the header. The default value for this option is one
line.
Head margin

This shows the number of lines between the header line and the first line of text,
including the header. The default value for this option is three lines. If you set
this option to zero lines, the header line will not be printed out.
Foot margin

This shows the number of lines between the last line of text and the footer line,
including the footer. The default value for this option is three lines. If you set this
option to zero lines, the footer line will not be printed out.
BOF (bottom of form) margin

This shows the number of lines from the footer line to the bottom of the sheet of
paper, excluding the footer. The default value for this option is one line.
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Lines/page (page length)
The total number of lines which will be printed on each page is then worked out
by subtracting the margins from the paper length. The default value is 54 lines
per page.

Left and right margins
The left and right hand margins are set with the Ruler. See the next section for
details on how to do this.
Note: If you have a cut-sheet feeder, your printer may restrict both the
page length and the position of the first printed line. In this case, you
may need to experiment a little to get the correct page layout. For
example, an Epson LQ-800 printer with an A4 sheet feeder attached
needs a paper length of 70 lines, a TOF margin of 1 line, and a BOF
margin of 9 lines.
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HEADERS AND FOOTERS
1st Word Plus allows you to specify header and footer lines of text to be printed
on each page. The following illustration shows where the header and footer lines
will appear on each page in relation to (a) the paper length and (b) the total
number of lines of text on each page, or the page length.

-lto:g·;~ -- -- · -· · -· ·
Header Line
•Le•ft
_ _ _ _C_e•n•tr•e---•R•ig-ht ::

l

~I:: ~~:t.~i;~

:

Page
Length

Footer Line

Left

1

Paper
Length

-· -T· · -z.-Fo~t- -· -· · ·
B-O~/~~~n__ __

Right ____ __

'f

+

Margin

.___ _ _ _ _ _ _ _ _ _ _ _ _ ___J_ ·· - · · - • . - · · - · · - ·· - · · - · ·

•. -
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Select Page Layout... in the Layout menu to display the Page Layout dialogue box.

!Head L:I
!Head C:I ::=:==========~
::===========~
!Head R:I.__
_ _ _ _ _ ___,
!Foot L:I
~=========~
!Foot C:!lll
!Foot R:I.___ _ _ _ _ ___,

::============

@l~@J

@] ITJ@J
@][!]@]
@][!]@]
@lm@J

Paper Length
TOF Margin ICancell
Head Margin
Foot Margin
BOF Margin

~

Head Left/Head Centre/Head Right
These boxes allow you to specify what is printed in the header line on each page.
Text in the header line may be centred, or aligned left or right. Enter the text you
want for each part of the header. Use the mouse to move the cursor to each box in
the normal way.
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Foot Left/Foot Centre/Foot Right
These boxes allow you to specify what is printed on the footer line on each page.
Text in the footer line may be centred, or aligned left or right. Again, enter the
text you want to appear in each part of the footer.

If there is no entry in a header or footer box on the dialogue box, then nothing
will be printed in the corresponding place on the pages of your document.
Page numbering
Place the number symbol # in a header or footer box to print the page number.
The page number is printed at Foot Centre by default and will need to be
deleted from that box on the dialogue box if you do not want it printed there.
1

1

Head Margin and Foot Margin
Make sure that the Head Margin and Foot Margins are both set to at least 1, or
the headers and footers will not appear (see the section Setting up the margins) .
Note: Headers and footers take their ruler settings from the first line of
a document. For example, if the first line is in expanded pitch, the
headers and footers for that document will also be in expanded pitch. If
the first line is a headline in expanded pitch and you do not wish the
headers and footers to have that setting, you can insert a blank line at the
beginning of the document above the headline and give it a different
ruler of your choice.
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RULERS
The width of the text you are typing, the left and right-hand margins, and the
positions of the tabs (as well as the character and line spacing - see sections
below), are determined by the ruler, which appears at the top of the text window.
The ruler line shows which ruler you are using at the current cursor position. By
default, this ruler is set up for 65 characters per line, with tab stops every 5
characters:

To turn the ruler line display on and off, select Show ruler in the Layout menu. If
the ruler is currently displayed, Show ruler will have a tick by it.
Adding rulers
You can add as many new rulers at various places in your document as you wish.
This lets you use, say, a different paragraph width for quoted text, or a different
set of tab stops for tables.
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To add a ruler at the cursor position, select Add ruler ••• in the Layout menu. The
following Add Ruler dialogue box will be displayed, allowing you to select
your own combination of tab spacing and ruler length (as well as line spacing
and character pitch):

l:Ml:miJI
Pitch

Tab Spacing

Elite

mm~

mme

I Condensed I
I Expanded I

Tabs: lffm~

Ruler Length:
Justify

~

llID
Cancel

@lrn@I
Line Spacing

@10@1

il

!.:1111 mrnKi111.t~i.

Ruler length
Use the left or right arrows to increase or decrease the ruler length to any
number between 10 and 150 characters. (This figure refers to the position of the
right margin, not the distance between the left and right margins) . The default

6.3

ruler lengths for the four character pitches (spaces) are based on a line 6.5 inches
long:
•
•
•
•

65 characters (Pica pitch)
78 characters (Elite pitch)
112 characters (Condensed pitch)
39 characters (Expanded pitch)

(Character pitches are explained in the section below entitled Character
spacing) .
When you have selected the ruler length you require, select OK to ipsert the new
ruler at the current cursor position. An inserted ruler will affect all text up to the
next ruler in the document.
Remember to reformat your text when you insert a new ruler by using the ITITl key
or icon, or selecting Refonnat••• in the Style menu. For more details, see
Reformatting text in the next chapter, Editing documents.
To check the extent of a ruler
To check how far down the page a particular ruler's influence extends, move the
mouse pointer over the ruler icon at the left-hand end of the ruler beneath the
foreground/background icon and press select. A line indicating the extent of the
ruler will be displayed in the page border on the left of the text window.
Deleting rulers
To remove a ruler from a document, place the cursor anywhere in a piece of text
where the ruler applies, then select Delete ruler in the Layout menu. Don't forget
to reformat your text after you delete a ruler.
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MODIFYING RULERS
Modifying a ruler is not the same thing as adding a ruler.
When you add a ruler, it affects text occurring between the cursor position
(where the ruler is added) and the next following ruler. On the other hand, when
you modify a ruler (by dragging the right margin to a new position, for example),
all the text within the scope of this ruler will be affected when you reformat,
whether it occurs before or after the current cursor point.
To display the Modify Ruler dialogue box, position the mouse pointer ov¢r the
ruler icon at the left-hand end of the ruler and double-click select. Select the
combination of character pitch, tab spacing, tab style (ie space or dot), etc which
you require, then select OK to update the ruler line.
You can also modify some parts of the ruler line (the tab stops and the margins)
using the mouse. Position the cursor within the influence of the ruler you want to
change, then drag the left and right hand margin stops to the new position you
want. Use the Reformat key to reformat each paragraph to the new text width.
Left and right margins
The right margin determines where the line ends, and hence where word wrap
and right justification will occur.
You can alter the position of the right margin stop (as in this paragraph) by
dragging it with the mouse to the desired position. To drag the right margin
outside the current window area, you must first horizontally scroll the window.
You can also alter the position of the left margin (as in this paragraph) by
dragging it to the desired position. Don't forget to reformat your text after
changing the left or right margin.
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Note: Dragging the margin stops does not necessarily have quite the
same effect as modifying a ruler. If you alter either of the margins, only
those paragraphs you type or reformat after the change will be
affected.

STORING RULERS
1st Word Plus stores the rulers along with the text when you save a document in
WP mode. The stored rulers will be redisplayed when you next open the
document for editing. If you read in a file with a different ruler in it using Read
file ••• , the stored rulers will be read in with the text.

If there is a particular type of ruler line which you use a lot, you may want to store
it, rather than setting it up from scratch each time. This will enable you to use the
same page layout, tab settings etc.
Select Read ruler••• in the Layout menu, and 1st Word Plus will read the first
ruler line in the file you specify into your document at the cursor. (This file need
not have any text in it, of course, but may just contain the ruler line!)

TABS
1st Word Plus has three different types of tabs - left-aligned, right-aligned and
decimal tabs.
Tabs are set up using the ruler, and a set of tab stops applies to all text within the
extent of a particular ruler.
When you press ITab I or use CI[], the cursor will move to the next tab stop to the
right. As on a typewriter, you can preset tab stops for aligning columns of text,
formatting tables, and so on.
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You set tab positions from the Add Ruler dialogue box (Page layout••• on the
Layout menu). Use the mouse to select the required gap between tab stops (3 4 5
6 8 10 etc). The tab stops can later be amended if, for example, you do not wish
them to be regularly spaced across the page.
You can also set and clear tab stops by positioning the mouse pointer over the
appropriate place on the ruler line and pressing select.

Left-aligned tabs
This is the normal type of tab, where the left-hand edge of the word lines up with
the tab . This table uses left-aligned tabs:
kelvin
second
mole

kilogram
ampere
candela

Decimal Tabs
You can use 1st Word Plus' Decimal tabs feature to line up columns of decimal
numbers on their decimal point in the following way:
156.4
84450
28.9854

--

2.4666
7800.25
.58348

Position the mouse pointer over any point on the ruler line and double-click
select to insert a decimal tab. The position of the decimal tab will be indicated
by a hash sign.
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Anything you now type in will be moved leftwards from the decimal tab until
you either:
•

Type a decimal point or a space, or

•

Press l:£Jor ITab I, or

•

Reach any previous text on that line.

To remove a decimal tab from the ruler line, select it with the mouse again.
Right-aligned tabs
You may want to align not just numbers, but any kind of single entries in a table
on their right-hand edges:
Andrew
Bill

Charles

Anne
Betty
Carol

Use the decimal tab in just the same way as described above to right-align words
and numbers.

CHARACTER SPACING
Character spacing, or pitch, is set at the same time as the ruler, and hence applies
to text within the influence of a particular ruler.
To alter character spacing, select Add ruler••• from the Layout menu. The Add
Ruler dialogue box will be displayed.
Select the character spacing, or 'pitch' you require using the mouse:
•
•
•
•
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Pica (10 characters per inch)
Elite (12 characters per inch)
Condensed ( 17 characters per inch)
Expanded (6 characters per inch)

- . : , i V\..,U1VlC1'-j .1 Lftl.VU .1

Note: The number of characters per inch for each pitch will vary from
printer to printer. The figures quoted above are valid for most Epsoncompatible printers.

JUSTIFICATION
Text can be either justified, with straight left and right margins, as in this
paragraph :

In a reference list, with author-date text references to
it, all works attributed to one person should be listed
and arranged chronologically by date of publication.
or unjustified, with a straight left margin and a ragged right margin, as in this
paragraph:

In a reference list, with author-date text references to
it, all works attributed to one person should be listed
and arranged chronologically by date of publication.
Ragged right is believed by some to be easier to read in long documents than
justified text, as the eye can find its way more easily around the contours of the
ragged edge.
Justification is set at the same time as the ruler, hence applies to the piece of text
affected by a particular ruler.
To turn justification either on or off, for the duration of a particular ruler, select
Add ruler... from the Layout menu. The Add Ruler dialogue box will be
displayed .
Select the relevant box to tum right justification on or off.
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If you select Justify ON for a particular ruler, 1st Word Plus will automatically
insert extra "stretch" spaces between each word as you type, so that the right hand
margin is straight. (The last line of each paragraph is excluded from this
process.) Right justification is switched off by default on the Add Ruler dialogue
box.
If you change justification, you will need to reformat by using the [ill] key or icon,
or selecting Reformat... in the Style menu (see Reformatting text in the chapter

Editing documents) .

WORD WRAP
At the end of each line, if the word you are typing goes beyond the right margin, it
will automatically be carried over to the next line. Since the only time you have to
press [£]is when you want to begin a new paragraph, you don't have to worry
about where to end each line. This in tum increases your typing speed. Word
wrap is switched on by default when you load 1st Word Plus in. You can tum
Word wrap off and type in lines up to 160 characters long by selecting it in the
Edit menu. A tick against Word wrap indicates whether or not it is switched on.

LINE SPACING
You can control the spacing between lines of text, in increments of one line.
Line spacing is also set at the same time as the ruler, hence applies to the piece of
text affected by a particular ruler.
Select Add ruler... from the Layout menu.
Use the left and right arrows on the Line Spacing feature to increase or decrease
line spacing to a number between 1 and 9. Single line spacing is switched on by
default when you first load in 1st Word Plus.
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FORMAT FILES
To save you having to set them up each time you start a new document,
1st Word Plus allows you to store "skeleton" format files with preset headers,
footers, ruler lines, and text.
Whenever you use Open file ••• to create a new file, 1st Word Plus looks in the
directory you are working in for a format file . If it finds one, it then reads it into
the beginning of the new file .
To create and store a format file, follow these steps:
1

Open a new file called format.

2

Set up the headers, footers, ruler lines and text you require in the file.

3

Use the Save file or Save as ••• command in the File menu to save your file in
the directory where you intend to create the files with which you are going to
use the format. Note that the format file and the document files must be in
the same directory.

Altenatively, you can load the skeleton format file itself, write your document
then save it (using the Save as ••• command) with a different file name, keeping the
skeleton file for use another day.

HYPHENATION
1st Word Plus has the ability to hyphenate words (break long words at the end of
a line), so making better use of the line length and giving your document a more
professional appearance. Hyphenation is switched on by default.
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When a paragraph is reformatted, 1st Word Plus may try to hyphenate one or
more words to avoid "slack" lines with too much white space in them. For each
word which the program tries to hyphenate, the following dialogue box will be
displayed :
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To move the hyphen to a different point in the word, position the mouse pointer
over either the left or the right arrow box and press select. The hyphen will move
along one character at a time. When the hyphen is in the position you require,
select OK, and the hyphenated word will be inserted into your text:

Oakwoods
There are two types of oakwood in Britain, danp oakwoods and
dry oakwoods. The typical danp oakwood tree is the PeduncuN
late Oak with its stalked acorns and eeculiar shaped leaves .
The typical tree of the dry oakwoods is the ~ or
Sessile Oak in which the flowers and consequeilfl\l'fhe acorns
have no stalks and the leaves have star-like hairs on their
undersurfaces.

Although a "soft" hyphen inserted by 1st Word Plus appears on screen as - to
distinguish it from a "hard" hyphen inserted by the user (as in right-handed for
example), they are both printed as -.

73

If you do not want to hyphenate a particular word at any point, select Cancel. If
you do not want to hyphenate any words in your document at all, select Disable.
Alternatively, you can select Hyphenation in the Edit menu to switch hyphenation
off (or back on again).

CENTRED TEXT
Centred lines can be produced by positioning the cursor on the line, then using
]ill or selecting Centre in the Style menu. This will cause the line of text to be

centred between the left and right margins:
In a reference list, with author-date text references to
it, all works attributed to one person should be listed
together and arranged chronologically by date of
publication.

RIGHT-ALIGNED TEXT
1st Word Plus also allows you to align your text with the right-hand margin,
leaving the left-hand edge ragged. To produce right-aligned text, position the
cursor on each line, then select Right in the Style menu:
In a reference list, with author-date text references to
it, all works attributed to one person should be listed
together and arranged chronologically by date of
publication.

INDENTS
The gap between the left-hand margin and one or more lines of text is called an
indent. 1st Word Plus can produce the following types of indents:
•
•
•

74

single-line indents
paragraph indents
hanging indents.

~ \.Jv\...J.1.V.lJ..:..l.'j

.J.

L~.J.\.J\...J

.J.

Indenting single lines

In a
reference list,
with author-date text
references to it, all works attributed to one person
should be listed together and arranged chronologically by
date of publication.

If you want to indent the first line of a paragraph by 5 spaces, you can do it either
by:
•

positioning the cursor flush with the left margin on the first line, and
selecting Fixed Space in the key box (or press@[]) five times, or by

•

setting the first tab stop to a suitable position (see Tabs above), and pressing
ITab I once to move the cursor to the stop.
Note: Because ITab I in 1st Word Plus inserts fixed spaces, you will have
to delete them one by one if you subsequently want to get rid of this kind
of indent.

Indenting whole paragraphs

Special problems may be solved by observing the
following principles. A single-author entry c omes
before a multi-author entry beginning with the same
name.
In a reference list,with author-date text
references to it, all works attributed to one
person should be listed together and arranged
chronologically by date of publication.
To indent a whole paragraph, use the ::ID key or select Indent one or more times
to specify the size of the indent before starting to type in the paragraph. This kind
of indent is similar in appearance to a I Tab I indent, but instead consists of a single
indent space followed by stretch spaces to the next tab stop. The cursor can be

75

positioned on the indent space only, and deleting this will delete all the stretch
spaces.
This paragraph is indented on each line but
the first line is further indented by pressing Tab
irrunediately after the F9 key at the start of the
paragraph.

1st Word Plus "remembers" indents, so you don't need to respecify them when
reformatting. To change the size of a paragraph indent, first position the cursor on
the first character in the paragraph. Use Back Space or I Delete I to reduce the size
of the indent, or mJ to increase the size, then reformat.
To indent a whole paragraph which has already been typed, first select the first
line and press mJ, then [£IIJ to reformat the paragraph to the indent.
Hanging indents
In a reference list, with author-date text references to
it,all works attributed to one person should be
listed together and arranged chronologically by
date of publication.

The paragraph above has a "hanging indent" . Type in the paragraph as normal,
then go back to line 2 and insert an indent with QI]. Finally, use [£!IJ to reformat
from line 2 onwards. A hanging indent will not be preserved if you reformat the
whole paragraph. This is because 1st Word Plus uses the indent value of the first
line to work out the left margin when reformatting.
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Numbered paragraphs
1.1

In a reference list,with author-date text references
to it, all works attributed to one person should be
listed together and arranged chronologically by
date of publication.

To number paragraphs, type the paragraph number (or letter) followed by one
or more[}[] indents before the first word in the paragraph. 1st Word Plus will
align following text lines with the last indent.

PAGE BREAK
1st Word Plus uses three types of page break, or places where a new page of
printed text starts. These are displayed in the page border on the left of the text
window, with the new page number directly beneath. Although you can work on
documents of 100 pages or more, there is only enough room in the page border to
display numbers up to 99.
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Soft page breaks

There are two types of oakwood in Britain, danp oakwoods and
dry oakwoods. The tyeical danp oakwood tree is the
Pedunculate Oak with its stalked acorns and peculiar shaped
leaves. The tyeical tree of the dry oakwoods is the ~~rnast
or Sessile Oak in which the flowers and consequently e
acorns have no stalks and the leaves have star-like hairs on
their undersurfaces.
lhere are two types of oakwood in Britain, danp oakwoods and
ary oakwoods. The tyeical danp oakwood tree is the
Pedunculate Oak with its stalked acorns and peculiar shaped
leaves. lhe typical tree of the dry oakwoods is the ~~rnast
or Sess,le Oak in which the flowers and consequently e
acornsave no stalks and the leaves have star-like hairs on
their undersurfaces.
There are two types of oakwood in Britain, danp oakwoods and
dry oakwoods. The typical danp oakwood tree is the
Pedunculate Oak with its stalked acorns and peculiar shaped
leaves. The tyeical tree of the dry oakwoods is the Durnast
or Sessile Oak in which the flowers and consequently Tfieacorns have no stalks and the leaves have star-like hairs on
their undersurfaces.

A 'soft' page break is indicated by a dotted line in the page border with the new
page number appearing directly beneath it. These are inserted automatically by
1st Word Plus when the maximum page length is exceeded with WP mode
switched on. Page length is defined for the whole document using the Page
layout••• option in the Layout menu. (For more details, see Setting up the margins
in this chapter.) You can convert a soft page break to a hard page break by
positioning the mouse pointer over it in the page border and pressing select.
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I-lard page breaks
Insert a hard page break whenever you want the text below it to be printed on a
new page.

Oakwoods
There are two t~pes of oakwood in Britain, danp oakwoods and
dr y oakwoods. The typica l danp oakwood tree is the
Pedunculate Oak1 with its stalked acorns and peculiar shaped
leaves. The typica l tree of the dry oakwoods is the Durnast1
or Sessile Oak1 in which t he flowers and consequentl {Tiieacorns have no st al ks and the leaves have star-like ha irs on
the ir undersurfaces.
Hard page break
[M

I
To insert a hard page break position the mouse pointer in the page border at the
desired position and press select. A hard page break is indicated by a solid
horizontal line with the new page number appearing directly beneath it.
Select a hard page break again with the mouse to delete it, or to convert it back to
a soft page break.
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Conditional page breaks
A conditional page break is always created by the user (except with footnotes,
see Printing footnotes in the Chapter Editing a document) . It is used to protect a
group of lines that you do not wish to be split across two pages (for example a
paragraph or a table of figures) . If the group of lines crosses a potential page
boundary, then a new page is started at the beginning of the group.
To create a conditional page break, position the mouse pointer in the page border
level with the first line of the group, hold down select then drag the mouse down
the page border to the last line to indicate the scope of the group. While you are
holding down select, the mouse pointer turns into a pointing finger, and the scope
of the conditional page break is indicated by a black oblong.
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OCUMENT LAYOUT

Once it has been set up the conditional page break appears as a very light dotted
line across the page border with a further dotted vertical line denoting its scope.

Conditional page break

RITISH WOODLANDS
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e ypical tree of the dry oakwoods is the DurMast1
or Sessile Oak1 in which the flowers and consequently~
acorns have no stalks and the leaves have star-like hairs on
their undersurfaces.
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If 1st Word Plus actually inserts a soft page break at the start position, the
conditional break display changes to a heavier dotted line with the new page
number directly beneath it. The vertical line denoting its scope remains visible:

There are two t!lpes of oakwood in Britain, danp oakwoods and
dry oakwoods. The typical dall\p oakwood tree is the
Pedunculate Oak with its stalked acorns and peculiar shaped
leaves. The typical tree of the dry oakwoods is the ~
or Sessile Oak in which the flowers and consequently the
acorns have no stalks and the leaves have star-like hairs on
their undersurfaces.
lhere are two tYTpes of oakwood in Britain, danp oakwoods and
i!ry oakwoods. he typical dall\p oakwood tree is the
Pedunculate Oak with its stalked acorns and peculiar shaped
leaves, The typical tree of the dry oakwoods is the ~~rnast
or Sess,le Oak in which the flowers and consequently e
acornsave no stalks and the leaves have star-like hairs on
their undersurfaces.
There are two types of oakwood in Britain, danp oakwoods and
dry oakwoods . The typical danp oakwood tree is the
Pedunculate Oak with its stalked acorns and peculiar shaped
leaves. The typical tree of the dry oakwoods is the Durnast
or Sessile Oak in which the flowers and consequently ~
acorns have no stalks and the leaves have star-like hairs on
their undersurfaces.

-

I

You can increase or decrease the scope of a conditional page break by dragging
the end position to a new place. Delete this kind of page break by selecting the
start position with the mouse.
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CHANGING TYPEFACE
1st Word Plus offers you a range of typefaces (roman, italic, underlined,
superscript and subscript) in three different weights (bold, medium and light) .
You can combine and alternate these style options to produce a variety of effects:
bold
bold underlined
bold underlined italic
medium subscript
medium italic
medium underlined italic superscript
light
light italic
light underlined italic
Note: Your printer may not be able to reproduce all the style options
available on-screen (see Appendix B Printer configuration for details) .
The typeface options can either be selected from the Style menu or by using
function keys CID to 00 .
When a style option is switched on, its function key icon will appear in reverse
video and it will be ticked in the Style menu. Everything you type in from that
point onwards will appear in that style, including spaces. If you later delete this
text, be careful not to leave "style spaces", which will then pass on their style to
anything typed in after them.
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Note: It is not possible to combine either (a) Bold and Light or (b)
Superscript and Subscript. Selecting one style option (eg Bold) will
automatically tum the other one (eg Light) off.
Underlined headings
With some word processors, producing underlined headings which are either
centred or indented can be a problem, since the space before the start of the
heading is underlined too. Other word processors get round this problem by not
underlining any spaces, including those between words! However, you can
produce perfect underlined headings with 1st Word Plus by following these
simple steps:
•

To underline indented headings:
Use ITab I orffi] to indent the heading.
2 Switch on Underline [fil.
3 Type in your text.

•

In the same way, to underline centred headings:
Switch on Underline [fl] .
2 Type in your text.

3 Use [ffi] to centre your heading.
With 1st Word Plus, it is also possible to produce italic underlined text without
tears:
Switch on Underline [fl] and Italic@].
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2

Type in your text.

3

Switch Underline [filoff.

-

4

Type an italic space.

5

Switch Italic [TI] off.

6

Carry on typing in your text.

The last character of the italic text may appear to have a slice out of it on the
screen. It will, however, be printed normally.
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Very few documents are exactly as you would like them to be when you have just
typed them in, and most will require some amount of editing such as correction,
substitution, insertion, or format changes. This section covers not only the basic
techniques of cursor editing, but also the more powerful procedures of block
manipulation, and search and replace editing.
To edit a document file with 1st Word Plus, press menu to call up the menus, then
select Open file ... in the File menu to display the OPEN FILE dialogue box. Use
the dialogue box to select the file you wish to edit as described under Opening a
file, in the Basic techniques. When you have selected the file, move the mouse
pointer over the OK button and press select to open it. Alternatively, you can
double-click select with the mouse pointer over the filename in the scroll box to
open the file directly.
When carrying out simple editing on text by deleting or inserting characters,
changes always occur at the position of the cursor. You must therefore move the
cursor to the part you want to alter before making any changes. Scroll through
your document until the portion you want to edit is visible on screen, then position
the cursor by using the mouse or the cursor keys (see the section on Moving the
cursor in the chapter Basic techniques).

-

DELETING TEXT

You can use the keyboard in five ways to delete text:
•

To delete a character to the left of the cursor, press Back Space or I Delete I or
select Delete and left arrow in the key box.

•

To delete the character the cursor is on, press I Copy lor select Delete and right
arrow in the key box.

•

To delete everything from the cursor to the beginning of the next word, press

I Shilt 11 Copy I.
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•

To delete the entire line that the cursor is on, press or select 00

•

To delete everything from the cursor position to the end of the line that the
cursor is on, press [§ill I Copy I.

If you wish to delete several letters, words, or lines, you can use the computer's
auto-repeat facility by holding down the relevant key(s), or holding down select
while the pointer is on the icon. Beware when deleting indents and stretched
variable spaces, because all the stretch spaces will be deleted with them.
You can also delete larger sections of text using the Block menu (see Editing

blocks of text in this chapter).

INSERT AND OVERWRITE MODES
You can insert new text into a document in two ways: by using insert mode or
overwrite mode.
Insert mode
When you begin a session with 1st Word Plus, insert mode is switched on by
default. To indicate this, the Insert mode option in the Edit menu is ticked, and
the F7 icon appears in reverse video. In this mode, anything you type is inserted at
the cursor position pushing everything to the right of it over to make room. The
text of that line is automatically rejustified if you make the insertion at the end of
a line, but you may need to reformat the rest of the paragraph afterwards.
Overwrite mode
Overwrite mode is the alternative to insert mode, often preferred by
programmers. As you type in new text, it is written over the existing text at the
cursor position. Where there is no existing text (for example at the end of a line),
then new text is inserted as usual. In this mode, the ITab I and G!J keys simply
move the cursor without inserting any spaces or lines.
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Use overwrite mode, for example, when you want to change a piece of text from
lower case to upper case (or the other way round). Try changing 'Eating Oysters'
to 'EATING OYSTERS':
Type in the words Eating Oysters.
2

Move the cursor to the beginning of the word Eating.

3

Switch to overwrite mode by using the [}l] key or icon, by pressing Insert, or
by selecting Insert mode in the Edit menu.

4

Tum I caps Lock I on by pressing the key or selecting the icon.

5

Finally, type in capital letters to the end of the word 'Oysters'.

When you have finished making replacements in overwrite mode, be careful to
switch back to insert mode, otherwise you may write over text that you want to
keep.

MERGING DOCUMENTS
It is easy with 1st Word Plus to merge one document with another by reading it in
from disc and inserting it into the "master" document. To do so, follow these
steps:
Position the cursor where you want the new text to be displayed.
2

Select Read file ••• in the File menu to display the Read File dialogue box.

3

Select the file to be inserted in the same way that you selected a file to open,

4

Select OK to read it in.

The document file will then be inserted into your master document at the cursor
position.
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EDITING BLOCKS OF TEXT
The Block menu commands will not only let you delete blocks of text and
pictures, but also copy them, move them, change their style (bold, light, italic,
underlined etc.), and cut and paste them between documents in different
windows. Before you can try some of these options out, you will need to mark
your block.
Marking blocks
There are two ways of marking blocks of text, pictures, or a mixture of both,
depending on the size of the block:
•
•

mark a small block, which is all on the screen, by dragging the mouse
mark a large block, which does not all need to be on the screen, by using the
Block menu.

To mark a small block, point the mouse at the first character to be marked, hold
down select, drag the mouse across until the last character you want to include in
the block is highlighted, then release the mouse button. This is the faster method.
To mark a large block, use the Block menu. Position the cursor at the beginning of
the block you want to mark, select Start block, move the cursor to the character
after the last one you wish to include in the block, and select End block. (A quick
method of redefining the end of a marked block is to move the mouse pointer to
the character following the end of the required block and double-click select.)

90

Whichever method you use, the marked block will be highlighted with a black
background:

-

-

-

If you have marked the start or end of a block, but cannot remember where it is
located, select Find start or Find end in the Block menu.
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Removing block marking
To remove the block highlighting, either mark a new block or select Hide block in
the Block menu. Using Reformat ••• in any part of a document also has the side
effect of removing block highlighting anywhere in that document. You can also
remove highlighting by pressing and holding down select .
Cutting a marked block
To cut a marked block, select Cut block in the Block menu. The marked block
will first be copied onto the clipboard, or storage area in the machine, and a
message will appear to inform you when this has been done. When you select
OK on this dialogue box the marked block will be cut or removed from your
original document. If the clipboard already contained an item which had been
cut from a document and not yet pasted into another place, a warning will appear
allowing you to cancel your instructions if necessary, as the original clipboard
contents would be lost if you copied another item over them.
Copying a marked block
To copy a marked block, without it being cut from your document, select Copy
block in the Block menu. The marked block will then be copied onto the
clipboard, but the original version will be left intact in its current position in your
document.
Pasting a marked block
To paste a block back into your document, move the cursor to the place where you
wish to insert the block, then select Paste block in the Block menu. The block to
be pasted is the one last copied or cut from the text. You can paste several copies
of the same item from the clipboard back into your document, by repeating the
paste operation. The copy remains on the clipboard unti.l another item is cut or
copied onto it. If you have more than one window open, you can also cut or copy a
block from one window, and paste it into a document in another window, by
changing the current window between the cut and paste operations.
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Moving a marked block
To move a marked block, that is to remove it from its original position and place it
somewhere else, position the cursor at the place you want to move it to, then select
Move block in the Block menu. This operation has an effect similar to first cutting
and then pasting a block of marked text. Note that this operation also involves use
of the clipboard, and will delete any existing contents from the clipboard.

-

It is also possible to mark blocks of spaces, and then move them, copy them, or
delete them! Be careful, though, as only lines containing text are highlighted.
Keyboard shortcuts exist for all the block operations listed above, and are as
follows:
•
•
•

•

~CIT]
~ [ill
~ [ill

is the same as Cut block
is the same as Copy block
is the same as Paste block
~ ~ is the same as Move block

Restyling blocks
To restyle a section of text, mark it as a block, then select a character style or
combination of styles using the function keys, the key icons, or the Style menu.
Whatever styles you choose will be applied immediately to the text in the
marked block. Key icons which are currently turned on will be highlighted in
reverse video and if you call up the Style menu you will see that the option(s) you
have chosen have a tick against them.

-

USING "BOOKMARKS"
If you are editing a fairly large document, you may frequently need to move from
one part of the text to another. In these circumstances, it is quite easy to lose your
place. With 1st Word Plus, you can use up to four invisible "bookmarks" to keep
your place in the text.
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Setting marks
To set a mark anywhere in your document, position the cursor at the point to be
marked, call up the menus and run the mouse pointer over the Edit option. When
the Edit menu appears run the mouse pointer over the Set mark option and select
the number of the mark you wish to set, remembering that you can have a
maximum of four marks. A mark with that number will then be set at the cursor
position. Note that marks are not visible on the screen, and are not stored with a
file when it is saved to disc.
Finding marks
You can now move freely within your document knowing that you will be able to
move back instantly to your mark at any time. To move the cursor to one of your
marks, run the mouse pointer over the Edit option again, then run it over the Goto
mark option. Select the number of the mark you wish to find and the cursor will
be moved to that mark.

CREATING FOOTNOTES
To create a footnote at the cursor position, select Add footnote .•• in the Layout
menu. 1st Word Plus will then:
•

Insert a footnote27 number from 1 to 999 in superscript text (such as the 27
indicated here) . Note however that you will only be able to place the cursor
on the first digit of such a number eg '2'.

•

Open up a special footnote window for you to enter your footnote text.

Pressing @ill [E] has the same effect as selecting the Add footnote ... command.
You can add footnotes wherever you like, except in header lines, footer lines, or
footnotes themselves!
The following menu commands, when used "globally" on entire documents will
include footnotes in their scope of operation, although you may need to close the
footnote window before you can activate them.
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Spelling checker
Search and replace
Statistics •••
Reformat •••

In each case the program deals with the main text, then deals with each footnote in
tum. However, note that if you select Reformat••• while you have the footnote
window open, the whole of that footnote will be reformatted automatically
without a dialogue box being displayed.
The footnote window

Oakwoods
There are two types of oakwood in Britain, daMp oakwoods and
dt'\I oakwoods, The typical da1r1p oakwood tree is the
Pedunculate Oakl with its stalked acorns and peculiar shaped
leaves. The typical trej of the dry oakwoods is the Dfh1r1ast1
or Sessile Oakl in which the flowers and consequently e
acorns have no stalks and the leaves have star-like hairs on
their undersurfaces.

-F19 Fixed sp F11 Centre
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If you want to edit a footnote, position the mouse pointer over its number and
double-click select. 1st Word Plus will open a special window, called the
footnote window, for you. The text for the footnotes themselves is not displayed in
the same window as the main text of the document, but in a footnote window. You
can then edit your footnote text using a slightly restricted set of 1st Word Plus
commands.
To save the footnote and close the window when you have finished editing, select
the quit icon at the top left-hand corner of the footnote window. Pressing@ill[}D
with an open footnote window will also save and close it. While the footnote
window is open you will not be able to select any other window as the current one.
Note: It is not possible to paste pictures into footnotes. If you read a
file containing pictures into a footnote, the pictures will not be
displayed.
The footnote ruler line
You can alter the footnote ruler line whenever you have the window open By
default, the left margin of the footnote ruler is inset by three spaces (ie at column
4) to leave space to print the footnote number. All of the footnotes contained in a
document are formatted according to the footnote ruler line displayed in the
footnote window.

RENUMBERING FOOTNOTES
This occurs automatically whenever you add or delete a footnote. All subsequent
footnotes in the document will immediately be renumbered in the correct order.
This applies even if you use Read file ••• to insert a document file containing
footnotes.
However, you have to reformat the relevant lines of text yourself when the
number of digits in a footnote number changes (9 to 10 or 99 to 100). You are not
advised to use footnotes in text which cannot be reformatted automatically (ie

lines which are centred or right-aligned).
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DITI NG DOCUMENTS

Deleti ng footno tes

number in the text
Delete a footnote by positioning the cursor over the footnote
character to the right
the
on
window and pressing I copy I. If the cursor is positioned
the footnote.
delete
of the footno te number, pressing I Delete I or Back Space will
ing alert:
follow
Before the footno te is deleted, 1st Word Plus will display the

Oakwoods
, dat1p oakwoods and
There are two types of oakwood in Britaintree
·
is the
dt•y oakwoods. The tyeical daf!lp oakwood
r shaped
Pedunculate Oak with its stalked acorns and dspeculia
is the f~rmast
leaves, The tyeical tree of the dry oakwoo
consequently e
or Sessile Oak in which the flowers and
acorns have no stalks and the leaves have star-like hairs on
their undersurfaces.
ds and
Delete footnote<s> ?
There are f
haped
I OK
%i&CRHCEL ;ivl
~~~u~~~f~~~
urf!last
leaves. Tn
and consequently~
or Sess~le Oak in which the flowers
acornsave no stalks and the leaves have star-like hairs on
their undersurfaces.
in Britain, dat.ip oakwoods and
There a1·e two types of oakwood
dry oakwoods. The typical daf!lp oakwood tree is the r shaped
reduncula~~ O~k with its stalked acorns and dspeculia
is the Durf!last
e yeical tree of the dry oakwoo uentl
eaves.
~
conse
and
flowet·s
the
which
in
Oak
or Sessile

•
•

Select OK to delete the footnote and its number
Select CANC EL to keep the footnote
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To delete a footnote and the word which precedes it in one operation, position the
cursor at the beginning of the word and press I Shilt 11 copy I. The alert dialogue box
will again appear:
•
•

Select OK to delete the footnote and the word
Select CANCEL to keep the footnote but delete the word

If you attempt to delete a line or a block of text which contains footnotes, an alert
dialogue box will again appear:
•
•

Select OK to delete all the footnotes and the text
Selecting CANCEL will leave footnotes and text intact

PRINTING FOOTNOTES
Footnotes are printed at the bottom of the page on which their numbers appear.

-. Footnote numbers
The number of a footnote will be printed in the first three columns of the first
line of the footn~te text (although while you are editing the text of a footnote, its
number appears on the title line of the footnote window).

--

98

_ . . . .LJ.A..&. &. ... , _

-

-

-

the number, the left
To ensure that these columns will be left empty to take
:
margin of the footnote window is inden ted by three spaces
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1.9 Oakwoods
Britain, dal!lp oakwoods and
Thet'e are two types of oakwood inoakwoo
d tree is the
dr~ oakwoods. The typical dal!lp
acorns and peculiar shaped
Pedunculate Oak1 with its stalked dry
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Oak'
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F19 Fixed sp Fll Centre
This footno te will be printe d out as
2Thi s is a footn ote ...
with a seco nd line .
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To prevent every line of the footnote text from being indented, you can set the left
margin at column 1 and create a tab stop at column 4. Press ITab I once to indent the
first line by three spaces:

Oakwoods
There are two types of oakwood in Britain, danp oakwoods and
dr·y oakwoods, The typical dafllp oakwood tree is the
Pedunculate Oak1 with its stalked acorns and peculiar shaped
leaves . The t pical tree of the dry oakwoods is the DurMastl
01· Sessile Oa
in which the flowers and consequentlytli'e
acorns ave no stalks and the leaves have star-like hairs on
their undersurfaces.

-.

F19 Fixed sp Fll Centre

This footnote will be printed out as
3This is a footnote
with a second line.
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If you do not use any kind of indent ,

-
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OaktJoods
Brita in, danp oakwoods and
Ther·e are two types of oakwood inoakwood
is the
dry oakwoods. The typical danp acorns tree
and peculiar shaped
Pedunculate Oak1 with its stalked
ds is the D.urmas.tl
leaves. The t pical tree of the dry oakwoo
consequently~
or Sessile Oa, in which the flowers and
acorns ave no stalks and the leaves have star-like hairs on
their undersurfaces.

F19 Fixed sp Fl! Centre

ritten with a footno te
the first three charac ters of your footno te text will be overw
reference when you print them out:

3s is a footn ote ...
with a secon d line
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The footnote separator
The footnote separator, which separates one footnote from another, is printed
immediately above the first footnote at the bottom of each page, and is made up
of:
•
•
•

up to 9 blank lines, followed by
a "rule" consisting of up to 160 underlined fixed spaces, followed by
up to 9 blank lines.

To create your own style of footnote separator, within these limits, first select
Footnote format in the Layout menu to display the following dialogue box:

Oakwoods
There are two t~pes of oakwood in Britain, danp oakwoods and
dry oakwoods. The typical danp oakwood tree is the
Pedunculate Oak1 with its stalked acorns and peculiar shaped
leaves. The typical tree of the dry oakwoods is the Durnast1
or Sessile Oakl in whi
nsequently~
acorns have no stalks Footnote Forfllat tar-like hairs on
their undersurfaces.
Lines Above [!]
Rule Length ~
Lines Below [!]
I Cancel I lii Q~in l
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extra lines .
note
28Th is is the secon d footn ote:
line
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as its last line.
Page breaks with footnotes
r on the same page as
1st Word Plus will print a line contai ning a footnote numbe
on the curren t
the footnote text wherever possible. If there isn't enough room
page.
new
a
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printed
be
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te(s)
page, the line and its footno
is displayed in the
In order for this to work, a one-lin e condit ional page break
page border when a line contai ns a footno te number.

-
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This special conditional page break has the following properties:
•

You cannot delete this page break by selecting it.

•

You can drag the mouse in the page border to increase the scope of the page
break downwards (to include following lines), but not upwards (to include
preceding lines).

SEARCH AND REPLACE EDITING
The "search and replace" facility in 1st Word Plus allows you to search for a
particular word, phrase, or other string of text throughout all or part of your
document. The following are all examples of text strings: 'abbot', 'I', 'righthanded', '2nd', 'Mount Everest', 'IS09127'. You can then replace as many
occurrences of your chosen piece of text with another piece of text as you wish.
Searching
To search for a specific word or phrase in your document, follow these steps:
Select Find ••• in the Edit menu or press ~ [IT]. The Find String dialogue
box will be displayed, allowing you to specify:
• The string of text you want to find. Press I Esc I to clear the line first if
necessary. You can use'?' as a wilJ.card to stand for any single character,
including a space. For example, enter 'p?t' to find words such as
'compete', 'computer', 'pit', 'Peter', 'up to', etc.
• The direction you want to look in: Down (onwards search, from the
beginning of the document to the end) or Up (backwards search, from the
end of the document to the beginning). The search begins at the cursor
position.

104

t_

• Whether or not the string searched for must be an absolute match,
including letter case (capital letters or small letters) . If you select
Ignore, then 1st Word Plus will disregard whether a word is spelt
with capital or small letters. For example, if the string is 'bird', it will
also search for 'Bird' and 'BIRD'.
Note: 1st Word Plus will look for exact matches of the string you specify,
including spaces. If you specify the string 'the' (without a space either
before or after it), the program will stop after 'the' in 'whether'.

'?' ~ay be used as a wildcard
IFind:ij
I

M1J.ii)iM I

Up

I

Case: MiM•G• I Ignore I
Cancel IIii . OK iii!
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2

Type in the string you want to find, and decide which direction you want to
search in.

3

Select whether you want all examples of the character string or only those
with matching letter case.

4

Select OK to start the search.

1st Word Plus will run through your document in the specified direction looking
for the first occurrence of the string.

If the string is found, the cursor will be placed either on the first character of the
string (backwards search), or on the character immediately after the string
(onwards search). However, Find ... will not detect two words in a phrase like '1st
Word' if they are split over two lines.
If the search string is not found, the cursor will be placed at either the beginning
or the end of your document, depending on the search direction. The search
direction will automatically be reversed the next time you use the Find ... option.
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Replacing
To replace a specific word or phrase in your document with another, follow these
steps:
1

-

Select Replace ••• in the Edit menu or press ~ @]. The following Find and
Replace dialogue box will be displayed:

Find and Replace
Find the first text string and
replace it with the second one
'?' May be used as a wildcard

kwoods and
iar shaped
he Durfllast3
tly"lli'e
e hairs on
e

l~ce: I'
IRep With:
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This is similar to the dialogue box displayed for Find ••• , and allows you to
specify:
• The string of text you want to find. Press IES<: I to clear the line first if
necessary, since if you have already specified a string using Find ••• the
dialogue box will still display that string. As with Find ••• , you can use '?'
as a wildcard to stand for any character, including a space.
• Your replacement text.
• The direction you want to look in: Down (onwards search, from the
beginning of the document to the end) or Up (backwards search, from the
end of the document to the beginning). The search begins at the cursor
position.
• Whether the string searched for must be an absolute match, including
letter case, or not. For details, see Searching in this chapter.
• Whether to replace One, Some, or All occurrences (the scope of
replacement) .
2

Type in the text you wish to search for, and the text you wish to replace it with,
choose the scope of this replacement and so on.

3

Finally select OK.

If you specify replacement of One or All matches, Replace ••• will search and
replace automatically. If you specify replacement of only Some matches,
Replace ••• will find and display each match and ask you whether or not to replace
the text, or Cancel the search. Select Yes or No, and 1st Word Plus will look for
the next occurrence and offer you the same choice of keeping or replacing the text.
This will continue until no further occurrences are found, or until you select
Cancel.
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You can use the Replace ••• option to make multiple replacements, insertions or
deletions:

I-

•

To replace occurrences of 'cement' with 'glue', give 'cement' as the text to be
found and 'glue' as the replacement text.

•

To insert 'and glue' after the word 'cement', give 'cement' as the text to be
found and 'cement and glue' as the replacement text.

•

To delete 'cement' , give 'cement' as the text to be found, press ITab I to move the
cursor to the replacement text (with) box, then press IEsc I G:iJ to leave this
line empty, before selecting OK.

As with Find .. ., if the search string is not found, the cursor will be placed at either
the start or end of your document, depending on the search direction. The search
direction will automatically be reversed the next time you use the Replace •••
option.
To repeat the last Find••• or Replace ••• , use the Repeat find option in the Edit
menu, or press @jJ [IT] for the same effect This uses the same choices but without
redisplaying either of the original dialogue boxes. If the Find ••• or Replace •.•
finished at the start or end of the document, then Repeat find will automatically
reverse the search direction.

REFORMATTING TEXT
After deleting or inserting any text, or using search and replace, remember to
reformat your text. There are two ways of reformatting text, depending on how
much text is to be formatted:
•
•

reformatting single paragraphs
reformatting larger sections.
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To reformat single paragraphs, position the cursor anywhere in the first line of
the paragraph, then select the [ill] key or icon. Although 1st Word Plus
remembers indents when you reformat single paragraphs, you will need to
reformat hanging indents, centred paragraphs, and right-aligned paragraphs line
by line.
To reformat larger sections of text, or even your entire document, position the
cursor anywhere in the section you want to reformat, then call up the menus and
run the mouse pointer across the Style option. When the next level of menus
appears, run the mouse pointer across the Reformat option, and finally select the
extent of the section you wish to reformat.
You can choose to reformat:
•
•
•

From the cursor to the end of the paragraph
From the first ruler before the cursor to the first ruler after it
The whole of your document, including any footnotes

If you choose to reformat a paragraph the cursor will be placed at the end of the
paragraph after reformatting, if you choose either of the other options the cursor
will remain in its current position.
Note: 1st Word Plus distinguishes between the end of a line and the
end of a paragraph in the following way:
• a line has a space at the end of it
• a paragraph has a ~ at the end of it.
If there is a space before the~ at the end of a paragraph, it will be reformatted
onto the following paragraph.

PASTING IN PICTURES
In order to paste pictures into a document, 1st Word Plus will automatically
switch on Graphics mode when you first load a picture into a document. However,
if there is not enough memory to load a picture, then graphics mode is
automatically switched off and all pictures are removed from memory (you still
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get the picture outlines on screen) . You can switch Graphics mode off in order to
save memory or time or to avoid confusion when editing text which is overlayed by
graphics. You can switch Graphics mode on by calling up the menus and running
the mouse pointer over the Graphics option and selecting Graphics mode. If you
switch Graphics mode on, remember that:
•

No pictures will be loaded if there is not enough memory to load them all
and Graphics mode will be left switched off.

•

You will get an error message if you have removed the floppy disc containing
the pictures from the disc drive. Any picture that cannot be re-read is
deleted from the document.

To insert the picture into your text, move the pointer to the Graphics menu and
select Read picture ••• to display the Read Picture dialogue box. The Directory:
box may need to be edited to show a path leading to the directory where the
picture you require is stored. The dialogue box is edited in the same way as the
OPEN FILE dialogue box described previously in the chapter on Basic
techniques . The name of the picture must be entered in the File: box.
When the correct names have been entered in both the Directory: box and the
File: box, select OK to paste the picture into your text at the cursor position.
Pictures which were created with a palette other than that used by the 1st Word
Plus program may appear with altered colours on the screen, but should return to
their normal colours or tones when printed. Pictures which were created in modes
other than 12 (or 20) may not reproduce correctly.
Note: When you paste a picture into a document, information about it is
stored in the document file. This information includes where in the
document the picture is pasted, and where on the relevant disc to find
the picture. If you move any of your pictures after you have pasted them
into your document (for example, into a different directory), 1st Word
Plus will look in the original directory for the pictures when you reload
that document, and will display an alert for each picture it cannot find .
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If you have a printer driver installed, the picture will have a dotted line around it
to indicate the amount of space it will take up when printed out on that particular
printer. If no printer driver is installed, a default picture size will be indicated
which is valid for many common printers.
Pictures are aligned vertically with the lower edge of the last line they occupy,
and horizontally with the left-hand edge of the nearest column. This allows you
automatically to line up your pictures with the surrounding text.
Moving pictures
Once the picture is pasted into your text, you can reposition it, write over it,
increase the space around it, or (if you are not happy with it) delete it.
To reposition your picture, place the mouse pointer over it, then hold down select.
A "flat" hand will appear and the frame around the picture will change colour.
If you now move the mouse a "ghost" outline of the picture frame will follow the
movements of the mouse on the screen.
When the frame is in the desired new position, release the select button and the
picture will be redrawn in the frame. You can, if you want, overlay pictures onto
pictures, put text and pictures side-by-side, write over your pictures, or move
blocks of text on top of them.
To increase or decrease the amount of space between your picture and the rest of
the text, position the cursor at its top or bottom edge. Use G!J to insert extra lines
of space, and IT[], Back Space or I Delete I to remove lines of space.
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Deleting pictures
To delete your picture, first position the mouse pointer inside it, then press select.
The insertion cursor will move to the beginning of one of the lines occupied by the
picture. Call up the menus, run the mouse pointer across the Graphics option and
select Delete picture. Your picture will switch into reverse video, and an Alert
message will appear on the screen asking whether the correct picture has been
selected. Select OK to delete the picture.

-

,

Note that if you have more than one picture on the same line 1st Word Plus may
be unable to tell which picture you wish to delete. To overcome this, if necessary,
move the picture to another part of the page before deleting it.
There will be an amount of empty lines left in your text equal to the height of the
deleted picture.' You can get rid of this space by marking it as a block, then
selecting Cut block in the Block menu.
Once a picture is pasted into position, it effectively becomes part of the text of the
document. This means that all of the Block menu operations can be carried out on
pictures, or a mixture of pictures and text. In some cases it may be faster to
delete a block of picture(s) and text using Delete block, rather than removing
each picture using Delete picture and then deleting the text.

USING THE SPELLING CHECKER
1st Word Plus comes with a 40,000 word spelling dictionary which helps you
check that every word in your document is correctly spelt either:
•
•

all in one go, after you have finished editing it, or
continuously, as you type each word in.

The spelling dictionary you get with 1st Word Plus obviously cannot contain all
the words you will need to check, but it does have the most frequently used ones.
In particular, it doesn't contain any proper names (words like Iceland, Patrick, or
Uranus), or any legal, scientific, or other technical terms.
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However, with 1st Word Plus you can add these words as required to your own
personal or supplementary dictionary. Since you can create as many of these
personal dictionaries as you need, you will be able to build up your own
"library" of dictionaries.
When 1st Word Plus comes across a word which it does not recognise and which
is misspelt, it will even suggest a list of correct spellings for you to choose from.
Select the word you want, and 1st Word Plus will then instantly replace the
misspelt word in your document with the right one.
In fact, just about the only thing that the 1st Word Plus spelling checker can't do
is to spot a word which is actually spelt correctly, but is in the wrong place eg
'Polai; bares live at the North Pole'.
Loading the spelling dictionary
To load the main spelling dictionary from disc into your Archimedes, select Load
dictionary in the Spelling menu. 1st Word Plus will search for the main
dictionary in the directory in which the 1st Word Plus program is to be found.
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When the spelling dictionary has been loaded in, a dialogue box will be
displayed to allow you to choose and load in a supplementary dictionary, if you
have created one:

oods and

OK
Cancel

...., ..,....... ..

F3 Italic
F9 Indent

F5 Super
F18 Fixed sp Fl! Centre
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Supplementary dictionaries are text files created by 1st Word Plus. They can be
given any name you like, but it is a good idea to use a filename which helps you to
recognise the file as a supplementary dictionary, eg COOKER YSUP ( =
"SUPplementary dictionary"). They must not, of course, be given the same name·
as any other file, including the file they are to be used with, as you would then
delete either the document or the dictionary when using the Save command. Use
the dialogue box to choose a supplementary dictionary in the same way as you
used the Open File ... dialogue box, then, when the Directory: box and the File:
box contain the required entries, select OK Select Cancel if you do not have a
supplementary dictionary yet, or you do not want to use one.
Continuous spell check
To check the spelling of each word as you type it in, select Continuous spelling in
the Spelling menu or press []ill C. When you move the cursor off the word you
have just typed in (by pressing Space Bar, C£J, or one of the cursor keys), the word
is checked against both the main dictionary and the supplementary dictionary. If
it is not found, your Archimedes will "bleep" to show that 1st Word Plus does not
recognise the word. You can then either:
•
•
•
•

carry on typing, or
correct the misspelt word manually, or
use the dictionary browser to correct it (see Using the browser), or
if the word is correctly spelt, add it to the supplementary dictionary (see

Adding words) .
Checking whole documents
To check the spelling in an entire document in one go, place the cursor wherever
you wish to begin the spelling check, then either select Check spelling in the
Spelling menu or press IEsc I. The spelling checker will look at each word from
the current cursor position to the end of your document, and flag any word it does
not recognise by placing the cursor after it. You then have the opportunity to
either:
•
•
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correct the misspelt word manually, or
use the dictionary browser to correct it (see Using the browser), or
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•

if the word is correctly spelt, add it to the supplementary dictionary (see
Adding words) .

To continue checking the spelling in your document, either press I Esc I again or
select Check spelling in the Spelling menu.
Adding words
To add a new, correctly spelled word directly to the supplementary dictionary
(displayed on screen as part of the main spelling directory), select Add word in
the Spelling menu or press [IBJ [}[] . The last word that the program detected as
unrecognisable will then be added to the dictionary, unless you have altered the
contents of the Find: box in the browser since that detection was made. In this case,
the new contents of the Find: box will be the item added. When the addition has
been made, either continue the spelling check as described above or carry on
typing in text.

--

You can also add words either with the browser (see Using the browser), or by
merging a supplementary dictionary into the main dictionary (see Merging
dictionaries ).

-

117

Using the browser
To check that the word has been added select Browse ••• in the Spelling menu to
display the dictionary browser. The browser can also be displayed by pressing
@ill ill] .

1.0
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The browser window displays a merged list of words from both the main
spelling dictionary and your supplementary dictionary (if you have loaded one) .
Whenever you call up the browser it will display the last word added or
spelling mistake found, and 1st Word Plus will also display the corresponding
page in your document in the edit window.
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To find a particular word, press IEsc I to clear the Find line, type in the word, and
select Find. The program will find your word (if it is in the dictionary), and
highlight it in reverse video at the top of the browser window. If the word is not in
the dictionary, the browser window will display the part of the dictionary which
is closest in spelling to it.
To search through all the words beginning with a particular letter of the
alphabet, position the mouse pointer over the up or the down arrow to the right of
the word boxes and press select to scroll the contents of the browser window.
To add a new word to the supplementary dictionary at any time, press IEsc I to
clear the Find line, type in the new word, and select Add . 1st Word Plus will
add your new word to the supplementary dictionary and highlight it in reverse
video.
Spelling correction
The browser also allows you automatically to correct any misspelt words in the
document you are checking. Let's say you have typed in 'steck'. When you check
your spelling, 1st Word Plus will place the cursor after this word to show you
that it is not in either of the dictionaries.
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Move to the Spelling menu and select Browse ... to display the browser. Now
select Guess, and the spelling checker will show you a list of suggested correct
spellings.
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Select the correct spelling in the browser word boxes ('steak', 'speck', etc.), then
select Replace to insert it into your document. If the correct spelling does not
appear in the list of suggestions, you can select Find to return to a full browser
listing, then search through the dictionary as before.
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Saving the dictionary
A session of spell checking ends either when you select End spell check in ~he
Spelling menu, or when you leave the 1st Word Plus program. If you have added
any words to the supplementary dictionary during the session, 1st Word Plus
will display a dialogue box to allow you to save the dictionary to disc either with
the same name as the original supplementary dictionary you had loaded, or with
a new name. By default, the dialogue box will display the name of the original
supplementary dictionary but you can edit the dialogue box just as you did the
OPEN FILE dialogue box. When you have the correct entries in the Directory:
and File: boxes, select OK to save the dictionary. If you select Cancel any new
additions to the supplementary dictionary will be lost.
Removing words
To delete words from a supplementary dictionary, simply load it into 1st Word
Plus as you would any other document file and edit it. To delete words from the
main dictionary, you will need to create a special supplementary dictionary and
merge the two dictionaries together.
Merging dictionaries
The 1st Word Plus spelling checker comes supplied with a special "dictionary
merging" program which allows you to:
•
•

add new words to the main dictionary
delete unwanted words from the main dictionary.
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First use 1st Word Plus to create a supplementary dictionary file containing just
the words you wish to add to or delete from the main dictionary. Create the
dictionary file in the same way as you would any other text file, but ensure that
WP mode is switched off. This is switched off by selecting WP mode in the Edit
menu and the tick indicating that WP mode was operating will disappear. Press
C£J after typing in each word to ensure that it appears on a separate line. Place a
minus sign'-' at the beginning of each of the words to be deleted eg -delete,
-word, -list, etc. Save the document in the normal way.
When you run the dictionary merge program the words which are preceded by a
"-" will be removed from the main spelling dictionary. Words which are not
preceded by a"-" will be added to the main dictionary if they are not in it
already.

If you have created and saved a supplementary dictionary using the browser or
add word facilities while spell checking a document, you can also use the
dictionary merge program to add the words from this to the main dictionary. To
merge two dictionaries, follow these steps:
Select and open the program called lstDMerge (which is on the utilities
disc), from the desktop or from the command line. If you are uncertain how
to do this, see the chapter Getting started and follow details on how to load
the 1st Word Plus program from the desktop or command line.
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When the title dialogue box appears, select RUN.

3

When the Input Dictionary dialogue box appears, enter the correct directory
path and filename for your main dictionary. The file is called lwp_spell
and is usually stored on the same disc as the 1st Word Plus program. If your
system has a single disc drive, you will have to enter the pathname
: 0. resources. 1 wp. * in the Directory: box, and put the 1st Word Plus
program disc in the drive before selecting OK. (Selecting Cancel will stop
the program.)

4

When the Supplementa ry Dictionary dialogue box appears, enter the
correct directory path (still prefixed by : 0 if it is on the main program disc)
and file name for your supplementary dictionary (eg COOKERYS UP) and
select OK. (Selecting Cancel will return you to the Input Dictionary
dialogue box.)

5

When the Output Dictionary dialogue box appears, enter the directory path
and file name you wish to give to the new dictionary that will result from the
merging of the other two dictionaries (eg COOKERYDIC) . Select OK
(Selecting Cancel will again return you to the first item selector.)

While the two dictionaries are being merged, the program will show you which
letter of the alphabet it is currently working on.

If the disc containing the dictionary merging program is too full to hold the new
dictionary you are creating, an error message will appear. If it does, you can
overcome the problem by copying the merging program 1 s tDMe rge together
with its template and strings file and the input and supplementary dictionaries
you wish to use to another disc before running the program.
As soon as the merging process is complete, the name of the new dictionary is
displayed on screen. Select Finish or press [£] to exit from the program.
Note: The spelling checker always looks for lwp_spell as the main
dictionary to be loaded. If your merged dictionary has a different name
(eg COOKERYDIC), and you now want to use it as your main
dictionary, you will need to change its name to lwp_spell . (See your
Archimedes User guide for details of how to rename files .) You will
need to give your original main dictionary a different name before
doing this.
Note, also, that these changes must be made before loading in the 1st Word Plus
program. In addition, if the merged dictionary was created on a disc other than
the one containing the 1st Word Plus program it may need to be copied onto the
1st Word Plus disc, and the original main dictionary may need to be removed
from that disc in order to make room for it.
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SAVING YOUR DOCUMENT
Once you have completed work on your document you will want to keep it safe to
return to at another time, whether to continue editing or simply to refer to it. To
save the whole of your document into the directory that appeared in the Directory:
box, and with the name that appeared in the File: box when you opened the file,
select the Save file option in the File menu. 1st Word Plus will save your
document with this filename into the specified directory, close the text window,
and return you to the startup screen.

If an earlier version of the document has already been saved in that directory
with that filename, 1st Word Plus will attempt to make a backup copy of this
version, before saving the new version. It will only be able to do this if a
directory called bak exists at the correct level in the directory hierarchy.
In order to decide where to save the backup copy, 1st Word Plus will look at the
last element in the directory path for the file . If this last element is one of the
special directory names such as % or", or a root directory (see Directories in your
Archimedes User guide) then 1st Word Plus will look in that directory for the
bak directory and if the bak directory is found, it will store the original version
of the document in it.
Similarly, if there is no directory path attached to the filename because it is in the
current directory then the search for a bak directory will be made in whichever is
the current directory. If the directory is found the original version of the document
will be stored in it.
If the last element of the directory path is an ordinary directory name, eg
letters, Fred, 12345 or whatever, then the program will look for the bak
directory in the directory which precedes this directory in the hierarchy, ie the
penultimate directory, and store the original version of the document in it.
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Files retain their original filenames when moved to a bak directory. Care must
therefore be taken with the organisation of files.

A

I
I

B

letter A

c

bak

I
letter B

If, for example, directory A is the current directory and contains two lower level
directories Band C together with a bak directory, and the directories Band C
each contain a file called letter then the backup versions of the letter files
from both directories would be stored in the same bak directory with the same
filename . In fact the backup copy of the last one to be saved would overwrite the
backup copy of the first one. To overcome this problem you could call the files
letterAand letterB.
If a bak directory is not found within the directory in which the search is made, a
dialog box will appear to warn you that no backup will be made.
Select Continue to save the file without a backup. If you select Cancel, you can
then use the Save as ••• command to save the file in a different directory where a
bak directory and therefore a backup facility is available.
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AVING AND PRINTING

Saving with a new name
To save the whole of your document with a new name, or in a different directory,
select Save as ... in the File menu. When the dialogue box appears, you can choose
a new disc, directory path, or name for your document. If there is already a file
with the name you have selected, in the directory you have chosen, 1st Word Plus
will attempt to turn this file into a backup copy and save it in an appropriate bak
directory. 1st Word Plus will then save your document in its place and close the
text window, returning you to the startup screen.
Save and resume
You are recommended to save your document files to di.sc at regular intervals,
especially if you are working on large documents. This will guard you against
losing what might amount to hours of work through something like loss of power,
or absent-mindedly selecting the Quit... or Quit all ... options. Select Save and
resume in the File menu to save your file to disc and continue working on it
without having to reload it.
Saving part of your document
In order to save part of your document in a separate file, mark it as a block (see

Editing blocks in the chapter Editing documents), then select Write block ... in the
File menu. When the Write Block dialogue box is displayed, you will be able
to save the marked block to disc with the filename and in the directory of your
choice.
Files which were saved from marked blocks can be treated in exactly the same
way as any other file, and can, for example, be read back in to the same or
another document using the Read file ... command in the File menu or be opened
and edited using the Open file ... command.
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DELETING FILES
If there is not enough space on the disc when you try to save a document, an alert
will be displayed saying that the disc is full. If this happens, you can delete files
to make space on the disc. Alternatively, you can save your document file onto a
different disc. For this reason, it is a good idea to always have one or two
formatted discs to hand when using 1st Word Plus.
.
Select Delete file ••• in the File menu to display a dialogue box, from which you
can choose a file to delete. Each time you delete a file, the dialogue box is
redisplayed until you select Cancel. This allows you to delete several files one
after the other.
Once a document has been loaded into the computer's memory in order for you to
work on it, it is possible to delete both the original version and/or the backup
copy of the document from the disc in order to create space on it, without affecting
the version currently loaded into the computer.
Only do this if you are sure that you have not lost any text you might want during
the current edit and then SAVE the document back to the disc immediately
afterwards.
Do not confuse the redisplayed Delete File dialogue box with the OPEN FILE
dialogue box. If you delete a file which is not also loaded into the computer's
memory, you will lose it. To be doubly safe, make a separate backup copy of
your document disc on another disc after every session with 1st Word Plus.

INSTALLING A PRINTER
Whenever you load 1st Word Plus, it will install by default a STANDARD
printer driver. This printer driver will enable you to get started with your
printer, although it will not be able to print everything you can see on-screen.
In order to use all the features which your printer is capable of, you will need to
install a suitable printer driver for it. A range of drivers for the most popular
printers is provided in the cfg directory. If you have a printer which is not yet
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supported by 1st Word Plus, instructions for creating your own customised
printer driver can also be found in Appendix B, Printer configuration.
Switching Printers within 1st Word Plus
Whenever you load 1st Word Plus, it searches in the directory containing
1st Word+ for the default printer driver lwp print, and installs it for use
when printing. If the default driver is not fou~d, a warning message is displayed
which you can remove by selecting CANCEL.
The 1st Word Plus Desktop indicates which printer is currently installed (and
the output port it is connected to) in the printer display line immediately above
the font table. If you have a text window open the printer information can be
displayed by dragging the window size icon upwards with the mouse.
To install a different printer, follow these steps:
•

Select the printer name in the printer display line with the mouse. 1st Word
Plus will display the Install Printer dialogue box.

•

Use the dialogue box to display the files in the cfg directory.

•

Select the file for your printer, then select OK to install it. The font table
will change its display to show you the characters available on the installed
printer.

The selected printer will remain installed until you either exit from 1st Word
Plus or select another printer.

Changing the Output Port
To change the output port, position the mouse pointer over the port name in the
printer display line and press select to switch between the parallel (Printer) and
serial (Modem) ports or the network printer.
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Installing a New Default Printer
To install a new default printer, follow these steps (before loading the 1st Word
Plus program) :
•

Delete or rename the file currently called lwp_print .

•

Copy the required printer file into the directory containing the 1st Word
Plus program and give it the name lwp_print.

(See your Archimedes User guide for instructions on copying and renaming
files .)

PRINTING YOUR DOCUMENT
1st Word Plus enables you to do background printing, where you can
print out one file whilst simultaneously creating, editing, and saving others.
However, you must previously have saved to disc the file you want to print out (see
the section Saving your document in this chapter for details how to do this) .
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To print a file, select Print file ... in the File menu or press Print. If you do not
have a suitable printer driver installed, an Install Printer dialogue box will be
displayed to allow you to install one. When the Print File dialogue box
appears, use it to select the file you wish to print. Select OK, and 1st Word Plus
will display the Print File dialogue box, which asks you a number of questions
about formatting and print quality:

Print Pages froM
Page nuMber offset
Left Margin offset
Alternate left Margin~
HuMber of copies
c=:!J
~--------"1

!"11$%8,'()

Swap headings on
alternate pages
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F2 Under
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llJl:m ~
I Cancel I Mi'PKi i!I

F3 Italic

!tWi1BJiW FB Del Lin F9 Indent
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F4 Light
F5 Super
·F18 Fixed sp F11 Centre

Select any of the number boxes to move the cursor bar into it, allowing the
number to be edited.
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Print pages from ... to •••
These two numbers tell the printer on which page of the file to start and finish
printing.

Page number offset
This number (sometimes called the folio number) is added to the page numbers
in the document as it is printed. This is a very useful feature if you are printing
consecutive files, such as chapters in a book. If chapter 1 ends at page 50, type in
'50' as the page number offset for chapter 2, and the first page number printed
will be '51'.

Left margin offset
This number tells the printer how many character positions to move the print head
across the platen before it begins printing. You may need a left margin offset to
avoid the row of perforations on the edge of fanfold printer paper, or because
you have an offset sheet feeder.
Alternate left margin
This instruction allows you to set a different width of left margin which will be
used for the even numbered pages in your document. The width set in the previous
instruction will then only be used for the odd numbered pages. If, for example,
you are printing a document that is, or will be photocopied onto both sides of the
paper, and want a wider margin near the binding of this document to allow you to
punch holes there, the wider margin will need to be at the left on odd numbered
pages and at the right on the even ones. Although you cannot actually set the right
margin as such, you can do so indirectly by varying the width of the left margin.
Careful selection of the size of the two left margins can be used to create the
desired effect.
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Number of copies
This number tells 1st Word Plus how many times to print out the file.
Swap headings on alternate pages?

If you select Yes, the left and right-hand components of your header and footer
lines will be reversed on even-numbered pages, allowing you to print double
page layouts. This facility is often combined with the use of the Alternate left
margin facility above.
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1
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2

L

("Even-numbered" here refers to the page numbers '2', '4', '6', etc. actually printed
on each page, not the physical pages 2, 4, 6, etc.)
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Print quality

If you have installed a near letter quality (NLQ) dot matrix printer, this option
allows you to select either draft or NLQ print.
If you have installed a daisyw&eel printer, then selecting NLQ mode will make
the printer pause whenever it is asked to print italic or light text. The printer
driver will prompt you to change daisywheels at each style change.
Make sure your printer is properly connected, switched on, "on line", and loaded
with paper. Check your selections on the Print File dialogue box, then select OK
When printing, the Print file ••• option in the File menu changes to Printing••• , and
has a tick beside it.
Note: Background printing will pause whenever a dialogue box, an
alert, or a menu is displayed on the screen.
To pause or stop printing, select Printing••• in the File menu. The tick will
disappear, and a Printing dialogue box will be displayed giving details of the
printer and the page currently being printed. If you now select the OK box,
printing will simply continue. To abandon printing, select the STOP box.
To pause printing, select the PAUSE box. The dialogue box will disappear but
the printing will not continue until you again select Printing in the File menu. A
dialogue box headed PAUSED will then appear. To restart printing, select the
REST ART box. If you select the OK box the printing will again be halted
awaiting further instructions.If you select STOP, printing will be abandoned.

If your printer driver is installed to pause between pages, then the Printing File
dialogue box will be displayed after each page while the program waits for you
to load the next sheet of paper. However, this will only happen if you have not
got a text window open. If a text window is open, printing will just pause between
pages, and you must then select Printing••• in the File menu to restart printing.
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QUITTING lST WORD PLUS
To quit 1st ford Plus, you must either:
•

select Save file or Save as ••• from the File menu to save your document to disc
and return to the startup screen, or

•

abandon the current edit by selecting Quit... in the File Menu or the close box
in the text window. An alert message will appear warning you that you are:
about to close the file without having saved it and giving you a chance to
cancel the instruction before the file is actually closed. You will be returned
to the startup screen.

If you are doing background printing, you must either wait for it to finish or
intervene to stop it before you can exit from 1st Word Plus.
Finally, select Quit... from the File menu to quit 1st Word Plus itself. You will
be returned to the operating system command line. Press RESET if you want to
get back to the desktop (and your machine is configured to do so).
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To abandon all your current edits at the same time without saving any changes,
select Quit all ••• in the File Menu. The program will display the following Alert:

Oakwoods
Thet•e are two types of oakwood in Britain, danp oakwoods and
dry oakwoods. The typical danp oakwood tree is the
Pedunculate Oak1 with its stalked acorns and peculiar shaped
leaves. The typical tree of the dry oakwoods is the Durnastl
or Sessile OakT in which the flowers and consequently""ffie'"'"""
acorns have no stalks and the leaves have star-like hairs on
their undersurfaces.
Abandon the current edit and
leave original file unchanged
1 1 CRHCUSWM I
I OK I
~~~~~~~~~~~~~~--,

Select OK, and 1st Word Plus will close all your edit windows together with the
1st Word Plus program.
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CALLING UP THE MENUS
The menus are called up by pressing menu on the mouse. It does not matter
where the mouse pointer is at the time you call up the menus.

-

If a menu entry has an outline arrowhead to its right, it means that the menu option
will give you access to another set of menu entries. These entries can be called up
by moving the mouse pointer onto the arrowhead.

-

Menu entries which do not have an arrowhead to their right are selected by
moving the mouse pointer over them and pressing select. As you move the mouse
pointer over the menu entries you will notice that a white box appears behind the
entry currently beneath the pointer. Menu entries which are temporarily unable
to be used, for example some of the Block menu entries when no block has been
marked, also have a white background, but in addition their text is a much lighter
shade of grey.

If you select a menu entry ending in' ••• ', (eg Open file ••• ) 1st Word Plus will
display a dialogue box asking for further information before carrying out the
command. Other menu commands will be carried out immediately, unless you
have selected Extra help in the Help menu.
If there is a keyboard shortcut which performs the same function as the menu
command the key combination will be shown on the right of the menu entry subheading. The symbol "on the menus represents@ill, hence AZ would mean press
@ill and Z together.

THE FILE MENU
¢
¢

Open file .. ,
Print file .. ,

¢---------------------

Style

Open file •••

¢ Save file
¢ Save as .. ,

This command displays a dialogue box which allows you to choose a document
file to open for editing. You may have up to four files open at one time. Nont-------------------document files (such as supplementary dictionaries or the printer installation
Delete File •. ,
r-------------------Uuit ...
files) may also be edited with 1st Word Plus.
Quit all ...

Sp el l i ng¢--~~~:- ~~~- :=~~~: ___ _

Grap hics¢ Read fi le .. ,
He l p
¢.
·ite Bio•
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If the filename you specify does not already exist, 1st Word Plus will ask you to
confirm that you want to create a new file, and will then look for a format file in
the directory that you are currently working in. If it finds a format file, it will then
read it into the beginning of your new file. (See also the chapter Document layout
for more information on format files and dialogue boxes.)
The Open file... dialogue box displays the directory path doc . * and the
filename untitled by default whenever 1st Word Plus is loaded in.
(See also the chapter on Document layout for further information on Filenames.)
Print file •••
This command enables you to print a file. The file must, however, have been
saved to disc before you can print it. A dialogue box will be displayed allowing
you to select the file you wish to print out. Pressing Print will also reveal the File
dialogue box.
If your printer driver is installed to pause between pages, an alert will be
displayed after each page while the program waits for you to load the next sheet
of paper.
Save file
Select this command to save the current file to disc with its original filename.
Each time a new version of a file is saved 1st Word Plus turns the last version that
was saved into a backup copy by changing the last directory element of its name
to bak, (doc.american would become bak.american, for example). If a bak
directory is not found, a dialogue box will appear to warn you that it will not be
possible to make a backup copy, and offer you the option of cancelling your save
command. After being saved the file will be closed and you will be returned to
the 1st Word Plus start-up screen.
Save as •••
Select this command to save the current file to disc with a new filename. A File
dialogue box will appear allowing you to select a new directory and filename. If
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a file already exists with the new name you choose, it will be turned into a backup
copy, provided that an appropriate bak directory can be found. After being
saved the file will be closed and you will be returned to the 1st Word Plus start
up screen.
Save and resume
This command saves the current file to disc without closing the file. After saving,
the cursor returns to its previous position in the document.
@ill R

-

This command allows you to choose a file to insert into the current document at
the cursor position.

-

Write block-

[fill

w

This command saves the current marked block to disc with a filename of your
choice.
Delete file •••
This command allows you to delete files from disc, and can be used for example,
when there is insufficient room to store a new document on the disc.
Delete file ••• allows you to delete several files one after the other. After each
delection the item selector will be redisplayed until you select Cancel.
Quit...

If you select Quit... while you are editing a document, the current edit is
abandoned (leaving the last saved version of the document unaltered) and the
text window is closed. You can also close a file by selecting the quit icon in the
top left-hand comer of the text window.
If you select Quit... when no documents are being edited or printed, the 1st Word
Plus program will close down.
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Quit all •••
This command closes all current text windows, abandoning all edits made since
the documents were last saved. The 1st Word Plus program is then also closed
down .

THE EDIT MENU
File

Imm¢

¢
Block
Repeat find 'fl
layout
¢ · ·· · ··--------·-···
Style
Spelling¢ Statistics, .. ·z
Graphics ¢-j~p-~~d;·····-·---·
¢ J Hyphenation
Help
Jlnsert oode
J Word •rap

Set oark
Go to fllark

Goto page .. ,

The WP mode, Hyphenation, Insert mode, and Word wrap options are ticked
when they are switched on.
Find...

Select this command to search for a specific string of text in your document. If the
string is found, the cursor will be placed either on the first character of the string
(backwards search), or on the character immediately after the string (onwards
search) . If the string is not found, the cursor will be placed at the start or end of
document, depending on the search direction.

Select this command to search for a specific string of text in your document and
replace it with a second one. If you specify replacement of One or All matches,
Replace ••• will search and replace automatically. If you specify replacement of
Some matches, Replace ••• will find and display each match and ask you whether
or not to replace the string or Cancel the search. If the search string is not found,
the cursor will be placed at the start or the end of your document, depending on
the search direction.
RepeatBnd

Select this command to automatically repeat the last Find ..• or Replace ••• using
the same choices. If the Find ••• or Replace ••• command finished at the start or the
end of your document, then the search direction will be reversed for Repeat find.
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Statistics...

@ill

z

This command displays the number of pages, lines, and words in the current
document, as well as its size in bytes. Statistics ••• also displays the amount of free
memory remaining in your Archimedes and on the disc you select.
WP mode
This option allows you to switch Word Processing mode on and off. Switch WP
mode on to tell 1st Word Plus to store page breaks and style changes etc. in your
document. Files created in the doc directory have WP mode switched on by
default.

-

Switch WP mode off if you want to work on non-document files. Only ASCII
data will then be stored in them. With WP mode off, you will not be able to use
•
•
•
•
•

indents
any kind of page break
any of the Style menu commands
Hyphenation and Word wrap
the text pitch, right justification, and line spacing options on the ruler line.

All spaces in files created with WP Mode switched off are fixed spaces, and
paragraphs containing them cannot be reformatted.
Hyphenation
This option allows you to switch automatic hyphenation on and off. If you switch
Hyphenation on, 1st Word Plus will try to hyphenate long words when you
reformat. This option is only available in WP mode.

Insert mode

[ill key, icon or I Insert I

Select this option to switch Insert mode on and off. If Insert mode is switched off,
any new text you type in at the cursor position will overwrite the existing text. If it

is switched on existing text will move rightwards when new text is typed in. The
F7 icon appears in white on black when insert mode is switched on.
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Word wrap
Select this option to switch Word wrap on and off. With Word wrap switched
on, text is moved onto the next line when you go past the right margin. With
Word wrap switched off, the right margin is ignored, and you can continue typing
on the same line until you press[£] or reach the 160 character limit. This option
is only available in WP mode.
Set mark...
Use this command to set or redefine up to four position marks anywhere in your
document. Marks are set at the current cursor position.
Goto mark•••
This command moves the cursor to one of the position marks defined by the Set
mark... command.
Goto page .. ./Goto line...
This command allows you to move the cursor to the top of a given page in your
document. If you specify a page number greater than the last page in your
document, the cursor will be placed at the top of the last page. This option
becomes Goto line ... in non-WP mode.

THE BLOCK MENU
The commands in the Block menu allow you to create and work with blocks of text
and/or pictures. Blocks are sections of a document of any length. Areas of text
within them will be highlighted with a black background. A document can have
only one block marked at any time, and marking a second block will cause the
first block to be hidden.
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ST WORD PLUS COMMANDS

,,,...

Stutblock

[ili]

s

Select this command to define or redefine the start of your block at the current
cursor position.

Ero block

[ili] E

Select this command to define or redefine the end of your block at the current
cursor position. An alternative method of redefining the end of a marked block is
to double-click select at the cursor position.
~

...::;;.

Although block start and end positions must be inside the window when they are
defined, 1st Word Plus will remember block positions when they move off
screen. Once a block has been defined, it will be highlighted and will remain so
until you use Hide, Cut block, Refonnat.. ., orr:£ill .

Cut Hock

~HTIJ

Use this command to copy a marked block onto the clipboard then cut it from
your document. A dialogue box will appear when the block has been copied.
When you select the OK box, the block will be cut from your document. The
contents of the clipboard can later be pasted back into your document at any
point. Should you try to copy another block onto the clipboard, before the
existing contents have been pasted back into the document, a warning message
will appear, because, if you did so, the existing contents would then be lost.

-

~block

[ili]

mJ

This command copies a marked block to the clipboard without cutting it from
your document. Note that Copy block will overwrite the clipboard contents in the
same way as Cut block.

Pa<;te block

[IBJ

mJ

This command pastes in a copy of the clipboard contents at the cursor position in
the current window. The contents of the clipboard remain intact, so you can paste
the block in at more than one position in one or more documents.
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Move block
This command moves the marked block to the current cursor position in the same
window. Note that Move block uses the clipboard, and will therefore overwrite
any existing contents it may have.

Findstut

~ T

Use this command to move the cursor to the start of the marked block.

Fmdend
Use this command to move the cursor to the end of the marked block.

Hideblock

~K

This command removes the highlighting and start and end markers from a block.
The contents of the clipboard are unaffected. Using Reformat ••• or !IITl or
pressing and holding down select,will also unmark a block.

THE LAYOUT MENU

Em

Show ruler

~

Block
~
lml!lm ¢...,
I S~howru~
I.,, -~
.L~
sryr;--¢ Show pos ition •p
Spelling <}'" ---------------------Graphics ¢-. ~~?:_!~?~~!:::_ .
Help
¢ Add ruler .. ,
"A
Ooleto ruL
·p
R"d ruler
·G
Foot note for111at.,.
Add footnote . .. •f4

This command allows you to turn the ruler line display at the top of the text
_____ window on and off. If the current ruler is displayed, Show ruler will have a tick
by it.

Show JXllitbn

~p

This command allows you to turn the cursor position display at the top of the text
window on and off. When the option is turned on the Show position menu entry
will have a tick by it. If WP mode is also switched on, details are given of the
page, line and column where the cursor currently appears. If WP mode is not

switched on, only the line and column will be given. The cursor position is
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displayed in place of the ruler line, and vice versa. You can create an extra line
in the text window by turning both Show ruler and'Show position off.
Page layout...
Select this option to display a form allowing you to specify the header and footer
lines and page layout for each document.

Addru1er...

Select this option to insert a new ruler into your document at the current cursor
position. Rulers can only be added in WP mode, and will control the following
options:
•
•
•
•
•
•

-

@ill A

character pitch (the number of characters per inch)
spacing between tab stops
tab leader character
ruler length
justification
line spacing.

Delete ruler
Select this command to delete the ruler controlling the current cursor position.

Readru1er...

@ill G

Select this command to display a File dialogue box. 1st Word Plus will take the
file you select, and read the first ruler it contains into your document at the cursor
position.
Footnote format•••
Select Footnote format ... to display a dialogue box allowing you to format the
rule separating the footnotes from the main body of the text. The length of the
rule is measured in character widths and the pitch of these characters is taken
from the footnote ruler.

--
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Add footrote...

@El

F4

Select Add footnote ••• to add a footnote at the cursor position. You can add
footnotes wherever you like, except in header lines, footer lines, or in footnotes
themselves.

THE STYLE MENU
File
Edit
Block
layout

The Style menu is used to select character style options and some text formatting
features.

i:mlm¢

ol
Spelling¢ Underline
Graphics¢ Italic
Help
¢ light
Superscript
Subscript

F
F2
FJ
F4

Edd

[IT] key or icon

FS
F6

Centre
Fll
Right
"Fll
Indent
Fl
Refor"at

This command turns boldface characters off or on. If selected the style will be
applied either to text which you type in at the cursor point, or to the text of a
marked block. The Fl icon appears in white on black and the menu entry is ticked
when boldface type is switched on.

Underlire

[IT] key or icon

This command turns underlined characters off or on. If selected the style will be
applied either to text which you type in at the cursor point, or to the text of a
marked block. The F2 icon appears in white on black and the menu entry is ticked
when underlined text is switched on.

Iralic

[TI] key or icon

This command turns italic characters off or on. If selected the style will be
applied either to text which you type in at the cursor point, or to the text of a
marked block. The F3 icon appears in white on black and the menu entry is ticked
when italic text is switched on.

Light

CB:] key or icon

This command turns lightface characters off or on. If selected the style will be
applied either to text which you type in at the cursor point, or to the text of a

146

-

marked block. The F4 icon appears in white on black and the menu entry is ticked
when lightface type is switched on.
Su~

-

[£IJ key or icon

This command turns superscript characters off and on. If selected the style will
be applied either to text which you type in at the cursor point, or to the text of a
marked block. The FS icon appears in white on blat.k and the menu entry is ticked
when superscript is switched on.
QI] key or icon

This command turns subscript characters off and on. If selected the style will be
applied either to text which you type in at the cursor point, or to the text of a
marked block. The F6 icon appears in white on black and the menu entry is ticked
when subscript is switched on.
[£DJ key or icon

This command centres the line containing the cursor between the left and right
margins.

-

Right
This command aligns the line containing the cursor with the right-hand margin,
leaving a ragged left-hand margin even if justification is turned on for the current
ruler.

Indent

-

-

IT[] key or icon

Select this command to indent a whole paragraph by one tab stop. Position the
cursor at the beginning of the first line of the paragraph, then select the command.
Selecting the command more than once with the cursor in the same position will
increase the indent by one tab stop each time. You will need to reformat the
paragraph after inserting an indent. The tab stop positions are taken from the
current ruler line. When you press ~ at the end of the paragraph, the indent is
cancelled, and will not be carried over to the next paragraph.
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Reformat•••
Select Reformat••• whenever you:
•
•
•
•
•

change your text by deletion or insertion
alter the size of an indent
switch justification on or off
modify the right or left-hand margin
insert a new ruler.

Use the [£ill key or icon to reformat single paragraphs. You will not be able to
reformat any text created with WP mode switched off, since all spaces will be
fixed spaces.

THE SPELLING MENU
i e
Edit
Block
Layout
Style

Load dictionary
¢
¢

mm.m:J ~l-clo~,d~D~lC~ti~on~ar~y~~;

Graph ics ¢··-----·----· ------------Help
¢ i:~~t.~:~; i;;:llin/:i
Brouse .. ,
"F5
Add wrd

End spell check

Select this command to load in the main spelling dictionary from the same
directory and disc as the program. 1st Word Plus subsequently displays a
dialogue box to allow you to load in a supplementary dictionary.

"F6

Check spelling
Select this command to check the spelling in your current document from the
cursor position onwards. 1st Word Plus will flag any word it does not recognise
by placing the cursor after it. You then have the choice of adding the word to the
dictionary (if it is correctly spelled but not yet included), or of replacing the
word in your document (if it is incorrectly spelled) either by the normal editing
process or by using the Browse ••• option.
Select Check spelling again or press IEsc I to continue the spelling check after
making the necessary amendment.
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Continuoos check

----

---·- ·· ---·~--

[fill

c

This option allows you to check the spelling of each word as you type it in. When
you move the cursor off a word that is not listed in a currently loaded dictionary,
either by typing a space after the word, or by using the cursor keys, your
Archimedes will warn you with a short high-pitched note so that you can check the
spelling. The menu option is ticked when it is switched on. Select it a second time
to switch it off.

Browse...
Select this command to display the dictionary browser, which will allow you to:
•
•
•

--

.. ----

automatically correct spelling mistakes in your documents
add new words to the dictionary
scan the dictionary for unwanted entries (See the chapter Editing documents
for details of how to delete these entries).

The dictionary browser displays a block of 10 words at a time on screen. Use the
up and down arrows to the right of the word blocks to search through all the
words in the spelling dictionary beginning with the same letter as the word on the
Find line.
To find a particular word, type it in on the Find line, then select Find or press G!J.
If the Find line already contains an unwanted word, clear it by pressing IEsc I
before entering the new word. The program will search for the word you have
specified and display the relevant part of the dictionary. If the word is in the
dictionary, it will be highlighted at the top of the browser.

Add word
This command allows you to add new words directly to the supplementary
dictionary. The word that is added will be the last word that the spell checker
detected as missing from the currently loaded dictionaries, unless you have
altered the Find line of the browser after that word was detected, in which case it

will be the word that currently occupies the Find line.

--
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End spell check
Use this command to finish a session of checking your spelling or adding words to
the supplementary dictionary. A dialogue box will be displayed to allow you to
save the altered supplementary dictionary onto disc. Select CANCEL to
abandon any additions you have made.

THE GRAPHIC S MENU
~

~

Edit
¢
Block
¢
Layout ¢
Style
¢
Spelling¢
[Em1¢·-.:
Gr 70
ap"hic07s-:c
M'""
de~·H
_el_p _
¢; ·R;~d-;;~;~;;:: :-

i ·jj;i;t;-;i~t~;;-- -

Graphics mode
This command allows you to switch graphics mode on and off. You may want to
switch it off in order to save memory or to avoid confusion when editing text that
is overlayed by graphics. When you first load a picture Graphics mode will
automatically switch on, unless you have intentionally switched it off, to allow
you to paste pictures into your documents. When Graphics mode is switched on, it
will have a tick by it.
Read picture•••
Graphics mode must be switched on before using this command. When you select
the command a dialogue box is displayed. Use the dialogue box in the same way
as you use an Open file ••• dialogue box to select the picture of your choice. Select
OK to paste the picture into your text at the current cursor position.
Delete picture
Position the cursor on one of the lines containing the picture you want to delete,
then select this command. The picture will go into reverse video, and 1st Word
Plus will ask you to confirm that you want to delete the selected picture. If there
is more than one picture on the line the program will select the first one it finds.
If this is not the one you wish to delete, you may have to move the one you want to a
line with no other pictures on it before you can delete it in this way.
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- WHAT IS lST MAIL?

-

-

1st Mail is a mail merge program for use with 1st Word Plus. A mail merge
program allows you to produce a series of documents which differ from each
other only in certain details. The classic use of this kind of program is to send the
same letter to a number of different people. Two files, one containing the letter
and the other the addresses, are merged, hence the name "mail merge".
For example, you might work in the marketing division of a large corporation, and
you want to send a letter to all your customers announcing a new product. To do
this with 1st Mail, you would first create a "master document" with 1st Word
Plus. The master document is the part that is common to all the letters ie the
message itself.
The part that is different in each letter is the variable data, such as the customers'
names and addresses. You can create a file in 1st Word Plus which contains this
variable data. We call this the datafile.

-

Alternatively, you can produce your own datafiles using 1st Word Plus. By
merging the variable data for each customer into the master document, a series of
personalised letters is created, although you have only needed to type in one.
The process of merging the datafile into your master document is carried out by
1st Mail using a set of easy to understand commands.
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document file

datafile

-

·---o-master document

+

personal data

=

personal letters

Of course, you are not restricted to producing letters with 1st Mail. You can, if
you wish, use 1st Mail to produce multiple copies of any document, such as party
invitations or office memos.
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LEARNING ABOUT lST MAIL
This chapter provides an introduction to 1st Mail and tells you how to run 1st
Mail on your Archimedes.

lST MAIL TUTORIAL takes you step by step through a tutorial session.
USING lST MAIL provides detailed information on the production of
formatted documents using command files and datafiles.
1 ST MAIL COMMANDS is a reference section providing brief summaries of
all the commands used in 1st Mail.

APPENDIX A contains instructions for printing address labels using 1st Mail.

-"""'

MAKING A BACKUP COPY
Before you begin using 1st Mail, you are strongly advised to make at least one
backup copy of the program disc. (See the Archimedes User guide for details of
how to copy discs.)

__..

PRINTER CONFIGUR ATION FILES
1st Mail uses the same printer configuration file as 1st Word Plus
(lwp_print). Both 1st Mail and the printer configuration file must be stored in
the same directory.

INSTALLING A PRINTER

--

Whenever you load 1st Mail into your Archimedes, it will look for a 1st Word
Plus printer driver in the same directory. If the appropriate printer file cannot
be found, 1st Mail will display a warning. If the warning is displayed, you can
select OK to direct subsequent output to disc instead of the printer. You may
want to do this in any case, so that you can review the results of the merge before
you print them out.
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The type ot printer installed, together with the type ot port it uses, appear in the
printer information strip along the bottom of the screen.You can change the
printer type while you are using 1st Mail by positioning the mouse pointer over
the printer name and pressing select. A dialogue box will appear allowing you
to install a different printer. The output port selected can also be changed by
positioning the mouse pointer over its name and pressing select. The four options
Parallel Port, Serial Port, Network Port and Disc will appear in rotation.
The next time you try to merge to the printer, 1st Mail will look for the
appropriate new printer driver. If it cannot be found, 1st Mail will display a
warning to allow you to redirect your merged output to disc.

RUNNING lST MAIL
The following are the instructions for running 1st Mail from a floppy disc. If you
have an Archimedes with a hard disc, see the Release note supplied with the
software for details on how to install and use 1st Mail on your hard disc.
To run 1st Mail from the desktop:
Insert your 1st Mail program disc into the disc drive. Select the disc drive
icon to open it.
2

Select the library icon.

3

Select 1st Mail.

To run 1st Mail from the command line:
Insert your 1st Mail program disc into the disc drive.

2

Type:
lstMail ~
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When 1st Mailhas loaded, you will see the following screen with a Merge
From dialogue box in the centre:

MERGE FROM FILE

-

Directory:
j&.lwp.doc.•

File:

Cancel

-
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1ST MAIL FILES
In addition to the 1st Mail program in the Library directory, along with 1st
Word Plus, there are two other directories used by 1st Mail. These are . mrg
and . da t. . mrg contains finished documents which have been processed
through the mail merge, with the items of individual data inserted. You can divert
the output of the mail merge to this directory if you do not want, or are not able, to
print them out directly. . dat contains data files, which provide the variable
information to "customise" the master document, such as individual names and
addresses a letter is to be sent to. Command files may be kept in the . doc
directory.
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RUNNING A MAIL MERGE

-

Your 1st Mail disc contains examples of a master document and a datafile, to
provide a tutorial session to help you get to know the basic features of the
program. You should remember, however, that not all the 1st Mail facilities are
covered in this tutorial. (For fuller details of these, consult the chapter "Using
1st Mail".) Conversely, the tutorial session includes features which you may not
use in every merging ses~ion.

-

First run 1st Mail, as described in the preceding section.
Note: unless you specify otherwise, 1st Mail will try to send your
merged documents directly to a printer. For this exercise, your merged
documents should be sent to disc so that you can look at them in detail
later, so select CANCEL on the Merge From dialogue box. Position the
mouse pointer over the current output port in the printer information
strip at the bottom of the screen and press select repeatedly until Disc
appears in the output box. Then call up the menus by pressing menu
and select Merge From... to return to the Merge From dialogue box.

2

Use the dialogue box to select the file called letter which should be in
the doc directory. (See the 1st Word Plus documentation for details of how
to use dialogue boxes.)

3

If you are merging to disc, the Merge From dialogue box will then be
replaced by a Merge To dialogue box. The File dialogue box will
automatically display the name of the original master document file (or
other master document) in this case letter. The directory box will show a
path leading to a directory called mrg. You can, however, alter both the
name of the new file and/or its directory path using the dialogue box in the
usual way. Remember to ensure that all the directories you will need for
your chosen paths are in existence before you load the program, or 1st Mail
will be unable to proceed. (The directories you require for this tutorial have
already been created for you .)

4

Begin the merging process by clicking on OK or pressing ~ -
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5

6

7

few seconds
The Merge to dialogue box will disappear. There will be a
the
then
ent,
delay while 1st Mail begins to process the master docum
ed.
message lST MAIL lette r start ed will be display
select a datafile
A Datafi le dialogue box will be displayed to allow you to
should be in
for use in the merging process. Select the file addre ss, which
the dat directory, then select OK or press GiJ.
to process four
1st Mail will use the datafile addresses on the program disc
d, the screen
letters to different people. When the merging process is finishe
will look like this:

lST HRIL letter
PROCESSING YOUR
PROCESSING YOUR
PROCESSING YOUR
IST HRIL letter
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started

LETTER TO Mr Winters
LETTER TO Ms Crow
LETTER TO Mrs Rivers
finished

l

sT MAIL TUTORIAL

....,.,.
Note: 1st Mail can be halted AT ANY TIME during the merging
process by holding down the select button on the mouse.

-

8

Exit from 1st Mail by calling up the menus and selecting Quit•••

Now load in 1st Word Plus to examine in detail the various files used and
produced in this sample mail merge session: the master document (letter) in
the doc directory, the datafile (address ) in the dat directory, and the
document file containing the merged letters (letter) in the mrg directory .

........

..,.,...

.,..
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THE MERGED LETTER
The mrg file letter contains four merged copies of the letter you just created
when you ran the mail merge. When you have loaded 1st Word Plus, you can
open the merged file and examine the copy letters.
When the File dialogue box appears on screen, select the letter file in the
mrg directory. The first merged letter in this file will look like this:

R.B Wintet's
Rouse 1 Wa ken RCo Ltd
125 King Street
Ware SGB 6BD
Dear Mr Winters,
Ne are pleased to inforn you that 1st Mail is now available for
use with 1st Word Plus. We believe nany of the custoners of
Rouse, Waken & Co Ltd will like the advanced features offered by
1st Mail, including the autonatic refornatting of paragraphs with
insertions in then. For further details, contact your local
Rrchinedes Dealer.
Yours sincerely,
Douglas C. NcRddans
Ms J.C. Crow
'Curl Up and Dye'
Oxford OXl 2PO
Dear Ms Ct·ow,
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Each customer in your imaginary mailshot would get a similar letter, but with a
different name, company, address, and so on. (Scroll through the letter file
to see what the four different letters look like.)
When you type in your master document using 1st Word Plus, however, it will
look like this:

GED

rnrnHK
isplay "PROCESSING YOUR LETTER TO TITLE HOME"
ITLE initials na1e
tlP<HlY

tldrgs
dtu zirccdf
cmmtry

Deat' title 1nm1:,
We are pleased to inforn you that 1st Hail is now available for
use with 1st Word Plus. We believe nany of the custoners of
1ranv will like the advanced features offered by 1st Mail,
including the autonatic refornatting of paragraphs with
insertions in then. For further details, contact your local
Rrchinedes Dealer.
Yours sincerely,
Douglas C. HcAddans
!'f!fi!ilt

-
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THE MASTER DOCUMENT
The master document, or text file, which 1st Mail processes, contains special
instructions controlling not only the layout of each letter as it is printed, but also
the places where pieces of data have to be inserted. When you are preparing a
master document such as a letter, it is a good idea to make a rough draft so that
you can work out where the pieces of variable data have to go.
To view this example master document, select Open File... in the File menu.
When the File dialogue box appears, select the letter file in the doc
directory. (Only the first part of the master document will be visible, and you
will need to scroll the screen to view it all.)
Keywords and Commands
You will notice that this example master document has a number of sections
which are distinguished from the surrounding text by being in light type. These
pieces of light text fall into two groups: keywords and commands. There is a
fixed set of commands in 1st Mail, but the keywords can be determined by the
user and there can be as many as you like. The only restriction is that they must
not be the same as any of 1st Mail's commands. Keywords and commands can be
in upper case (READ) or lower case (read), as long as they are in light rype. A
list of the commands appears later in the section on Text file commands in the
chapter 1st Mail commands.
We will look at keywords and commands in turn to see how they are used.
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INTRODUCING KEYWORDS
Whenever 1st Mail comes across text in light type it first tries to identify it as a
command. If it cannot identify it as a command, it will treat it as a keyword. A
keyword is a prompt for the mail merge program to look for a piece of individual
data to insert in a merged document. When you are typing in a master document,
you will need to use keywords in all the places where you want 1st Mail to insert
pieces of data, usually from a datafile. The keywords used in the example
master document are as follows (keywords are entered in light type in the
original document, and shown here in bold type):

The pieces of personal or variable data which correspond to these keywords, and
which appear in the first sample merged letter above are as follows :
Mr

125 King Street

A.B.

Ware

Winters

SG86BD

Rouse, Waken & Co Ltd
Note: These keywords are only examples invented for use in the tutorial
session.
You can use as many of your own keywords as you like, provided that each
keyword corresponds to a piece of data.
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Before seeing how the data is inserted into your merged documents, let us have a
brief look at the structure of the datafile.

THE DATAFILE
The sample address list datafile you used in the tutorial (created with 1st Word
Plus) is included on the 1st Mail program disc. To view this sample, select Open
File ••• in the File menu. When the File dialogue box appears, select address in
the . da t directory. You will see the following list:

'·

.

-

(The longer lines can be viewed by scrolling the screen sideways if necessary.)
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The datafile consists of 3 lines or records, with each line containing the variable
data to be used in one merged document. Within each line, the pieces of data or
fields are separated by commas. No space is left between the comma and the
following item, because if such a space were left it would appear as a space
before that item in the text of the letter itself.
Each line of data must contain the same number of fields as there are keywords
following the read command, although some of the fields may be empty. A
comma at the end of a line of data automatically creates an extra empty data
field at the line end and is included when there are less data fields than items of
data to be read.

-

Any data field which itself contains a comma must be enclosed in double
inverted commas, or the program will take the position of the comma as the end of
a data field.
The datafile must be created and stored by 1st Word Plus in non-WP mode.

THE COMMANDS IN THE LETTER

-

Light type is also used to identify commands embedded in the master document
(or other master document). The commands used in the tutorial example master
document are read, ragged, omitblank, and display at the top, and repeat at the
bottom (shown in this manual in bold type). You will notice that each command
is at the beginning of a line, and that there is only one command on each line. All
commands included in 1st Mail documents must be at the start of a line and there
must not be more than one to a line.
We will now look at each of the commands used in the example master document
in turn, starting with the group of commands at the top.
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Read
The read command tells 1st Mail to read in data fields from a datafile and
associate each one with the corresponding keyword in the master document:
read title,initials,name,company, ...
1st Mail will then go to the first record in the named datafile (here
dat. address) and link up the data in each field with the keywords in the line
following the read command in exactly the same order:
Mr,A.B.,Winters,"Rouse, Waken & Co Ltd", ...
After this, whenever 1st Mail comes across the word title in light type, it will
insert the piece of data "Mr" until it receives the next read command. The same
process will be repeated for every keyword which 1st Mail encounters, and for
which it has read a piece of data.
Note: Keywords must be in ordinary plain type when they are being
defined following the read command, but in light type when they are to
be used within the master document. (See example above)
Ragged
The next command in the example master document is ragged, which specifies a
ragged (unjustified) right margin:
We are pleased to inform you that 1st Mail is
now available in the UK for use with 1st Word
Plus. For further details, contact your local
Archimedes dealer.
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1st Mail will default to the type of margin in force in 1st Word Plus when you
made your master document. If you want to change the setting for all or part of
your merged letter, use the commands ragged or justify at the appropriate places
to override the original setting. An example of justified text appears below.
We are pleased to inform you that 1st Mail is
now available in the UK for use with 1st Word
Plus.
For further details, contact your local
Archimedes dealer.

Once you have changed the setting, you will have to use the opposite command to
return to the original setting.
Omitblank
Following ragged in the example master document is the command omitblank.
This tells 1st Mail that if a data field is empty for some reason, a blank line is
not to be printed in place of the corresponding keyword in the text. Let us say that
one of the records in the sample datafile has no data field corresponding to the
keyword address, but simply reads:
Ms,J .C.,Crow,"'Curl Up and Dye'",,Oxford,OX1 2PO
If you specify omitblank in your master document, 1st Mail will print this
address as follows :
title initials name
company
city
postcode

MsJ.C. Crow
'Curl Up and Dye'
Oxford
OXl 2PO
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and the other addresses in the usual way:
title initials name
company
address
city

postcode

Mrs J. Rivers
Freshwater Fisheries
25 Old Square
Edinburgh
ENl 5HQ

If, on the other hand, you would like the addresses on all your letters to start and
end in the same place on each page, use the command noomit to produce the
following result:
title initials name
company

MsJ.C. Crow
'Curl Up and Dye'

city

Oxford
OXl 2PO

postcode

If you do not specify a choice, 1st Mail will print blank lines when a field is
empty. Use noomit when you want to switch off omitblank and keep these lines
blank in your documents.
Display
The final command at the top of the example master document is of a different
kind compared with the other commands. This command does not have any effect
on the contents or the layout of each letter, but displays a message on the screen:
display "Processing your letter to title name"
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--

The message in the example master document indicates which person's letter is
currently being processed by 1st Mail. So far, the commands contained in the
example master document have instructed 1st Mail to:
Read a set of data fields into the letter in place of the specified keywords.
2

Omit any blank lines where a data field is empty.

3

Make the right margin ragged (unjustified) .

4

Display a message on screen indicating that 1st Mail is processing a letter to
the name of the person contained in the first record of the specified datafile.

Repeat

-

-

At this point, 1st Mail has carried out all these commands using the first record it
encountered in the datafile dat. address . Without any further instructions, the
program would simply stop, having produced one letter. The repeat command
tells 1st Mail to go back to the very beginning of the master document or other
document, and read through it again using the next set of data. The program will
then carry on repeating this process until it runs out of data. In the example used
here this results in 3 letters, because the datafile has only 3 records .
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--This chapter is a reference guide to creating mail merge documents using data
files and command files . Some of this will already have been covered in the
tutorial session in the previous chapter. The previous chapter also provides
definitions of terms such as keywords, commands, fields and records used in this
section.

COMMAND FILES

-

-

A file which you create with 1st Word Plus for use with 1st Mail may consist
almost completely of commands and keywords, with the text and data to be
merged being "called up" from disc or entered by the user as needed. By using
this kind of command file you can work with as many different documents and
datafiles as you wish in one mail merge session with 1st Mail.

-
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A sample command file created with 1st Word Plus is supplied on the 1st Mail
program disc. To have a look at it, load in 1st Word Plus. When the dialogue
box appears, select the file command in the doc directory then select OK A
window will open with the following contents:

F6 Sub

Del Lin F9 Indent
By following the workings of this small command file step by step, you will be
able to write command files to carry out more complex mail merge tasks of your
own.
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------ .. - ---

-.

................. ....,

Datafile
The datafile command tells 1st Mail to use the named datafile whenever the
read command is encountered:

-

datafile filename

I

The program will then check that the datafile you have specified actually exists
on disc, and will display an error message if it cannot be found. If you do not
specify a filename, a Datafile dialogue box will be displayed to allow you to
choose a datafile. If you do specify a datafile, and it is not in the current
directory, you will need to specify a directory path in front of its name to allow
the program to find it.

Input

-

The input command used in the next two lines of the example command file tells
1st Mail to display the text between the quotation marks on the screen and wait
for a reply:
input "today's date?", todaydate
input "letter filename? ", letter
This is what is known as an interactive command, since it asks you to enter
information while the. program is working. One consequence of this is that there is
no absolute necessity to use datafiles with 1st Mail at all. It is quite possible
(but time-consuming!) to have all the necessary data entered interactively by the
user using a series of input commands.
1st Mail will then take the reply and identify it with the keyword (eg todaydate)
after the comma. Whenever 1st Mail subsequently encounters the keyword in this
mail merge session, it will substitute the reply that was typed in.
Again, if you wish to name a file in one of your answers, and that file is not in the
current directory, you must precede its name with a directory path which will
allow the program to find it.
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Note: If, for any reason, you wish to break off a 1st Mail merge
procedure which includes input commands, hold down select and press
G!:J while the program is waiting for the reply to an input command.

Includefile
The last line in the command file:
includefile letter
...

tells 1st Mail to look for the file associated with the keyword following the
command includefile and process it. Once 1st Mail has processed the selected
file, it will return to reading the instructions in the original file. In our example
command file, there are no further instructions, so the program will stop at this
point.

If the includefile command is used with no filename following it, 1st Mail will
display a dialogue box to allow you to select the appropriate file.
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The following diagram shows the effect of the includefile command in the
middle of a file . 1st Mail will stop processing file A and start processing file B.
When it has finished processing file B, it will return to file A and carry on
processing it.
FILE A

FILE B

includefile
~

B

.

~

r+

-

If file A is a command file, then the document processed by the includefile
command will be separate from the command file itself. By using one
includefile command after another, you can process as many sets of documents as
you wish. For example, the following command file will process the named
letter (eg letter) using the datafile addresses, then process the named memo
(eg memo) using the datafile offices:
data file addresses
input "letter filename? ", letter
includefile letter
datafile offices
input "memo filename? ", memo
includefile memo

1Note: If you do not explicitly specify a new datafile, 1st Mail will use
the last one mentioned until it runs out of data.
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NESTING FILES
In the previous example we looked at how the includefile command works in a
command file. However, if the includefile command occurs in the middle of a
document file, then the document which is processed will be included or "nested"
inside the original file . 1st Mail will allow you to nest several documents by
putting an includefile command in one document file, which itself contains an
includefile command, and so on:

:-:·:·:·:·:·:·:·:·:·:·:·:·:·:·:-:·:·:·:·:

::~.:.:.:.;:;: ~: ~: ~: ~ :~: ~: ~: ~: ~: ~:

;~mtt~~;~~~;~ j~ ~ ~ ~ ~j~j~~~~~~~~~~~;

~ j:::::::::::::::::::::::::::::::::::::::

:::::::::::::::-..:::::::;:::;:;:;:
;:;:;:;:;:;:;::~:::::::::::::::::
:::::;:;:;:;:;:~:;:;:::;:::::::::
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If you attempt to nest too many includefile commands, 1st Mail will abort with
an appropriate error message. Nested includefile commands are dealt with in
the order shown in the following diagram.
;- -

FILE A

FILE B

includetile B

-

.
~

f+
FILE C

-

...

includetile

.

c

~

--1

-1
In each case, the program will return to the document file or command file that
the includefile command was in, and carry on where it left off.
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Chainfi le

If, however, you want 1st Mail to switch to processing file B, but not to carry on
reading through file A afterwards, then use the command chainfil e:

FILE A

chainfile B

.

FILE B

,.,
FINISH
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-You can mix include file and chainfile commands as you wish, as long as you
remember that 1st Mail will return to the original file after an includefile
command, but not after chainfile:

FILE A

FILE B
includefile B

-

.

~

+
FILE
chainfile C

c

.
~

-The commands includefile, chainfile (and datafile) all require that the file to be
processed is defined in one of three ways:
By specifying the file directly:
chainfile doc.letter

179

2

By using a keyword which has previously been associated with the file:
input "letter filename? ", letter
chainfile letter

3

By not specifying a file, and allowing the user to choose a file with the file
dialogue box:
chainfile

USING COMMAN DS
There are certain rules which you must follow if you are using 1st Mail
commands. For example, commands must ALWAYS be in light type, at the
beginning of a line. Any words other than the command which are in light type
will be treated as keywords. If you were to put cha inf ile letter, 1st
Mail would look for the filename to be substituted for letter before the chainfile
command was carried out.
Don't put more than one command on each line, and don't put any text before a
command. Lines with commands on them are treated separately from lines with
text on them, or lines which contain keywords which are not part of the command.
Also, commands in 1st Mail are "reserved" and cannot be used as keywords. All
of the following examples are incorrect, and will cause 1st Mail to abort with an
error message:
read name
Dear Sir
read justify
display "message"
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datafile keyword
read name
keyword

(two commands)
(text before command)
(command used as keyword)
(command then keyword)

•

.,:,u~u
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COMMENT LINES
1st Mail will treat a line starting with a light star * (or any other punctuation
character such as" ! ? : in light type) as a comment. You can use comment lines to
explain how a large or complex command file works. You may, for example,
want to remind yourself what different datafiles contain:
datafile address1
* This file contains clients addresses
data file address2
* This file contains suppliers addresses
Any line beginning with a punctuation character which is not in light type will be
inserted into your merged documents.

DATAFILES
Constructing Datafiles
Here are two general rules to remember when you are constructing datafiles:

-

•

always keep the fields in the same order in each record

•

likewise, the order of entries in the datafile must corresi ond to the order of
the keywords in the read command in the master documr t.

If you are using 1st Word Plus to create your datafiles, you r ill also need to
remember the following points:
•

Datafiles must be saved in non-WP mode (switch off W~ Mode in the Edit
menu), otherwise formatting characters will create erro s in your merged
documents. (Take particular care if you store your datarfle in a doc
directory where new files are automatically created in WP mode.)
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•

Do not put any spaces or a~ at the end of the last line in the datafile. (If
you use the repeat command in a document, 1st Mail will go back to the
beginning of the datafile when it comes across a ~ at the end of the last
record.)

If you should forget these rules and type in your datafile incorrectly, you could
end up with letters that look like this:

rR.B Winters Rouse Waken &Co Ltd
25 King Street
are SGB 6BD
Dear 11rR.B Winters Rouse Waken &Co Ltd
We are pleased to inforn you that 1st Hail is now available for
se with 1st Word Plus. We believe nany of the custoners of
125 King Street will like the advanced features offered by
1st Mail, including the autonatic refornatting of paragraphs with
insertions in then. For further details, contact your local
Rrchinedes Dealer.
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Separating Fields and Records
When you create your own datafiles with 1st Word Plus, you must separate data
fields with commas, and data records with~ . Datafiles which have been
produced using some database programs may, however, use different characters
to separate fields and records. If this is the case, you may need to redefine the
characters separating fields and records before reading in the datafile
concerned. You can redefine field and record separators wit.1-i the commands:
fieldsep decimal number
recordsep decimal number
The "decimal number" part of the command refers to the standard ASCII
decimal number for each character. Tables showing the complete ASCII
character sets available on the Archimedes can be found in the Archimedes User
guide. Let us say you want to use the character "#" as a record separator. Look up
its decimal ASCII number, which is 35, and enter the command as:
recordsep 35

-

If you need to, you can redefine up to 20 different field or record separators at a
time. The default values for the decimal numbers used with these commands are:
fieldsep 9 ,44 (tab, comma)
recordsep 10,12 (return, form feed)
The sample datafile ADDRESSES used earlier contains 4 records, and results in
the merging of 4 letters. Datafiles may, of course, be much larger than this. In
general, the size of a datafile is only limited by the size of disc it is stored on.

183

Enclosing Fields
Use double (") or single (') quotation marks around fields containing commas to
indicate that everything inside them is to be treated as a single item, including the
comma but excluding the quotation marks. Don't forget to type the closing
quotation mark before the next field separator:
,"Rouse, Waken & Co Ltd", or ,'Rouse, Waken & Co Ltd',
1st Mail will read from one quotation mark to the next one it finds of the same
type, treating everything in between as a single block of data. This means that you
can enclose one type of quotation mark within the other:
, "Harry's Bar",

If you need to use both single and double quotation marks within your data
fields, you can define up to 20 new "quotation mark" characters with the command
quotes decimal number
This command works in the same way as fieldsep and recordsep. Let us say that
you have an entry "Harry's Bar" as one of your fields, and you want to use the
character" +" to enclose this field. Since its decimal ASCII number is 43, enter
the command
quotes 43
and 1st Mail will read the data field +"Harry's_Bar"+ correctly.
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Skipping Fields
If you do not want to read in all the information contained in each record within a
datafile, you can use two commas in a row to indicate that a particular field in
each record must be skipped. You may, for example, have a field indicating a
person's position in a company:
Mr,A.B.,Winters,Director, ... Ms,J.C.,Crow,President, ...
In order to skip over this particular data field when processing a document, enter
the read command in the following way:
read title,initials,name,, ...

If you want to skip over the first data field, simply place a comma before the first
keyword:
read ,initials,name, ...
Similarly, if you want to skip over more than one data field, simply put in a
comma for each skipped field . If you want to skip to the start of the next record,
use the command skiprecord:
read title, initials, name, company
skiprecord

Empty Fields

Do not insert space(s) if a field is empty, but type the next comma separating the
fields . For example, if you wanted to add a record to the example address list
for someone with no known initials, you would enter:
Mr.,,Daley, . . .

-

I
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REFORMATTING TEXT
1st Mail uses a number of commands which allow you to reformat all or part of
any merged documents. Their effect may be modified by any rulers embedded
in the original document.
The following pages show the effect of these commands on your documents. In
each case, the first illustration shows the commands being used in a 1st Word
Plus document. The second illustration shows the output produced by processing
the document with 1st Mail.
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Line Spacing

double line
1st Mail has a powerful set of cof!\t!\ands which can be eMbedded in

your text to perforM useful functions, such as printing this
paragraph in double line spacing.
singleline
You can just as easily drop back into single line spacing again
afteruards, just like this.

Use doubleline to switch on double line spacing when you are printing a
document or saving it to disc, and singleline to revert to single line spacing.

- .

187

1st Mail has a powerful set of conMands which can be enbedded in
your text to perforM useful functions, such as printing this
paragraph in double line spacing .
ou can just as easily drop back into single line spacing again
afterwards, just like this.
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Indents

i11di'!11t 29

1st Mail also allows you to control the layout of your docuMent,
using eMbedded coM~ands like this. Notice how this paragraph is
indented, whereas the first one was not.

Use the indent command to alter the indent value of part or all of a document
during the mail merge process.
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1st Mail also allows you to control the layout
of your docunent, using enbedded connands like
this. Notice how this paragraph is indented,
whereas the first one was not.
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Margins

tvll'gin 58

Sinple, isn't it? And of course if you coMbine this with other
connands, you can do all kinds ol interesting things ....
double line
indent 3®
Margin 68

, . , , .like this, for exanple.

I
Use the margin command to alter the right-hand margin of all or part of a
document during the mail merge process. 1st Mail will ignore any value of
margin which is lower than the current indent value eg indent 30, margin 20.
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Sinple, isn't it? Rnd of course if you conbine this with other
connands, you can do all kinds of interesting things .. , .
. . , .. like this, for exanple.
Finally, we'll look at printing
ragged text.
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Ragged Text

Use ragged to switch off right-hand justification when you are printing a
document or saving it to disc, and justify to revert to right-justified text. The
default setting depends on the ruler in your document.
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Occasionally 1 though, you'll need to produce docuMents which
include justified sections, without worrying about the effects
any insertions Might have wnen you are Mail Merging. So we have
put in a connand to take care of it for you.
Having turned justification on, you nay want to turn it back off
again, which the ragged connand can do for you.
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MISCELLANEOUS TOPICS
Clearing the Screen
Use the clearscreen command to clear the screen of messages at any point during
the operation of 1st Mail. For example, if clearscreen were to come directly
before the repeat command in the example master document, the screen would
be cleared after each successive display of the message "Processing your letter to
title name".
Repeating the Merging Process
The repeat command tells 1st Mail to repeat the merging process from the
beginning of the file it is reading. If you do not put a number after repeat, your
master document will be reprocessed until the end of the datafile is reached.
However, if you do specify a number eg repeat 2, the merging process will be
repeated that number of times, or until the end of the datafile is reached
(whichever comes first). The program will then either stop (if that is the only
document being processed), or carry on reading through the command file.
Remember that this number tells 1st Mail the number of times that the merging
process is to be repeated, not the total number of copies that you will end up with.
If you specify repeat 2, you will end up with 3 copies.
Note: 1st Mail expects a positive number (1,2, ... ) after the repeat
command. To merge one copy of a document, do not put repeat 0, but
simply omit the repeat command.
Although you are restricted to only one repeat command in each file, you can
switch to another file with a repeat in it. However, repeat can only work with one
datafile at a time. This means that you cannot nest datafiles to produce, for
example, copies of a publicity letter which itself contains a current price list of
products. If you switch to a new datafile, 1st Mail will forget the contents of the
old one, and if you respecify the old datafile, it will be read in from its
beginning.
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Number of Copies
Be careful not to confuse the repeat command with the "Number of copies" option
on the Print File dialogue box. Specifying more than one copy to be printed will
simply tell 1st Mail to go through the merging process that many times. If you
ask for 5 copies t6 be printed, 1st Mail will take you through the merging process
5 times, and any information which was asked for during the first copy will also
be asked for with each subsequent copy.
Multiple Columns
Also found on the Print File dialogue box is the "Number of columns" option.
This allows you to print your documents in several columns, like a newspaper._

l@IUD
Print pages

froti1 [ ]

Left Margin offset

to 19991

[!]

[!]

Page nuMber offset

Alternate left Margin [ ]
NuMber of copies

[]

Swap headings on
alternate pages

IYesl llI!I

NuMber of coluMns
Headerstfooters ruler

Print quality
Pause
I Cancel I
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BINLQI
IYesl llI!I
OK

The default setting is single column output. Using the mouse, select the arrow
boxes to the right or left of the number to increase or decrease its value.
You must make sure that the number of columns you have requested is actually
possible. 1st Mail uses the first ruler it finds in a document to set the column
width. The column width is then multiplied by the number of columns and
subtracted from the "Headers/footers ruler length" (in the equivalent character
pitch) to calculate the width of the gaps between columns.

If the ruler in your document is too long to allow gaps, the columns will overlap
when it is printed. If this happens, either increase the ruler length on the Print
File dialogue box or edit the document to change the ruler length and reformat it.
You can also select one of four pitches in which your headers and footers will be
printed. The ruler length on the Print File dialogue box changes as you select a
new pitch, showing how many characters can be printed in that pitch.

-.

Note that the Headers/Footer s ruler box on the Print File dialogue box will be
empty unless you have selected to have more than one column. When there is
only one column the headers and footers will be controlled by the first ruler in
the document itself.

Page Breaks
The repeat command will not automatically put in a page break. If you want each
letter to begin on a new page, you must remember to place a hard page break in
the page border at the end of your master document (and before the repeat
command):
Page Numbers

The repeat command also does not reset the page number on each copy: if you
print 3 copies of a 2 page letter each separate page will be numbered
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consecutively 1 2 3 4 5 6. You can reset the page number on each copy by using the
pagenum command: pagenum 5, for example, will cause each copy of your
document to start at page 5. The pagenum command must come before repeat.
Light Type
1st Mail interprets anything in light type as either a command or a keyword. If
you use light type for any other reason (eg highlighting words), the program will
abort with an error message
The only exception to this is a light vertical bar I , which will be ignored in the
text. The light vertical bar can be used to print two separate words with no space
in between, so that title I initials name will appear as:
MrAB Winters MsJC Crow etc.
Any words in light type other than the initial command will be interpreted as
keywords before the command is carried out. For example, repeat 2 will be
interpreted as the command repeat followed by the keyword 2.
Note: Spaces in substitution strings (pieces of data read in from a
datafile which are more than a single word or number long) are treated
as soft spaces, and may be "stretched" during reformatting by 1st Mail.

Inserting the Date
Using the Archimedes internal clock, you can insert the date automatically into
your merged documents with a special 1st Mail keyword, rather than using an
input command and your own keyword.
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1st Mail uses three special keywords for three different ways of writing dates:
longdat e
ukdate
u~date

month in words
day/mon th/year
month/d ay/year

eg 19 Septemb er 1999
eg 19/9/99
eg 9/19/99

1st Mail will read the current date from the operating system and insert it if
it
comes across one of these special keywords. The current date will be inserted
beginning at the same position as the keyword used, so allow enough space on
the
right to avoid long dates being "wrapped" onto the next line. For example,
if you
enter the special keyword longdate at the following position

Dear title naM~ ,
We are pleased to inforn you that 1st Mail is
a1,1ailable for
use with +st W~rd Plus. We belie1,1e nany of thenowcustoner
s of
qottpan~ will like the.advanced features offered by 1st
;nclud;ng t~e autonat1c refornatting of paragraphs with Mail,
inse~t1ons in then. For further details, contact your
local
rch1nedes Dealer.
McAddans
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and the current date is 19th September 1999, then, providing the internal clock in
your Archimedes is correctly set, it will be processed by 1st Mail into

Mr R.B Winters
Rouse 1 Waken &Co Ltd
125 King Street
·are SGS 6BD

14 May 1988

We are pleased to inforM you that 1st Mail is now availableof for
use with 1st Word Plus. We believe Many of the custoners
offered by
Rouse, Waken &Co Ltd will like the advanced features
with
1st Mail, including the autonatic refornatting of paragraphs
insertions in theM. For further details, contact your local
Rrchinedes Dealer.
Yours sincerely,
Douglas C. McRddaMs
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!ill

This chapter summarises the commands in 1st Mail menus, as well as the 1st Mail
textfile commands.

MENU COMMANDS
1st Mail Info ...
Select this option to display information concerning which version of the program
you have. You will need to supply this information if you ever have need to
contact your dealer or the manufacturers with queries about the program.
Merge From ...
Select this option to start the mail merge process. 1st Mail will display a
dialogue box to allow you to select which file you want to merge from . If you
have set the output selection to Parallel or Serial Port, this will be followed by a
Print File dialogue box, and then a Datafile dialogue box. If you have set the
output to Disc, the Merge From dialogue box will be followed by a Merge To
dialogue box and then a Datafile dialogue box.
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MERGE FROM FILE

Directory:

l&.!wp.doc.•

OK
Cancel

When you first load 1st Mail, the Merge From dialogue box will appear
automatically. If you wish to change the output port before commencing your
merge procedure, select Cancel on this dialogue box to allow you access to the
Printer Information Strip at the bottom of the screen.
Quit
Select this option

to

exit from the 1st Mail program.

Clear screen
Select this option to clear the 1st Mail window.
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ST MAIL COMMANDS

-

The Printer Information Strip

Information relating to the currently installed printer appears in an information
strip along the bottom of the 1st Mail screen.

-

The boxes in this strip can also be used to change the current printer or output
port selections.
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The Printer Installed dialogue Box
an
Positioning the mouse pointer over this box and pressing select will display
printer
correct
the
Install Printer dialogue box. Use the dialogue box to select
configuration file for your system.
The Output Port dialogue Box
Positioning the mouse pointer over this box and pressing select will cause the
.
options Parallel Port, Serial Port, Networ k Port and Disc to appear in rotation

TEXT FILE COMMANDS
e
In the following command descriptions, the comman d syntax is shown alongsid
light
in
entered
be
the command name. The command name (eg chainfile) should
text. Parameters which are optional are shown enclosed in brackets <>. When
using such a command, do not include the brackets, only the parameter.

Chainfi le
chainfil e <filenam e>
This comman d tells 1st Mail to switch to the quoted filename and process it.
ons
Once 1st Mail has processed that file, it will not return to reading the instructi
is
filename
no
if
but
,
optional
is
in the original file afterwards. The filename
to be
specified in the command, a dialogue box will be displayed to allow a file
selected .
Clearsc reen
clearscr een
This comman d is used to clear the 1st Mail dialogue window .
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Datafile
datafile <filename>

-

-

This command selects the datafile from which data will subsequently be drawn.
The filename is optional, but if no filename is specified in the command, a
dialogue box will be displayed to allow a datafile to be selected.

Display
display "text"
This command is used to write text to the 1st Mail dialogue window.

Double line
double line
Use the command doubleline to switch on double line spacing. 1st Mail will
default to single line spacing. This command should not be used within a
paragraph .
Fieldsep
fieldsep decimal number,decimal number, ...
This command allows the data input to recognise different field separators, in
case a non-standard datafile is used. The decimal number is the ASCII code for
the desired character. The default decimal values for the number following this
command are 9 and 44 (tab and comma).
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Include file
include file <filenam e>
This comman d tells 1st Mail to switch to the quoted filename and process it.
in
Once 1st Mail has processed that file, it will return to reading the instructions
the original file. It is possible to nest several includef ile commands. The
filename is optional , but if no filename is specified in the command, a dialogue
box will be displayed to allow a file to be selected.
Indent
indent position
Use the indent command to alter the size of the indent for part or all of a
in
docume nt during the mail merge process. The size of the indent is measured
h.
paragrap
a
characte r spaces. This command should not be used within
Input
input "prompt", keyword
on
This comman d displays the characters enclosed within the inverted commas
named
the
with
in
types
user
the screen and associates the reply which the
since
keyword. For neatness in the display window, leave a space after "prompt",
mark.
n
quotatio
the cursor will be positioned at the closing
Note: Keywords must be in ordinary type when they are being defined
following the input command, but in light type when they are being
used.
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Justify
justify
Use the command justify to specify a justified right margin in your merged
documents. 1st Mail's default setting will depend on any rulers in the original
document. This command should not be used within a paragraph.
Margin
margin position
Use the margin command to alter the right-hand margin of all or part of a
document during the mail merge process. The position of the margin is measured
in character spaces from the left edge of the page. This command should not be
used within a paragraph.

Noomit
noomit
This command tells 1st Mail to print blank lines if an empty data field is
substituted for a keyword. 1st Mail will print blank lines in place of empty data
fields by default.
Omitblank
omitblank
This command tells 1st Mail not to print blank lines if an empty data field is
substituted for a keyword. 1st Mail will print blank lines in place of empty data
fields by default.
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Pagenum
pagenum number
This command resets the page number to the specified value.
Quotes
quotes <decimal number,decimal number, ... >
This command allows the data input to recognise different quotation marks, in
case a non-standard datafile is used. The decimal number refers to the ASCII
code for the desired character. The default decimal values for this command are
34 and 39 (single and double quotation marks).
Ragged
ragged
Use the command ragged to specify a ragged right margin in your merged
documents. 1st Mail's default setting will depend on any rulers in the original
document. This command should not be used within a paragraph.
Read
read keyword, keyword, ..
This command reads one or more fields from a datafile and associates them with
the corresponding keywords. Two commas in a row can be used to indicate that a
field must be skipped. If no datafile has been selected then a Datafile dialogue
box will be displayed to allow the user to choose one. Once defined, keywords
can be used in any file processed during a 1st Mail session.
Note: Keywords must be in ordinary romanface type when they are
being defined following the read command, but in light type when they

are being used within a master document.
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Recordsep
recordsep decimal number,decimal number, ...
This command allows the data input to recognise different record separators, in
case a non-standard datafile is used. The decimal numbers refer to the ASCII
codes for the required characters. The default decimal values for this command
are 10 and 12 (return and formfeed) .
Repeat
repeat <number>
This command restarts the merging process at the top of the current file . If no
number is specified, then the text file will be repeated until the end of the
datafile is reached. If a number is specified in the command, the text file will be
repeated that number of times or until the end of the datafile, whichever comes
first .

Setval
setval keyword, "text"
There may occasionally be a piece of text which you would like to be merged into
documents by 1st Mail, but which (a) cannot be stored in a datafile, and (b) you
do not want to be entered while the program is running. The setval command will
insert a piece of text of any length into your documents in place of the keyword.
You can use this command to insert something like a standard warning or
copyright notice in all documents merged in a single session with 1st Mail, eg:
setval warning, "Be careful!"
setval is identical in use to input, except that the piece of text used with setval is
typed in before merging, while with input it is typed in during the mail merge.
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Single line
single line
Use the command singleline to revert to single line spacing after using the
doubleline command. 1st Mail will default to single line spacing if neither
command is used. This command should not be used within a paragraph.
Ski pre cord
skiprecord

This command tells 1st Mail to skip to the start of the next record when reading
in data.
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One of the many tasks that 1st Mail can be used for is to print addresses on sticky
labels for envelopes. The following example document created with 1st Word
Plus will print labels nine lines apart:

title initials naMe
COtlP<IO\I

ddress
ostcode

--

Notice the hard page break before the repeat command in the page border. This
ensures that if any lines are left blank (as a result of omitblank for instance), the
next label will still start in the correct position.
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If you create an address label document like the example, it will need to contain
information about page length in the Page Layout dialogue box. The "page
length" will relate to the size of the label, and will be very short. The total
number of lines on each page in the example is identical to the paper length (ie 9
lines).
You will also need to alter the vertical initialisation in your printer configuration
file, to tell the printer when to move on to the next label.
The information in the printer configuration file is stored in hexadecimal form, so
you will need to make any alterations to this file in hexadecimal as well. There
is a special character denoting form feed which you will need to alter according
to the page length you require. Substitute the existing form feed character with
the number of lines in hexadecimal that you require. This tells ·t he printer to
form feed to the top of the next nine line page, rather than the usual page length.
Your printer manual will give you more information on how to do this. As an
example, the relevant alteration to the configuration file for an Epson FX-80 is
shown:
20, lB, 43, 09 * Vertical initialisation

After altering your configuration file, run the program lpr and copy the file that
is produced onto the 1st Mail disc. Running 1st Mail with this document and a
suitable datafile will produce address labels beginning every 9 lines.
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INTRODUCTION
There are hundreds of different printers on the market, and many more on the
drawing board. Most of these printers claim to be compatible with one of the
standard printer series (Epson, Diablo and Qume being the most common), but
many of them are less compatible than they claim, and nearly all of them have
extra features in addition to the standard ones.

..

Despite the lack of true standards, most printers are available for use with your
Archimedes. 1st Word Plus is capable of driving almost any printer that you
have successfully interfaced to your Archimedes by using a standard subset of
the printer's commands.
In addition to the standard print options, 1st Word Plus also enables you to use
the full range of your printer's special features, including extended character
sets, different print styles and pitches (in any combination), and even bit-image
graphics on a suitable dot matrix printer!
1st Word Plus is supplied with pre-configured drivers for a range of popular
printers which make use of the special functions available. If your printer is
compatible with one of these configurations, it is very easy to select the correct
driver from your 1st Word Plus Desktop, and to install it as your default printer
(see Installing a printer in the chapter Saving and printing) .

If your printer is not fully compatible with one of the supplied drivers, or if you
want to use additional features of your printer that are not supported, this
appendix tells you how to create and install your own custom printer driver for
use with 1st Word Plus.

STANDARD PRINTERS
1st Word Plus is supplied with a range of pre-configured printer files, including
the following:

ASCII

This is a universal driver which is compatible with most of the
printers currently available. It tells 1st Word Plus to print only
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ASCII characters and to remove all style commands - so you
won't see bold or underlined text on your print-out.
BROTHER

This driver is configured for Brother HR series daisywheel
printers HR-15, HR-25 and HR-35, but excluding the HR-1 (use
the STANDARD driver).
The HR-15 accepts commands in 1/120" increments, but prints in
1/180" increments, rounding values to the nearest 1/180". This
may give scruffy results when printing bold text in justified
lines, because the 1/120" bold offset will vary between zero and
1/90" . Left justified headings will be unaffected.
Note: This configuration assumes a standard USA ASCII
print wheel (see DIABLO).

DIABLO

This configuration should be used for all Diablo and Diablocompatible daisywheel printers. If you don't know what type of
daisywheel configuration to use, try this one first.
Note: As with all daisywheel printers, the characters that your
printer is capable of printing, and their positions relative to the
ASCII code table, depend on the print wheel itself. The
daisywheel configurations provided with 1st Word Plus assume
that your printer has a standard USA ASCII daisywheel. You
will need to create a custom configuration for each non-standard
print wheel that you use.

EPSON_FX

If your printer is one of the Epson FX or RX series, or it is
described as "Epson-compatible", then this is the driver to use.
Epson PX-compatible printers are 9-pin draft quality matrix
printers supporting the full range of 1st Word Plus printing
styles, including graphics.
Warning: Not all printers that claim to be "Epson-compatible"
conform to the FX standard, including some Epsons! To cause
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further confusion, the more recent FX models (FX-85, FX-105)
are in fact Epson LX compatible.

-

EPSON_JX

The Epson JX series, plus EX models fitted with the colour
option, are PX-compatible 9-pin dot matrix colour printers.
The JX driver is configured to print in red ink when it detects the
light text style and to reproduce colour graphics in up to eight
colours (red, green, blue, cyan, magenta, yellow, black and
white). Pictures are stored as sprites. If a palette has been
stored with the sprite, the printer will attempt to match the
palette colours to the nearest print colour available. If no
palette has been stored with the sprite the standard 1st Word
Plus palette will be used .

EPSON_LX

Warning: The NLQ mode on these printers is only available for
use with Pica pitch (10 characters per inch) and does not support
italic, superscript or subscript characters. To overcome this, the
supplied LX driver switches NLQ mode on and off as required
to reproduce the screen appearance as closely as possible.
However, this has some unavoidable side effects in NLQ
printing, and you should not use the following styles combined
with light face in NLQ mode:

.

The Epson LX and GX series, together with the FX-85 and FX05, are 9-pin matrix printers that have an extra NLQ (near-letterquality) mode in addition to the standard FX features.

--

• Italic
• Superscript
• Subscript

I When printing in draft mode, none of these restrictions apply.
EPSON_LQ

The Epson LQ and SQ range are very high quality 24-pin
matrix printers that have an excellent NLQ mode without any of
the restrictions of the LX series.
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--These printers are FX-compatible in every respect except
graphics, which will be printed some 30% larger than on an FX
series printer.
IBM_GRAP

The IBM Personal Graphics Printer is a 9-pin dot matrix printer,
loosely based on the Epson FX-80 command set, with draft mode
text printing and bit-image graphics printing modes.

IBM_PROP

The IBM Proprinter is a 9-pin dot matrix printer, loosely based
on the Epson FX-80 command set. The Proprinter has draft,
double-strike NLQ and bit-image graphics printing modes.

JUKI

This configuration supports the JUKI 6100 range of daisywheel
printers.
Note: This configuration assumes a standard USA ASCII
print wheel (see DIABLO) .

QUME

This configuration supports the Qume Sprint range of
daisywheel printers, models 5, 9 and 11, but excluding the Sprint
10 (for which you should use the STANDARD configuration).
Note: This configuration assumes a standard USA ASCII print
wheel (see DIABLO).

STANDARD
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To get you started, this driver is installed as the default 1st
Word Plus printer. Although it has a restricted range of
functions , it is compatible with practically all printers, ranging
from a simple teletype to a laser printer. The minimum
requirement is the presence of a backspace function on the
printer.

PPENDIXB

The STANDARD driver prints only ASCII characters and
removes all style commands except bold and underline, which
are implemented by backspacing and overprinting.
Note: The range of printer drivers supplied will vary from country to
country, and may change as new printers are released onto the market.

CUSTOM PRINTER CONFIGUR ATION
The following pages describe the process of preparing and installing a custom
printer configuration to utilise the special features of your printer.
Creating a custom printer configuration requires great attention to detail and a
degree of trial and error. Computer novices are advised to use one of the
standard configurations. However, if you are confident that you understand the
principles involved and you follow these procedures exactly, you can be sure that
you will create a driver that matches your printer exactly.
Types of printer
1st Word Plus recognises three basic types of printer:
DAISY

These are daisywheel printers capable of microspacing (usually
to 1/120") with a print wheel of 96 (or more) characters in a
single font. 1st Word Plus drives daisywheel printers directly
under microspacing control to control print styles such as
character pitch, boldface and underlining.

If you use one or more non-standard print wheels, you will need
to configure a special printer driver for each print wheel, to
ensure that your screen display matches the printed output.
Note: Proportional spacing is not available using a microspacing
daisywheel configuration. If your printer supports proportional
spacing and you wish to use this feature, make a custom driver
based on a matrix printer configuration, using the printer to
achieve bold, underlining, etc.
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MATRIX

These are 9- and 24-pin dot matrix printers, with a range of print
styles and fonts. 1st Word Plus uses the built-in features of
these printers to produce the different style effects, sending
escape sequences for each style or font change.
Note: A proportional spacing driver can be configured if a
proportional font is available on the printer. However, this
mode cannot support right justified text.

STANDARD

Some printers (including most typewriters with computer
interfaces) are incapable of microspacing control and have a
very limited or extremely complicated command set. 1st Word
Plus utilises the backspace function (when available) to
implement boldface and underlining only.

Some notes on printer hardware
When producing a configuration for a printer, it may also prove necessary to
configure the printer hardware.
Most printers have sets of "DIP" switches which affect things such as autolinefeed or paper length. Most of these can be set to your preferred options,
except the foflowing:
•
•

Skip over perforation must be DISABLED.
Auto linefeed after carriage return must be DISABLED.

and, for a serial interface:
•
•

CTS/RTS handshaking must be ENABLED.
XON/XOFF handshaking must be DISABLED.

For "Epson-compatible" matrix printers it is not necessary to switch language
fonts, and you should use the standard USA setting. The printer driver is
configured to switch fonts under software control to access accented characters.
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IEtPPENDIX B
With daisywheel printers, the character translation table in the printer
configuration must be changed to match your print wheel if this is not standard
USA ASCII.

EDITING CONFIGURATION FILES
HEX files
In the HEX directory you will find three files corresponding to the three basic
printer types:

•
•
•

DAISY
MATRIX
STANDAR D

Use 1st Word Plus to create a custom printer configuration by editing the file
which is appropriate to your printer. Make sure that WP mode in the Edit menu
is switched off when editing, and give your printer file a new name when you save
it, using Save as ••• in the File menu.
Most of the data in the printer file is numeric, and numbers are assumed to be in
hexadecimal (base 16). Lines starting with an asterisk (*) are comments and
blank lines are ignored. The data held in the file falls into four sections,
described below.
Printer name
The first non-blank line in the file {excluding comments) is assumed to be the
name of the printer. When the printer driver is installed, this name is displayed
in the printer display line above the font table on the 1st Word Plus startup
screen. The name should not exceed 32 characters.
Configuratio n variables
This section contains a list of six numbers (on a line together) separated by

commas, as follows:
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Printer type
This should be set to 1 for a microspacing daisywheel printer, otherwise zero.
2

Unit width
For a daisywheel printer, this specifies the width of one character in the
printer's own width units.
For a matrix printer, this value should be set to 2 if each pixel is to be printed
twice (to double the output width) in graphics mode (Atari SMM804).

3

Unit height
This specifies the size of a linefeed in the printer's own height units.

4

Middle of carriage/graphics resolution
For a daisywheel printer, this specifies the position to which the print head
should be moved when feeding paper (normally the middle of the paper).
This position is specified in printer units from the left margin.
For a matrix printer, this specifies the printer graphics resolution in pixels
per inch. It is used for the screen display of a box around the picture to show
its actual size on paper.

5

Carriage shift for bold (daisywheel only)
This specifies the horizontal offset in printer units used by the printer driver
when printing bold text: it prints the character once, moves along a fraction,
and prints again.

6

Pause between pages
Set this to 1 to force the printer driver to pause at the end of each page to

allow the paper to be changed, otherwise zero.
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ll'JPPENDIXB
Printer characteristic s

This is a table of command sequences which are sent to the printer for style
changes, etc. The first number on each line is the function number used to identify
the line (this is not sent to the printer). The entries in the table must be in .
increasing order of function number, but it is not necessary for all the entries to
be present.
Each table entry starts with its entry number, followed by the codes to be sent to
the printer, separated by commas. A comment may be included on the line,
preceded by an asterisk (*).
A value more than 80 (hex) is a placeholder for variable binary information to
be sent to the printer: the difference after subtracting 80 is added to the value to
be output. (For example, on a Diablo-comp atible printer, commands to co~trol
character width require a value to be output of width+ 1, so the placeholder in the
command is 81.)
The table is terminated by a zero entry, but there must be at least one non-zero
entry before this.
In addition to the initialisation strings listed below, the printer driver also sends
all commands which tum off print styles at the start of each document.
When printing in NLQ mode, if a style change command for NLQ mode is not
present, the correspondin g Draft mode command will be used instead.
You will find that it will not be necessary to include all of the following
commands for your printer. Where you wish to omit a command, it is simpler to
do this by making the entry a comment line by typing an asterisk (*) at the start of
the line.
Remember that these commands must be kept in numerical order, and that all
entries are in hexadecimal .
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0

Set character width (daisywheel only)
This command sends character width changes to the printer. It includes a
placeholder for the width (normally 81).
Linefeed
This command contains the code to be sent to the printer at the end of a line.
Normally, a linefeed for daisywheel printers, and a linefeed plus carriage
return for dot matrix printers.

2

Forward print (daisywheel only)
This instructs the printer to print from left to right.

3

Backward print (daisywheel only)
This instructs the printer to print from right to left. This command should be
omitted for those "intelligent" daisywheel typewriters which cannot print
bidirectionally (for example, Juki 2200 and Brother CE-51 ).

4

Vertical tab (optional)
This command feeds the paper by several lines in a single smooth operation.
The command should include a placeholder for the line number. If this
command sequence is omitted from the table, several linefeeds will be used
instead.
There is a potential problem when using vertical tabs on some printers. If
you have a document with lines longer than the paper width, and the printer
automatically wraps lines which are too long, this may cause the printer's line
number to get out of step with the program's line number. Vertical tabs
would then typically skip to the start of the next page.
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Absolute horizontal tab (non-daisywheel)
This command is the horizontal equivalent of the above: it moves the print
head horizontally to a specified character position.

-

6

Draft bold on
This command sequence instructs the printer to switch on draft bold printing,
using either emphasised or double-strike modes (or both).

If this command is defined for a daisywheel printer, the printer will effect
the style change, otherwise the software will achieve this by microspacing
and overstrike. If this command is omitted for a non-daisy printer and a
backspace command is defined, then bold text will be printed using
backspace and overstrike.

7

Draft bold off
This command sequence instructs the printer to switch off draft bold printing.

8

NLQ bold on
This command is similar to (6), but operates in NLQ mode.

If your printer does not support NLQ printing, you can omit all the NLQ
commands.

9

NLQ bold off
This should switch off bold and ensure that the printer remains in NLQ
mode.

-

A

Draft italic on
This command instructs the printer to switch on italic printing.
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B

Draft italic off
This command instructs the printer to switch off italic printing.

C NLQ italic on
This command instructs the printer to switch on italic printing in NLQ mode.
Some printers (Epson LX-80 etc) cannot print italic in NLQ mode. In this
case use this command to switch off NLQ then switch on double-strike and
italic!

D

NLQ italic off
This command instructs the printer to switch off italic printing in NLQ mode .

If you have switched off NLQ mode to print italic, you will need to switch it
back on here.
E

Draft light on

If your printer has a second colour ribbon, use this command to switch
ribbons, otherwise omit the command.
F

Draft light off
If you use light to switch to a second colour, use this to switch back to black,
otherwise omit the command.

10 NLQ light on

Use this command to switch out of NLQ into draft mode to give the effect of a
lighter face .
11 NLQ light off

Switch NLQ back on again.

224

12 Draft superscript on
For dot matrix printers, this command instructs the printer to switch on
superscript style.
For daisywheel printers, this command (usually) performs a reverse half
linefeed.
13 Draft superscript off
For dot matrix printers, this command instructs the printer to switch off
superscript style.
For daisywheel printers, this command (usually) performs a half linefeed.
14 NLQ superscript on
For certain NLQ dot matrix printers (Epson LX-80 etc) you may need to
switch off NLQ in order to print superscript. Otherwise the command is
identical to (12) above.
15 NLQ superscript off

If you have switched off NLQ to print superscript, you will need to switch it
back on here. Otherwise the command is identical to ( 13) above.
16 Draft subscript on
For dot matrix printers, this command instructs the printer to switch on
subscript style.
For daisywheel printers, this command (usually) performs a half linefeed.
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17 Draft subscript off
For dot matrix printers, this command instructs the printer to switch off
subscript style.
For daisywheel printers, this command (usually) performs a reverse half
linefeed.
18 NLQ subscript on
For certain NLQ dot matrix printers (Epson LX-80 etc) you may need to
switch off NLQ in order to print subscript. Otherwise the command is
identical to (16) above.
19 NLQ Subscript Off

If you have switched off NLQ to print subscript, you will need to switch it
back on here. Otherwise the command is identical to ( 17) above.
lA Draft underline on
This command sequence instructs the printer to switch on draft underline
printing.

If this command is defined for a daisywheel printer, the printer will control
underlining. Most daisywheel printers are not intelligent enough to
underline correctly in microspaced lines. They will either cheat (by not
underlining spaces), or will go wrong under certain conditions! It is safer to
let 1st Word Plus control underlining.
If this command is omitted for a daisywheel printer, underlines will be
printed by 1st Word Plus during a second pass of the line.
If this command is omitted for a non-daisywheel printer and a backspace
command is defined, underlining will be printed by backspace and
overstrike.
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1B Draft underline off
If you have included an "underline-on" command, use this to switch it off
again. Otherwise omit the command.
1C NLQ underline on

If your printer supports NLQ, this should be identical to (lA) . Otherwise
omit the command.
1D NLQ underline off

If your printer supports NLQ, this should be identical to (lB). Otherwise
omit the command.
lE Formfeed (optional)

If this code is defined, it is used to feed the paper to the top of the next sheet,
otherwise linefeeds will be used.
1F Horizontal initialisation (optional)
This code is sent once only at the start of the document.
For a daisywheel printer, this should include a character width command
whose placeholder will be replaced by the default character width from (2)
above.
20 Vertical initialisation (optional)
This code is sent once only at the start of the document.
For a daisywheel printer, this should include a linefeed distance command
whose placeholder will be replaced by the default line height from (3)
above.
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You can include a formfeed in this initialisation string to ensure that the
printer is at the start of a page when you print a document.
21 Printer reset (optional)
This command is sent to the printer at the end of the document to reset it for
use by other programs.
22 Backspace

If this command is defined for a non-daisywheel printer, and there is no
underline command, underlines will be printed by backspace and
overstrike. Similarly, if there is no bold command, backspace overstrike will
be used for bold text.
23 Carriage return
This command should contain a carriage return (without a linefeed) for use
when printing graphics. It will also be used by non-bidirectional daisywheel
printers.
24 Form length in lines

If this command is defined, it will be output at the start of the document to set
the printer's form length to the value on the Page Layout dialogue box. This
will prevent the printer from automatically starting a new page before the
end of page.
25 Set linefeed distance
This command is required for graphics output, to control the size of a
linefeed. It should contain a placeholder for the linefeed distance.
26 Print graphics
This command is used to start a line containing graphics data. The command
is followed by two bytes giving the byte count of the following graphics data
(Epson-style) .
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27 Reserved
Command 2 7 is not used. It is reserved for future expansion.
28 Draft Pica
On a dot matrix printer, this command is used to switch into Pica pitch (10
characters per inch [cpi]) in draft mode. It should also switch off doublewidth and condensed printing.
On a daisywheel printer, this should contain a single value giving the
character width in the printer's internal units (usually C) .

29 NLQ Pica
This command is used to switch into Pica pitch (10 cpi) in NLQ mode. This is
usually identical to (28) , but must additionally switch NLQ on if the printer
does not support NLQ with other pitches (Epson LX-80 etc).
Not used on a daisywheel printer.
2A Draft Elite
On a dot matrix printer, this command is used to switch into Elite pitch (12
cpi) in draft mode. This command should also switch off double-width and
condensed printing.
On a daisywheel printer, this should contain a single value giving the
character width in the printer's internal units (usually A) .

2B NLQ Elite
This command is used to switch into Elite pitch (12 cpi) in NLQ mode. This is
usually identical to (2A), but should be omitted entirely for printers that
cannot print NLQ Elite, such as the Epson LX-80.
Not used on a daisywheel printer.
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2C Draft Condensed
On a dot matrix printer, this command is used to switch into Condensed pitch
(usually 17 .2 cpi) in draft mode. It should also switch off double-width
printing.
On a daisywheel printer, this should contain a single value giving the
character width in the printer's internal units (usually 8 for 15 cpi) .
2D NLQ Condensed
This command is used to switch to condensed pitch (normally Condensed
Pica for 17 .2 cpi) in NLQ mode. This is usually identical to (2C) , but should
be omitted entirely for printers that cannot print NLQ Condensed, such as
the Epson LX-80.
Not used on a daisywheel printer.
2E Draft Expanded
On a dot matrix printer, this command is used to switch into Expanded pitch
(normally double width Elite for 6 cpi) in draft mode. It should also switch
off Condensed mode printing.
On a daisywheel printer, this should contain a single value giving the
character width in the printer's internal units (usually F for 8 cpi).

2F NLQ Expanded
This command is used to switch into Expanded pitch (normally double-width
Elite for 6 cpi) in NLQ mode. This is usually identical to (2E), but should be
omitted entirely for printers that cannot print NLQ Expanded, such as the
Epson LX-80.
Not used on a daisywheel printer.
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30 Black ink
This command is used to switch to black ink when printing graphics on a
colour printer. Otherwise omit the command.
31 Magenta ink

-

This command is used to switch to magenta ink when printing graphics on a
colour printer. Otherwise omit the command.
32 Cyan ink
This command is used to switch to cyan ink when printing graphics on a colour
printer. Otherwise omit the command.
33 Yellow ink
This command is used to switch to yellow ink when printing graphics on a
colour printer. Otherwise omit the command.
Character translation table
This table must be configured to translate each Archimedes character into one or
more codes, to access the nearest equivalent character on your printer.
The character translation table is held in Archimedes character code order,
terminated by a zero entry. Each entry comprises the Archimedes code followed
by zero or more codes to be sent to the printer, separated by commas, followed
by an optional comment preceded by an asterisk (*).

If you configure your matrix printer to use the standard USA font, or use a
standard USA ASCII daisywheel, then the code range 20-7F (hex) of the
Archimedes Latin Alphabet 1 character set (ECMA/ISO) can be sent directly to
the printer without translation. There need not be any table entries for standard
USA ASCII characters.
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If you are using a UK ASCII font or daisywheel, you will need to translate both
the u and# characters to produce correct results on the printer.
Accented characters and other international characters in the second half of the
character set can be printed on some printers either by backspace and overstrike
or by sending commands to the printer to switch font. In this case the table entry
should start with the code of the character to be translated, followed by the data
to be sent to the printer.
Where a character cannot be satisfactorily printed, a table entry giving just the
character code without any translation will cause the printer driver to skip that
character.
See MATRIX file for font switch commands to access accented characters (it
switches back to the USA font for standard USA ASCII symbols) .
See DAISY file for accented characters on a daisywheel printer achieved by
backspace and overstrike. This table will need changing for different
daisywheels !
There is no fixed limit on the size of the table, so adventurous installers could try
including commands to download character shapes into dot matrix printers for
some of the more exotic characters.

GRAPHICS PRINTING CONFIGURATION
Printing method
1st Word Plus prints graphics images pixel-for-pixel as shown on the screen,
without any scaling or raster transformation. Thus the screen representation of
the image in relation to the text will be an approximation to the printed output.
If you have a graphics printer driver installed, each image displayed on the
screen is bordered by a dashed line indicating the extent of the image on the
printed page. This helps you align your text with the graphics image.
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fn practice, most Epson-compatible printers will print graphics exactly as shown
on the screen, with no relative size change.

~st

Word Plus supports colour printers with four-colour ribbons (Epson JX-80,
f tc). See above under the appropriate printer name in the Standard. printers
section for further details.
I
pnit height

The unit height (3) must be set to the spacing between lines in internal units. Most
Epson-compatible printers have 72 dots per inch, and print six lines per inch, so
fie lines are 12 dots apart. The Epson LQ-800 has 60 dots per inch in 8-pin mode,
so the line spacing is set to 10 for this printer.
Unit width

If the unit width (2) is set to 2, then the picture will be expanded to double width
hy sending each pixel twice.
This is useful for printers such as the Atari SMM804 which only has a highdensity graphics mode (1280 dots per 8", but adjacent dots are not printed).

If the unit width is set to 0 or 1 then the graphics will not be expanded in this way.
Graphics resolution

The x-axis graphics resolution (in pixels per inch) is held in the Configuration
Variables (see above). This is used when calculating the effective picture width
' hen displaying the picture border on the screen. If the unit width is set to 2 to
double the width of the picture, then this number should be halved to match.
Aspect ratio
~f printing on an Epson FX-80, mode 5 (lB, 2A, 5) will produce a square aspect
ratio (circles are actually circular). Note that some "Epson-compatible" printers
do not support mode 5.
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Epson mode 4 (lB, 2A, 4) will print a full screen snapshot on 8" paper, but will
produce slightly elliptical circles.
On an Epson LQ-800 or similar, use mode 0 (lB, 2A, 0) for a square aspect ratio.
This will expand the picture by some 30%, as indicated on screen by the picture
border.
Colours
Graphics colour printing is "subtractive" and therefore requires black, magenta,
cyan and yellow ink to achieve black, red and green printing. Colour subtraction
is carried out automatically by the printer driver.

If you print a colour picture on a monochrome printer, the printer driver will
automatically convert the colours into an approximate grey-scale representation.

INSTALLING YOUR CUSTOM DRIVER
The lstlnstall program
To install your custom driver for operation with 1st Word Plus, it is first
necessary to convert the hex printer file into a Configuration file - the format that
1st Word Plus understands.
Follow these steps

to

do this:

Load the printer installation program 1stlnstall (on the Utilities disc), either
from the desktop or from the operating system, in the same way that
1stWord+ is installed (see Loading 1st word Plus in the chapter Getting
started for details) .
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2

When the Input File dialogue box appears select the file in the Hex
directory which relates to the printer you wish to install.

3

Select OK or press [;!]

4

An Output File dialogue box will now appear. The Directory: box will
contain a path leading to the cfg directory and the Filename: box will
contain the name of the file you selected on the Input File dialogue box. If
you wish to place the file elsewhere or give it a different name, you can use
the dialogue box to do so.

5

When you are satisfied with the entries, select OK

The printer installation program will convert the hex file to a Configuration file
and return you to the Input File dialogue box when it has finished.
If the installation program displays an alert, this usually indicates that you have
made a mistake when editing the printer file. Check your file carefully for
errors.
Testing the CFG file
You can test your new Configuration file by selecting it using the printer display
line on the 1st Word Plus startup screen, as described in Switching printers
within 1st Word Plus in the chapter Saving and printing.
The Docs directory contains a file named Test which includes examples of all
of the possible print pitches and character styles, a character set table, and a
graphics image. Print this file using Print file ••• in the File menu to test your new
printer configuration.
You can make 1st Word Plus load your driver by default by copying it, renaming
the copy lWP Print, and moving it to the disc and directory containing
lstWord+,-;-s described in Installing a New default printer in the chapter

Saving and printing.
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Add footnote ... 146
Add ruler. .. 145
Add word 149
Adding rulers 62
Altering text 19
Alternate left margin 132
Backing up discs 153
Backup files 49
Block editing 21
Block marking, removing 92
Block style 24
Blocks, copying 23, 92
Blocks, cutting 92
Blocks, deleting 25
Blocks, marking 22, 90
Blocks, moving 23, 93
Blocks, pasting 24, 92
Bold 146
Bold type 14
Bottom of form margin 57
Browse .. . 149
Capitals 14
Centre 147
Centred text 14, 74
Chainfile 179, 204
Character translation table 231
Check spelling 148
Clearscreen 195, 204
Clipboard 23
Closing windows 41
Columns, multiple 196
Command file 171
Commands 162
Conditional page breaks 80
Continuous check 149
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Continuous spell check 116
Control keys 30
Copy block 143
Copying blocks 23, 92
Cursor movement 19, 44
Cut block 143
Cutting blocks 92
Daisywheel printers 217
Datafile 173, 205
Decimal tabs 67
Delete file ... 139
Delete picture 150
Delete ruler 145
Deleting footnotes 97
Deleting rulers 64
Deleting text 87
Deleting blocks 25
Deleting files 128
Deleting pictures 113
Dictionaries, merging 121
Dictionary browser 118
Display 168, 205
Documents, merging 89
Doubleline 205
End block 143
End spell check 150
Extra help 27
Fields, skipping 185
Fieldsep 183, 205
Filenames 49
Files, backup 49
Files, deleting 128

Files, format 71
Files, saving 125
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-.

Find end 144
Find start 144
Find... 140
Finding marks 94
Finding pages 45
Finding position 45
Fixed spaces 46
Font table 34
Foot margin 57, 61
Footers 59
Footnote numbers 98
Footnote format ... 145
Footnote ruler line 96
Footnote separator 102
Footnote window 96
Footnotes 94
Footnotes, deleting 97
Footnotes, page breaks with 103
Footnotes, printing 98
Footnotes, renumbering 96
Format files 71
Function key icons 30
Function keys 30
Goto line 142
Goto mark 142
Goto page 14 2
Graphics mode 150
Graphi\:S resolution 233
Hanging indents 76
Hard page breaks 79
Head margin 57, 61
Headers 59
Headings, underlined 84

Help information 26
Help menu 26
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Hide block 144
Horizontal scroll bar 43
Horizontal scrolling 44
Hyphenation 71, 141
Includefile 174, 177, 206
Indentl47,206
Indent command 189
Indent spaces 4 7
Indenting paragraphs 20, 75
Indenting single lines 75
Indents, hanging 76
Input173,206
Insert mode 88, 141
Inserting pictures 110
Italic 146
Italics 17
Justification 69
Justify 207
Key box 32
Keyboard 29
Keywords 162
Labels, printing 211
Left margin offset 132
Left margins 58, 65
Left-aligned tabs 67
Light 146
Light type 198
Line spacing 70
Load dictionary 148
Loading the spelling dictionary 114
Longdate 199
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Mail merge 1, 151
Margin 207
Margin, bottom of form 57
Margin command 191
Margin, head 57
Margin, top of form 57
Margin, foot 57
Margins, left 58, 65
Margins, right 58, 65
Marking blocks 22, 90
Marks, finding 94
Marks, setting 94
Master documents 162
Matrix printers 218
Memory space restrictions 47
Merging dictionaries 121
Merging documents 89
Mode 12 9
Mode 20 9
Mode, insert 88
Mode, overwrite 89
Modifying rulers 65
Move block 144
Moving blocks 23, 93
Moving pictures 112
Moving windows 41
Multiple columns 196
Nesting files 176
Noomit 168, 207
Numbered paragraphs 77
Numeric keypad 30
Offset, left margin 132
Offset, page number 132

Omitblank 167, 207
OPEN FILE 12, 51
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Open file ... 137
Overwrite mode 89
Page border 38
Page breaks, conditional 80
Page breaks, hard 79
Page breaks, soft 7 8
Page breaks with footnotes 103
Page breaks 197
Page layout ... 145
Page length 58
Page number offset 132
Page numbering 61
Page numbers 197
Pagenum 198, 208
Pages, finding 45
Paper size 57
Paragraphs, indenting 20, 75
Paragraphs, numbered 77
Paste block 143
Pasting blocks 24, 92
Pictures, deleting 113
Pictures, inserting 110
Pictures, moving 112
Pitch 68
Pitch, character 197
Position, finding 45
Print file .. . 138
Print quality 134
Printer characteristics 221
Printer installation 128
Printer types 213
Printers 153
Printers, daisywheel 217
Printers, matrix 218

Printers, standard 218
Printing 130
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Printing footnotes 98
Printing method 232
Quit202
Quit all... 41, 140
Quit... 28, 41, 139
Quitting 135
Quotes 184, 208
Ragged 166, 193, 208
Read 166, 208
Read file 139
Read picture ... 150
Read ruler. .. 145
Recordsep 183, 209
Reformat ... 148
Reformatting mailmerge text 186
Reformatting text 109
Removing block marking 92
Renumbering footnotes 96
Repeat 169, 195
Repeat find 140
Replace ... 140
Replacing 107
Right 147
Right margins 58, 65
Right-aligned tabs 68
Right-aligned text 74
Ruler length 63
Ruler line 38
Ruler line, footnote 96
Rulers, adding 62
Rulers, deleting 64
Rulers, modifying 65
Rulers, storing 66
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Save and resume 127, 139
Save as ... 138
Save file 138
Saving files 125
Saving text 28
Scroll bars 38
Scrolling 42
Scrolling, horizontal 44
Scrolling, vertical 43
Searching 104
Set mark ... 142
Setting marks 94
Setval 209
Show position 144
Show ruler 144
Singleline 210
Skiprecord 210
Soft page breaks 78
Spaces, fixed 46
Spaces indent 47
Spaces, stretch 46
Spaces, variable 46
Spacing, line 70
Spell check, continuous 116
Spelling correction 119
Spelling dictionary additions 117
Spelling dictionary deletions 121
Spelling dictionary, loading 114
Standard printers 218
Start block 143
Startup screen 33
Statistics... 141
Storing rulers 66
Stretch spaces 46
Subscript 147

Superscript 147
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Tabs 15
Tabs, decimal 67
Tabs, left-aligned 67
Tabs, right-aligned 68
Text, centred 74
Text, deleting 87
Text, reformatting 109
Text, right-aligned 74
Text window 13, 36
Title bar 37
Top of form margin 57
Typefaces 83
Typing text 16
Ukdate 199
Underline 146
Underlined headings 84
Underlined text 15
Usdate 199
Variable spaces 46
Vertical scroll bar 43
Vertical scrolling 43
Window size icon 40
Windows, closing 41
Windows, moving 41
Word processor 1
Word wrap 16, 70, 142
Workspace 37
WP mode 33, 141
Write block 139
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